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2 Introduction
Thank you for choosing astraia - software for women's health as your documentation system for obstetrical and 
gynaecological examinations. astraia provides a modern system that was developed in close cooperation with Prof. 
Kypros Nicolaides and other renowned international specialists in gynaecology and antenatal diagnosis.

astraia - software for women's health was developed in accordance with our certified quality management system 
(EN ISO 13485 and MDSAP requirements). astraia fulfils all legal requirements for medical devices as specified by 
the Medical Device Regulation (MDR - EU 2017/745) and the In Vitro Diagnostic Regulation (IVDR - EU 2017/746). Risk 
management has been carried out according to EN ISO 14971.

Please read this manual very carefully and in case of any questions please contact our technical support. 

This manual covers all available standard modules in the astraia - software for women's health package, though the 
modules a customer has bought and licensed within the full package may be fewer and some modules described in 
this manual will therefore not be available to all users. Please check your order confirmation/invoice for 
information on which modules you have bought.

2.1 Product end of life
For information about the end of life of the current and previous versions of astraia, please refer to our website 
at https://www.nexus-astraia.com/support.

2.2 Intended Use / medical indication
astraia - software for women's health is a modular software system. The use of these modules depends on the 
purchased license(s). The functionality and purpose of these modules are outlined below:

Obstetrics (includes IVD: risk calculation for Trisomy 21 in the First Trimester), Gynaecology, Colposcopy, 
Fetal Echocardiography, Fetal Neurosonography, Breast Clinic modules

Structured documentation of patient data and history, examination details, findings, diagnoses, 
management and therapy information
Creating and sharing structured examination reports /printouts
Monitoring fetal and maternal health
Detection of abnormal fetal growth
Prediction of fetal trisomy 21, 18 and 13
Prediction of preeclampsia

NEXUS / ASTRAIA GmbH cannot take any responsibility for your data security and integrity.
We advise you to keep regular backups of the database (we recommend twice a day or every 10 
examinations) and other important files, which should be stored separately from the machine(s) on which 
you are running astraia. We recommend doing additional backups to an external storage medium 
(external hard disk, USB, via the network to another PC, DVD/CD, SAN, NAS). 


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Prediction of fetal growth restriction
Prediction of preterm delivery
Prediction of malignancy of ovarian masses
Exchanging data with ultrasound devices (i.e. transfer of measurement data and images to the astraia 
software)
Exchanging data with laboratory devices (i.e. transfer of analyte concentrations to the astraia software)
Exchanging data with hospital information systems (HIS), picture archiving and communication systems 
(PACS), Laboratory information system (LIS) and other IT systems in a medical facility
View, adjust, measure and categorise DICOM media directly in the examination record
Collecting and extracting data for (clinical) studies, quality control and performance statistics

Contraindications

The astraia software offers clinical decision support but  does not  provide automatic diagnosis, decisions or 
management and treatment information.

Intended patient group

Sex: Women

Conditions: Pregnant and non-pregnant

Age: From early adulthood on

Ethnic origin: No restrictions

Health: Healthy and unhealthy subjects

Weight: No restrictions

Probable body part

The product is a pure software and is therefore not applied  in or on the human body.

However, within its intended use / medical indication (see above), the astraia software takes into account the 
following parts and properties of the human body:

Female (reproductive) organs and fetal anatomy
Blood
Maternal and fetal physiology 
Genetic information about the mother and fetus 

Probable user profile

Doctors (e.g. Gynaecologists, Obstetricians) Radiologists, Sonographers, Midwives, Secretaries, Medical assistants, 
Laboratory staff, IT-personal

User Qualification

Secondary school education (ISCED 2), basic software skills, basic astraia software application training.

The use of the FMF risk algorithm to predict trisomy 21, trisomy 18, trisomy 13, preeclampsia, fetal growth 
restriction and preterm delivery requires a valid FMF license that is provided by the Fetal Medicine Foundation 
directly! Please refer to the FMF website (The Fetal Medicine Foundation) for further information.

The use of the IOTA models to predict the malignancy of ovarian masses requires a certification by the IOTA 
organization. Please refer to the IOTA website (https://www.iotagroup.org/) for further information.

Intended environment of use:
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Type of environment

Medical examination room, doctor's office, nurse desk, administrative office, delivery room

Technical environment

Computer hardware, IT- systems and softwares, ultrasound machines, laboratory  devices 

Physical e nvironment

Not applicable as the product is a pure software. 

Clinical environment

Not applicable as the product is a pure software. 

Only technical personnel that have been sufficiently trained by astraia  may set up these modules or change 
their configuration or settings  with assistance from   astraia technical support. Data transfer between third-party 
systems (normally an ultrasound machine) and the astraia system should be thoroughly tested and verified prior to 
using it as a live system. Any changes to the system configuration, including that of third party systems connected 
to astraia, require further quality inspections of all transfer functions. 
These "system configuration changes" include but are not limited to: network configuration changes; software 
updates of third-party systems; software updates, reconfiguration and re-licensing of the astraia system.

All terms of the national regulations for users of medical devices apply, as well as those of other relevant legal 
regulations.

First Trimester risk assessment for chromosomal anomalies [IVD]

Only sonographers who have been certified by the Fetal Medicine Foundation, London (FMF) according to its 
directives and those who possess a valid FMF license may use the first trimester risk module. This module calculates 
the risk for Trisomy 21 [IVD], 18 and 13 using the algorithm provided by the FMF (see the 11-13+6 Weeks Scan Book 
on www.fetalmedicine.org). This probability alone does not give a diagnosis.

The performance evaluation is based on routine clinical data collected from 5 different customers in the time 
period from Jan 2014 to Feb 2022. Data was considered if analysed with valid FMF version numbers >= 3.0 which 
corresponds to the FMF algorithms 2012 (versions 3.x) and 2018 (versions 4.x). In total 38886 cases from 5 different 
customers from Denmark, the Czech Republic and the Netherlands were included in the study. Performance 
parameters were calculated using risk cut-offs of 1:100, 1:150 and 1:200. Using a cut-off of 1:100 the sensitivity and 
specificity were found to be 85.85% (77.42% - 91.77%) and 97.37% (97.20% - 97.52%), respectively. PPV and NPV 
(positive and negative predictive values) were calculated and reported as 8.18% (6.67% - 9.98%) and 99.96% 
(99.93% - 99.98%). ACC (Accuracy) and MCR (Misclassification Rate) were calculated and reported as 97.34% 
(97.17% - 97.49%) and 2.66% (2.51% - 2.83%). Predefined acceptance criteria were fulfilled. Results for specificity 
and sensitivity are consistent with previously reported data. 

International Ovarian Tumor Analysis (IOTA) Models

The International Ovarian Tumor Analysis (IOTA) group is a multidisciplinary organization involving gynaecologists, 
radiologists, oncologists, physicists, and biologists and is dedicated to many aspects of gynaecological 
ultrasonography. A main focus of the group is to develop predictive models to estimate the risk of malignancy of 
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ovarian masses. astraia – software for women’s health includes the Simple Rules, a preoperative classification 
system and LR2, a mathematical model based on logistic regression.

Please note that the use of the Simples Rules and LR2 requires a certification by the IOTA group! Upcoming 
courses / events and further information can be found on the IOTA website: www.iotagroup.org.

Simple Rules (2008)

The Simple Rules are a preoperative classification system that includes five features typical for benign tumours (B-
features) and five features typical for malignant tumours (M-features) and support trained medical doctors to 
preoperatively diagnose ovarian cancer in women who have at least one persistent ovarian, para-ovarian or tubal 
tumour. Based on the present B- and M-features, tumours are classified as Benign, Malignant or Inconclusive (Ref.: 
www.iotagroup.org).
The Simple Rules were developed based on clinical and ultrasound data from 1066 women with 1233 adnexal 
tumours recruited at 9 centres in 5 countries (Italy, Belgium, Sweden, France, and UK). The development data set 
revealed a sensitivity of 93% and a specificity of 90%. A prospective test data set (n=507) indicated a sensitivity of 
95% and a specificity of 91%. Importantly, the Simples Rules have been created for patients undergoing surgery, i.e. 
the Simple Rules cannot be applied to conservatively treated adnexal tumours as patients selected for expectant 
management were excluded when creating the model (Timmerman D, et al. Ultrasound Obstet Gynecol 
2008;31:681-90.).

The Simple Rules have been internally and externally validated in multiple studies: 
Timmerman D, et al. BMJ 2010;341:c6839. Testa AC, Kaijser J, et al. Br J Cancer 2014;111:680-8. Fathallah K, et al. 
Gynecol Obstet Fertil 2011;39:477-81. Hartman CA, et al. Ultrasound Obstet Gynecol 2012;40:360-6. Alcázar JL, et al. 
Ultrasound Obstet Gynecol 2013;42:467-71. Sayasneh A, et al. Br J Cancer 2013;108:2448-54. Tantipalakorn C, et al. 
Asian Pac J Cancer Prev 2014;15:5123-6. Nunes N, et al. Ultrasound Obstet Gynecol 2014;44:503-14. Tinnangwattana 
D, et al. Asian Pac J Cancer Prev 2015;16:3835-8. Ruiz de Gauna B, et al. Eur J Obstet Gynecol Reprod Biol 
2015;191:10-4. Knafel A, et al. Ultraschall Med 2015 Jun 30. [Epub ahead of print]. Alcázar JL, et al. Ultrasound 
Obstet Gynecol 2016;48:397-402

LR2

LR2 estimates the probability that an adnexal mass is malignant and supports trained medical doctors to 
preoperatively diagnose ovarian cancer in women who have at least one persistent ovarian, para-ovarian or tubal 
tumour.
LR2 uses one clinical variable (age) and five ultrasound variables (maximal diameter of the largest solid component, 
irregular internal cyst walls, presence of papillary projections with detectable flow, acoustic shadows, and ascites) 
(Ref.: www.iotagroup.org).
LR2 was developed based on clinical and ultrasound data from 754 women recruited at 9 centres in 5 countries 
(Italy, Belgium, Sweden, France, and UK) and gave an area under the receiver operating characteristic curve (ROC) 
of 0.95 for the development data set and a ROC of 0.94 for the test data set (n = 312 patients). The probability cut-off 
value of .10 revealed a sensitivity of 93% and a specificity of 76%. Importantly, LR2 has been created for patients 
undergoing surgery, i.e. LR2 cannot be applied to conservatively treated adnexal tumours as patients selected for 
expectant management were excluded when creating the model (Timmerman D, et al. J Clin Oncol 
2005;23:8794-801.).

LR2 has been internally and externally validated in multiple studies:
Van Holsbeke C, et al. Clin Cancer Res 2009;15:684-91. Timmerman D, et al. Ultrasound Obstet Gynecol 
2010;36:226-34. Van Holsbeke C, Van Calster B, et al. Clin Cancer Res 2012;18:815-25. Nunes N, et al. Ultrasound 
Obstet Gynecol 2012;40:355-9. Sayasneh A, et al. Br J Cancer 2013;108:2448-54. Kaijser J, et al. Gynecol Oncol 
2013;129:377-83. Nunes N, et al. Int J Gynecol Cancer 2013;23:1583-9. Testa A, Kaijser J, et al. Br J Cancer 
2014;111:680-8. Meys EM, et al. Ultrasound Obstet Gynecol 2016
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All custom software modules which have been developed to customers' individual requirements, such as interfaces 
to hospital information systems or other third-party systems, are limited to the intended use agreed by both 
parties.

If national or international laws, directives or regulations are limiting the intended use of the product, they have 
absolute priority over the statements above.

The group of permitted users is defined by the precise definition of the intended use. The customer must ensure 
that all relevant regulations concerning data protection are met and that the necessary data security procedures 
are in place. astraia provides you with comprehensive user access management, enabling you to define who is 
allowed to use astraia features and to access or change some data. Access to the astraia system is protected by user 
names and passwords.

We wish you all the best for your future work with astraia - software for women's health.
NEXUS / ASTRAIA GmbH

Copyright 2024 NEXUS / ASTRAIA GmbH Ismaning

For the internal use of licensed customers only. Publication or distribution of this information in any form is strictly 
prohibited without the express written consent of NEXUS / ASTRAIA GmbH.

2.3 System Requirements and Installation

2.3.1 System Requirements
Details about the recommended system configuration for an astraia single user or network installation can be 
downloaded from the astraia website: https://www.nexus-astraia.com/support.

Please report all complaints regarding the astraia product to our support team, support@astraia.com. 

Users and Patients Note: The user and/or patient must report any serious incidents related to the 
product to the manufacturer and the relevant competent authority of the Member State in which the user 
and/or patient is established.



Please ensure that the system is operated by sufficiently trained personnel only.
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System requirements for standalone systems

Single workstation1

Minimum Recommended

CPU 2 Cores 4 Cores Intel

RAM 4096 MB (2048 MB for 32bit systems) 8192 MB

Storage 150 GB + Backup system 500 GB + Backup system

Graphic resolution 1280 x 1024 1680 x 1050

Operating System Supported Recommended

Windows 8/8.1 Pro (32-bit or 64-bit)2,

Windows Server 2016/2019

Foundation/Essentials/Standard/
Datacenter (32-bit or 64-bit)2,

Windows 10 Pro/Enterprise (32-bit or 64-
bit)2,

Windows 11 Pro/Enterprise (32-bit or 64-
bit)2,

Windows 11 Pro/ Enterprise (64-
bit)2

Database Sybase SQL Anywhere 16

Microsoft SQL Server 
2014/2016/2017/20193 with compatibility 
mode

Microsoft SQL Server 2022

Oracle 19c4

PostgreSQL 13

Microsoft SQL Server 
2014/2016/2017/20193 with 
compatibility mode

Microsoft SQL Server 2022

Oracle 19c4

PostgreSQL 13
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System requirements for network client computers

Client workstations1

Minimum Recommended

CPU 2 Cores 4 Cores Intel

RAM 2048 MB 4096 MB

Storage 50 GB 100 GB

Network 100 Mbit/s 1000 Mbit/s

Graphic resolution 1280 x 1024 1680 x 1050

Operating System Supported Recommended

Windows 8/8.1 Pro (32-bit or 64-bit)2,

Windows 10 Pro/ Enterprise (32-bit or 
64-bit)2

Windows 11 Pro/ Enterprise (32-bit or 
64-bit)2,

Windows 10 Pro/ Enterprise (64-bit)2

Windows 11 Pro/ Enterprise (32-bit or 
64-bit)2,
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System requirements for servers

Application and database server

Minimum Recommended

CPU 2 Cores Intel 4 Cores Intel Xeon

RAM 4096 MB 8192 MB

Storage 500 GB + Backup system 1 TB RAID + Backup system

Network 100 Mbit/s 1000 Mbit/s

Graphic resolution 1024 x 768 1280 x 1024

Operating System Supported Recommended

Windows 8/8.1 Pro (64-bit)2,

Windows Server 2016/2019

Foundation/Essentials/Standard/
Datacenter (64-bit)2,

Windows 10 Pro/ Enterprise (64-bit)2, 

Windows 11 Pro/ Enterprise (32-bit or 
64-bit)2

Windows Server 2016, 2019

Foundation/Essentials/Standard/
Datacenter (64-bit)2, 

Database Sybase SQL Anywhere 16

Microsoft SQL Server 
2014/2016/2017/20193 with 
compatibility mode

Microsoft SQL Server 2022

Oracle 19c4

PostgreSQL 13

Microsoft SQL Server 
2014/2016/2017/20193 with 
compatibility mode

Microsoft SQL Server 2022

Oracle 19c4

PostgreSQL 13
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Further requirements for all components

Specified for computer systems running astraia in addition to standard office software. If further high-performance 
software applications are to be used on the same hardware, please contact our support team for clarification.

Backup: local backup service or network backup service
Supported database systems:

Sybase SQL Anywhere 16 (legacy support for existing installations, recommended moving to 
PostgreSQL). For larger installations, it is recommended to use Microsoft SQL Server or Oracle in 
order to avoid performance issues. Please contact our support team to discuss the best option for 
your installation.
Microsoft SQL Server 2014/2016/2017/20193 (fully supported by astraia application/with 
compatibility mode; database administration by qualified hospital IT staff),
Oracle 19c (fully supported by astraia application; database administration by qualified hospital IT 
staff)

Remote access: Stable broadband internet connection for TeamViewer™ or VPN access

1 macOS's users: Please contact our support for requirements on setting up a virtualized solution with a supported 
MS Windows version.
2 By default, astraia setup installs the 64-bit version of Java. Please contact our support for information about 
installing the 32-bit version.
3 Microsoft SQL Server versions supported with compatibility mode level 110 (equivalent to enable MS SQL 2012 
compatibility). Please contact our support in case of questions.
4 Oracle database engine needs to be configured in astraia to use connection pool, this is mandatory otherwise 
astraia application could not work correctly.    

2.3.2 Protection of data (technical security)
All personal data stored in the astraia system is stored in a relational database management system (RDBMS) as 
outlined in "Structure of the filing system" below.

The RDBMS is one of PostgreSQL, MS SQL Server, Oracle DB and Sybase SQL Anywhere (legacy and not installed by 
default anymore) as listed in the document System Requirements.

By default, a PostgreSQL database is used, which is preconfigured. On request by the customer, MS SQL Server or 
Oracle DB can be used under the sole responsibility of the customer concerning its data security, safety and 
technical administration.

For special configurations where two or more different sites are connected via the Internet (e.g. astraia 
server → VPN → astraia clients), the minimum bandwidth necessary to ensure a sufficient working speed 
for astraia is: 5Mb up/down for astraia networks without imaging and 10Mb up/down for astraia 
networks with imaging.



Please note: It is recommended to review the list of known issues for technical workarounds that 
complement the information shown in this document.


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2.3.2.1 Protection of the database
For all database types, the access to the database is protected by username and password. Only the astraia 
software system shall have direct access to the database by these credentials. The credentials are stored in a non-
retrievable way in the software.

PostgreSQL: The database server with the database to be used for astraia shall be set up with encryption 
enabled as outlined in the administrator documentation provided by PostgreSQL community. We 
recommend TDE (transparent data encryption) based on AES
MS SQL Server: The database server with the database to be used for astraia shall be set up with encryption 
enabled as outlined in the administrator documentation provided by Microsoft. We recommend TDE 
(transparent data encryption) based on AES and 3DES.
Oracle DB: The database server with the database to be used for astraia shall be set up with encryption 
enabled as outlined in the administrator documentation provided by the Oracle Database Advanced 
Security Guide. We recommend TDE (transparent data encryption) based on AES192.
Sybase SQL Anywhere : The Sybase SQL Anywhere database is by default encrypted with a proprietary 
method from Sybase based on AES encryption when delivered to the customer. On demand by the 
customer, AES-128 and AES-256 can be used, but we recommend one of the other database solution 
mentioned above.

For all database servers, it is recommended to apply state-of-the-art firewalls and antivirus/malware protection 
software in order to mitigate the risk of unauthorized access and compromising data.

The communication between the astraia software and the database server is performed via TCP/IP and 
unencrypted. Security has to be enforced by securing the network. If the network cannot be secured to an 
acceptable level, you can encrypt the communication by use of VPN and SSL tunnels.

2.3.2.2 Protection of the astraia software
Access to the astraia software is restricted to registered users with a login which requires an individual username 
and an individual password. Registration of users is done by the astraia system administrator.

Password policies to enforce rules on passwords and expiry of passwords can be set by the astraia administrator. 
Login, logout and view of personal data stored in astraia are tracked by the system in an audit trail with unlimited 
storage duration.

Personal rights on who can edit and view medical data, is able to print patient data, export it or perform statistical 
queries on the data, is to be configured for each individual user in the software and can be enabled or disabled for 
user groups.

For further information, consult the astraia manual of the corresponding version and its sections 'Options - Users' and 
'Options - Groups'.

Duration of storage is unlimited for legal and medical reasons. If the deletion of patient records is required, the 
system keeps track of deletion of personal data in the audit trail. This is described in more detail in the astraia 
manual and its section 'Audit Trail and Database Archive'.

For the servers and client computers where astraia is installed, it is recommended to apply state-of-the-art firewalls 
and antivirus/malware protection software in order to mitigate the risk of unauthorized access and compromising 
data.
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2.3.3 Backup and archiving of data (technical safety)

2.3.3.1 Backup
In order to maintain safety of data against loss and corruption, regular backups of the astraia database are needed. 
The astraia software supports backups for the database, with automatically scheduled backups at predefined times 
for the client/server version of astraia. For details, please consult the astraia manual of the corresponding version
and its section 'Database Backup' and discuss backup plans with our support department.

2.3.3.2 Archive
In case the customer wants to stop using astraia actively, we offer to create a complete archive of the current 
astraia installation, including database, log files, and image library, and to test access to it prior to handover. A log 
is created when the archive file is transferred and signed by both parties. The archive file is encrypted, the password 
is transferred. This determines the time of deactivation. Astraia imports a license on the system that only allows 
read access to the data.

This also terminates the existing software maintenance agreement with the date of decommissioning.

The file is stored on a disk provided by the customer, which has to be kept in a safe place.

If read access to the data is required, astraia is available for remote maintenance. As a result, the customer gets a 
virtual machine and has access to all the data.

2.3.4 Installation and Update
The installation and update for the software ‘astraia – software for women’s health’ will be executed by selected 
and trained astraia staff or astraia partners/distributors. Please contact our support team at support@astraia.com.

2.3.5 Disposal
This medical product is a stand-alone software. This means that the product must be uninstalled and no 
waste products are produced. The uninstallation must be carried out by trained personnel. To do this, contact the 
software distributor or NEXUS / ASTRAIA GmbH directly.
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2.4 Quick Guide to Using the Program
Logging in

On starting the program you are asked to enter your name and password. Your user name controls some features of 
the program, such as the ability to change data, to run queries or to change lists. The program administrator (user 
name admin) can add new users and change user settings (see Options - Users (see page 177) and Options - Groups (see 
page 179)).

The Desktop

The program desktop (see The Desktop (see page 22)) contains buttons that open new windows, such as patient 
records (Patients) or statistic queries (Queries). If you want to open a module, click on it or press the key of the 
initial letter of the module (P for Patients, Q for Queries, A for Audit, D for Diary, O for Options and E for Exit).

Entering patient data

In order to find a patient in the database or to book a new patient (see Selecting a Patient Record (see page 24)), click 
on Patients on the desktop.

After having selected a patient or booked a new patient, you can choose a case (see Selecting a Case (see page 26)). 
Here you can decide between Pregnancy (see page 28), Gynaecology (see page 64), Colposcopy (see page 69) or Fetal 
Echocardiography (see page 72) (depending on which modules are licensed) or you can take a look at a past or the 
current case.

After you have booked a new patient and selected the case, the next screen will be the screen for patient data (see 
Patient Data (see page 91)). If you have selected an already existing patient, you have three possibilities.

You can:

open the current case (e.g. pregnancy) and do a new examination (e.g. a biometric examination two months 
after the first trimester scan);
open a new case (e.g. a gynaecological examination or a new pregnancy);
open a past case (e.g. to look up the outcome of a past pregnancy).

Make sure that you log in with your own user account. If you do not have a user account, please contact 
your clinical administrator so that they can create one for you. If somebody else is already logged in (you 
can see the current user on the right side of the menu bar), please log them out first. 


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If a new case is created, the patient data is displayed automatically and you are also given the opportunity to copy 
the patient history from the previous case.

Navigation and data entry

In the summary (see Navigation and Summary (see page 75)), you can take a look at the most important data of all the 
examinations in one case. Here you can also change between the different examinations. In order to look at a 
particular screen in detail, that screen has to be selected using the navigator (see Navigation and Summary (see page 
75)) on the left-hand side.
You can enter data either in text fields or lists (see The Record Screen (see page 88)).

Navigation with multiple windows

You can open as many windows as you like, move them around and minimize windows you are not currently using. 
Each window has a title bar. The patient title bar includes the patient's Id-number, name, date of birth and age:

The content of this title bar can be modified to e.g. display the hospital number instead of the astraia patient ID, to 
configure this please contact the astraia support team.

The three icons on the right side are used to minimize, maximize and close the window. The currently selected 
window is displayed with a coloured title bar, as shown in the picture. When a window is minimized, it is 
automatically placed at the bottom of the desktop and appears as:

To restore a minimized window, click on it with the mouse. You can also select and restore a window from the 
Window menu at the top of the screen.

In the following section, you will find a quick introduction to documenting an examination. Here we will do a first 
trimester screening and then a biometric examination on an imaginary patient. You can follow the procedure on 
your version of astraia, however, please be sure to use a training database or have the patient deleted by your 
astraia administrator after finishing these tutorial examinations.

First Case: First trimester screening

Let's assume a new patient arrives for a first trimester ultrasound examination.

First, click on Patients on the desktop. Next, enter the surname, first name and date of birth of the patient. Now 
click on Book (F2) and choose a New case: Pregnancy. You can now enter all known demographic data of the 
patient and her partner in the patient data screen.

Next, please select History on the navigator. In this screen, you can enter pregnancy-specific data such as the first 
day of the Last period. Since the last period is known in most cases, it is displayed by default. If you click on Last 
period you can also select a different set of data. You can also enter different aspects of patient history like an 
obstetric history, chronic diseases, family history or maternal medication by clicking on the associated screens on 
the navigator.

Now we begin the examination. For example, you could now click on Indication on the navigator which will open a 
screen enabling you to enter the indication information for the current examination.
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In this case, the next step would be the ultrasound examination. Therefore you can click directly on First Trimester
on the navigator. The First Trimester screen is a subscreen of the ultrasound examination because the first 
trimester examination is only one of many possible ultrasound examinations during pregnancy.

The date and time of the examination are automatically completed with the current date and time but could be 
modified if you are entering data for a past examination, e.g. from the day before.

You should now click on the empty field next to Operator and select your name from the list. If the list is empty, 
click on Change this list and fill in your name (see Editing Helper Lists (see page 94)). If you want to calculate the 
gestational age from dates (e.g. last period) or enter it manually, click on Gestational age and check the 
appropriate checkbox. However, if you want to calculate the gestational age from ultrasound measurements, you 
will first have to enter the ultrasound measurements in the respective fields and afterwards click on Gestational age 
(see Examination and Ultrasound (see page 33)).

After having filled out the fields in the History and First Trimester Ultrasound section, you can click on the 
Biochemistry tab. Here you can enter all relevant data for biochemical analysis (see Biochemistry (see page 46)). 
The ethnic group, smoking and Method of conception fields in the History section are automatically completed, 
where possible, from known values in the patient history.

If you now click on the Patient counselled and consent given checkbox in the risk calculation section, you will be 
able to calculate the risks. Press the Calculate button and you will see the risk of trisomy 21 and trisomy 13+18 if 
you are in possession of a valid FMF License (for information on importing the FMF License see Options - FMF 
Risks (see page 190)).

Now you could proceed to the Conclusions screen by selecting it from the navigator. Here you can enter the 
diagnosis, procedure codes and additional free text if applicable.

As soon as you have finished entering data, select File - Save (Ctrl + S) in order to save the patient and the case. 
Furthermore, you can print a selection of automatically created reports by clicking on File - Print (Ctrl + P). You can 
also save these reports as PDF files or send them via fax or e-mail (see Printing Reports (see page 129)).
You can close the patient using File - Close (F10) or with the Save and close the patient icon underneath the 
navigator.
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Second Case: Biometric Examination with the same patient

Now let's assume that the same patient arrives about two months later for a biometric examination.

First, click on Patients on the desktop and enter the patient's last name. You should see at least one patient that 
matches (the patient we entered in the first case). If there are other patients with the same last name in the 
database, they will be displayed as well. Select the correct patient and press Select (Enter). Leave the checkbox 
Current case selected and click OK. The next screen is the summary of the previous first trimester examination. 
Now click on New Examination (Ins). A new examination will be created with the current date and time (which 
should be 2 months in the future) - the patient history and demographic data are automatically associated with 
both examinations.

Please note that the currently-selected examination is highlighted in white, the other examination has a grey 
background.

Now you can enter the data for this examination. By clicking on Indication on the navigator you can once again 
enter the indication for the new examination.

The next step is the ultrasound examination. Select Biometry / Anatomy, which is also a subscreen to the 
Ultrasound screen.

The date and time are again automatically filled in but can be modified. The gestational age is automatically 
calculated to fit the new examination. It is calculated from the data of the first trimester examination (if you click on 
Gestational age, a warning message will appear).

After having entered all measurement data in the Biometry / Anatomy section, you can continue to complete the 
Detailed Anatomy (see Detailed anatomy (see page 45)) tab pages. If you select "normal", "not seen" or "not visible" 
in one of the tab pages, the cursor jumps to the next tab page. If you select "normal" on a tab page, the tab page 
turns green. If you select "not seen" or "not visible", the tab page turns black. If you select any abnormalities, the 
tab page will turn red.

After you have finished entering the data from your ultrasound examination, you can once again select Conclusions
on the navigator and fill out that screen.

Once finished, you can once again save the case, print some reports and close the patient as described in the first 
case.

All other functionalities of the program will be explained in detail in these chapters.



astraia user manual - 29.x

Published on: 15-Jan-2024
NEXUS / ASTRAIA GmbH

The Desktop- Page 22 of 263

•
•

•

3 The Desktop
After the login, you will see the astraia desktop. The desktop is the starting point for all further activities within the 
program. The various program options (Patients - Queries - Audit - Diary - Reminders - Options - Exit) can be 
selected by clicking on the buttons. If you want to navigate with the keyboard, press the key of the initial letter of 
the module.

Patients

By clicking on the Patients option on the desktop (or pressing the key P) you can:

search for a patient in the database or enter a new patient (see Selecting a Patient Record (see page 24));
choose a case: Pregnancy (see page 28), Gynaecology (see page 64), Colposcopy (see page 69) or Fetal 
Echocardiography (see page 72) (see Selecting a Case (see page 26));
enter patient data and examination results (see The Record Screen (see page 88)).
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Queries

The Queries (see page 141) option (keyboard shortcut Q) allows you to run pre-defined or user-defined queries.

Audit

The Audit (see page 222) module (keyboard shortcut A) contains the following complex database queries:

First Trimester Audit: this audit is for NT, ß-hCG and PAPP-A values and distributions and creates a graphical 
presentation of the data in the first trimester. This module is only available for doctors holding valid FMF licenses 
from the Fetal Medicine Foundation, London.

Second Trimester Audit: this audit is for biometry values in the 2nd trimester (BPD, HC, AC, FL, Uterine PI, 
Umbilical PI, Ductus Venosus PI, Middle Cerebral PSV) and is available to all privileged users.

FMU Statistics: FMU Statistics allows users to export monthly figures for first/follow up scans and procedures 
(Amniocentesis, Fetal Blood Sampling, CVS, etc.) into an Excel file.

EPU Statistics: Early Pregnancy Statistics provides the ability to export early pregnancy data on a monthly basis 
into an Excel file.

Automatic Audit (if licensed): this performs a set of database queries at a preset time, usually monthly. These 
queries are synchronized via the Internet and the results returned using encryption.

KC65 Colposcopy Report (if licensed): this audit queries a set of colposcopy examination data that can be printed 
or previewed.

Diary

The Diary (see page 151) option - press the key D - enables you to manage appointments for the various ultrasound 
and procedure rooms.

Reminders

The Reminders (see page 134) option (Keyboard shortcut R) helps you to get an overview of open patient tasks and 
reminds you of calling a patient for an appointment.

Options

The Options (see page 163) item (keyboard shortcut O) allows you to change the program settings for Appearance (see 
page 164), Administrator (see page 167), Users (see page 177), Groups (see page 179), Charts (see page 183), Printouts (see page 185), 
FMF Risks (see page 190), Imaging / Worklist (see page 194), Lab interface (see page 199), Patient data (see page 207) and 
Workstation (see page 211). In Appearance (see page 164), the preferred language can be selected.

Exit

Click on the Exit button (or press the E key) to leave the program.
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4 Selecting a Patient Record

The patient lookup is a simple tool for retrieving a record from the database, or for entering a new patient. Click on 
the field Patients on the desktop, the Patient Lookup window will open:

To find an existing patient, enter the patient's name, and optionally other names, date of birth or hospital 
number. If you know the database Id press the Up arrow once and type in the Id number of the patient. You can 
also change the initial focus of the list in Options - Patient data (see page 207).

The database assigns a unique number to each patient, which we call the patient Id number. By using this number 
you will find that retrieving patient records becomes much easier, avoiding mistakes caused by the incorrect 
spelling of names.

As you enter details, the list is automatically filled. If too many patients are displayed, you should enter more 
information. Note that by default the list starts to fill once you have typed two characters of the name, so it is not 
always necessary to type the full name. For big databases, you might want to change this behaviour to start filling 
after 3 or more characters only, which will reduce the result list and display the result faster (you can change this in 
Options - Patient data (see page 207)).

When there is only one patient in the list, or you have selected the correct patient in the list you can proceed by 
pressing Enter, clicking the Select button, or double-clicking on the list entry.

To enter a new patient, follow the same procedure and enter all the known fields correctly. As before, the list will 
display any patient having the same details, so you can check that the patient has not previously been entered.

When you have entered all data of the new patient correctly you can add this patient to the database by pressing 
F2 or clicking the Book button.

Please remember, double-booking a patient causes a lot of problems: Proceed very carefully while 
entering patient data. If your entered details match a patient in the list, you will need to uniquely identify 
the new patient; in case all known patient data match an already booked patient, you could use the field 
hospital number to distinguish the new patient, even if you do not normally use a hospital number.


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The patient list offers a sorting function, where you can sort the list for Id, date of birth, hospital number, last visit 
or alphabetically for the name, other name or town. Click on the header of the column you want to sort and an 
arrow symbol (in this example for 'Other names') will indicate the direction the list is sorted.

Interfaces:

In case your astraia installation is connected to a hospital information system via a HIS interface, the option HIS
(F3) appears on the patient lookup screen. After entering certain patient data (normally the hospital number or the 
patient name) you can click on the HIS button and the astraia program will send a request to the connected 
hospital database. All matching patients (in case you use the hospital number it should only be one) will be 
displayed in the patient list. Next, choose Book (F2) if it is a new patient or Select (Enter) if the patient already 
exists in the database.

In case your astraia installation is connected to an ultrasound machine and you use the DICOM Worklist with the 
astraia Worklist server to transfer data, another button called Worklist (F5) is visible. Clicking on Worklist displays 
all patients whose records have been sent to the worklist of the ultrasound machine.

How to send patients to the worklist, see Navigation and Summary (see page 75)

How to set up and configure the HIS interface or the worklist, see Options - Patient data (see page 207) and Options - 
Workstation (see page 211).
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5 Selecting a Case
When you enter a new patient, the following window will open. You need to select a new case from the popup list 
and then press OK. The default case is Pregnancy:

When opening a new case with an already existing patient (one or more cases existing) you can choose to copy the 
relevant history data from the previous case. The old data will not be changed.

When you open an existing patient you can choose from opening the current case, a past case or a new case:
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To select a past case, you must select the checkbox past cases, and then choose a case from the list by clicking on 
the line. A new case can be selected from the popup list after the checkbox New case has been selected.
The following cases can be documented in astraia - software for women's health, as long as they have been 
licensed (see The Menu Bar (see page 230)):

Pregnancy (see page 28)
Gynaecology (see page 64)
Colposcopy (see page 69)
Fetal Echocardiography (see page 72)
Breast screening (only available in some languages, currently not available in English)
MRI (evaluation phase)

If you are watching a past case, there is a simple way to view another past case or to create a new case for the 
patient. Therefore, you have to click on the Data field in The Menu Bar (see page 230) and select Change case.
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5.1 Pregnancy
The case pregnancy covers the following areas:

Patient details (see page 91) Shows personal information and demographic data about the patient 
and her partner.

History In this branch, you can enter data about the present pregnancy and the 
mother's pre-pregnancy condition.

Obstetric History Gravida, Para and a detailed record screen for the obstetric history.

Chronic Disease Selection of common chronic diseases.

Family History Detailed family history with pedigree.

Maternal Medication List of medication and radiation exposure.

Examination

Indication Shows the indication of the examination.

Ultrasound (see page 33) Ultrasound contains: Early Pregnancy (see page 36); First Trimester 
Ultrasound (see page 39) with History, Detailed anatomy (see page 45),  
Biochemistry (see page 46), Mean Arterial Pressure (see page 49) and Risk 
calculation - [IVD] (see page 50); Biometry/Anatomy; Growth Scan; Doppler; 
Fetal Echocardiography (see page 72)* (licensed module) with a Detailed 
Assessment, Cardiac Biometry and Doppler; Fetal Neurosonography 
(licensed module) with Cephalic Biometry; Placenta evaluation; Cervical 
assessment; Maternal structures with Uterus, Ovaries, Adnexal masses 
and Kidneys/Bladder; Videos.

PE Screening (see page 58) This screen contains all necessary sections and fields for the calculation 
of preeclampsia risks in the second and third trimester, including 
maternal characteristics and history as well as biochemical and 
biophysical markers. 
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Fetal assessment The fetal assessment contains a biophysical profile, fetal heart rate and 
an amniotic fluid index.

Counselling The section Counselling allows the text entry for genetic counselling 
with indication and details and provides second trimester risk 
assessment for chromosomal abnormality (according to Nicolaides KH: 
Screening for chromosomal defects (Editorial). Ultrasound Obstet 
Gynecol. 2003 Apr; 21(4): 313-21).

Procedures Available are Amniocentesis, Chorion Villus Sampling (CVS), Fetal Blood 
Sampling (FBS), Amnio Drainage, Amnio Infusion, Fetal Sampling, Shunt, 
ER/ Fetocide, Laser Ablation and Cervical Suture.

Investigations Investigations show the results of examinations of maternal blood, 
maternal urine, fetal blood, amniotic fluid, fetal and maternal karyotype 
and genetic studies.

cfDNA testing Non-invasive prenatal testing (NIPT) data obtained from cfDNA testing 
can be entered here.

Maternal Assessment Here you can enter the clinical examination results of the mother.

Conclusions Conclusions offer a lookup table for diagnosis and procedure codes. 
Furthermore, you can add individually configured text elements for 
standardized letters (see The Reporter (see page 102)) or memos or enter a 
free text.

Letters Within this submenu, standardized letter components can be created, 
structured hierarchically and utilized in printouts.

Accounts Accounts for examinations and procedures.

Delivery The licensed module Delivery contains tabs for information on Labour 
induction, Rupture of membranes, Labour, Delivery, Caesarean, 
Placenta delivery, Perineum, Medication and Complications.

Check-in Document various check-ins during the delivery.

Postpartum / Discharge Record information on the postpartum phase and discharge.
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Outcome Shows an overview of the outcome of pregnancy.

Neonatal Period Includes treatments that can be done during the neonatal period.

Postmortem Findings If there has been an autopsy, the results can be entered here.

Placenta Outcome Findings on the placenta can be entered here.

* The module Fetal Echocardiography can either be used as part of a pregnancy case or as a separate case. For more 
information, please see Fetal Echocardiography (see page 72).

For multiple screens in the case pregnancy, there are alternative screens that can be selected (see Screen 
Configuration (see page 213)). In this list the preset default screens are printed in blue, the screens for which you can 
change the configuration are printed in bold:

Patient details:

Patient name:

Patient name
Patient name (Netherlands)
Patient name (Swiss)
Patient name (Portugal)
Patient name (Greek)
Patient name (Canadian)
Patient name (China)
Patient name (neonatal)
Patient name (SGH)
Patient name (Russian)
Patient name (Hungarian)
Patient name (Albanian)

Patient demographics:

Patient demographics (default)
Patient demographics (Canadian)
Patient demographics (Netherlands)
Patient demographics (UK/NHS)
Patient demographics (Denmark)
Patient demographics (Austria)
Patient demographics (Mamma)
Patient demographics (Russian)
Patient demographics (Hungarian)
Patient demographics (Albanian)

Partner:
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Partner
Partner (Canadian)
Partner (Albanian)

History - Maternal Medication:

Maternal Medication:

Maternal Medication
Maternal Medication - record

Examination:

Examination header:

Examination header
Examination header (Portugal)
Examination header with order button
Examination header (Gynae referral)
Examination header (SGH)
Examination header (Albanian)

Patient Visit Information

Patient Visit Information (empty)
MSH - Patient Visit Information
Patient Visit Information RIS

Examination - Indication:

Pregnancy Indication:

Pregnancy Indication
Pregnancy Indication NL
Pregnancy Indication DK

Examination - Ultrasound:

Ultrasound header:

Ultrasound header (detailed)
Ultrasound header (incl. code)
Ultrasound header FMF
Ultrasound header (Gravida, Para)
Ultrasound header (with EDD for Luxembourg)

Examination - Ultrasound - First Trimester:

First Trimester:

First Trimester assessment
First Trimester assessment study screen (this screen should not be used as it is due to unexpected changes 
according to FMF studies)

Examination - Ultrasound - Biometry/Anatomy and - Growth scan:

Biometry/Anatomy:
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2nd trimester scan
2nd trimester scan (with ventricular ratios)
2nd trimester scan (manual HC & AC)

Examination - Ultrasound - Doppler:

Doppler:

Basic doppler
Full doppler
Extended doppler

Examination - Ultrasound - Cervical Assessment:

Cervical Assessment:

Cervical assessment
Cervical assessment (prematurity clinic)

Examination - Procedures:

Invasive Procedures:

Invasive Procedures
Invasive Procedures (SGH)

Examination - Procedures - Amniocentesis:

Amniocentesis:

Amniocentesis
Amniocentesis (SGH)

Examination - Procedures - CVS:

CVS:

CVS
CVS (SGH)

Examination - Procedures - FBS:

Fetal Blood Sampling:

Fetal Blood Sampling
Fetal Blood Sampling (SGH)

Examination - Conclusions:

Pregnancy diagnosis:

Pregnancy diagnosis
Pregnancy diagnosis (text for diagnosis)

Pregnancy conclusions:

Pregnancy conclusions
Pregnancy conclusion - Referral
Pregnancy conclusions (+ mat. Diag. + Proc.)

Accounts:

Accounts:
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Accounts
Accounts detailed

Outcome:

Outcome:

Outcome
Outcome (Portugal)

5.1.1 Examination and Ultrasound
To enter ultrasound details, you must record the date of the examination and the name of the operator
(ultrasonographer).

This is the screen examination and ultrasound:

The date is automatically set to today's date, but it can be manually changed to any other date.
The operator list is initially empty - click on the field Operator and the list editor (see Editing Popup Lists (see 
page 92)) will appear. To add new operators to the list choose Change this list or press Alt + Enter to open the 
list editor.
FMF- Risk Module: The Risk Module is accessible over the subscreen First trimester in Ultrasound. Each 
operator who wants to use the FMF First Trimester Risk calculation needs a valid FMF operator code. It is not 
possible to calculate a risk without the FMF user ID. You can import your FMF license file in Options - FMF 
Risks (see page 190) and the list of FMF operators on the Risk calculation screen will be automatically filled with 
the name and FMF code from the imported license.
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You can calculate the gestational age by clicking on the field 'Gestational age'. The window 'Gestational age 
calculator' appears. Here you can choose between calculating the GA by ultrasound measurements (individual 
measurements or a combination of them), from dates - e.g. last period - (if the last period has been entered in the 
history), or entering the GA manually - e.g. if a colleague has already dated the gestational age in a previous 
examination which was not recorded in astraia.

The fields for weeks and days cannot be edited unless you have chosen the method Manual.

You can generally calculate the gestational age by any measurements, as long as you have selected a chart in which 
that measurement is a function of the gestational age (see Options - Charts (see page 183)).

In case you have a first trimester examination, you can calculate the gestational age e.g. by the measurement 
CRL.

Another possibility to date the GA by ultrasound measurements in case of early pregnancy is the gestational sac 
diameter. If you have selected gestational sac as Morphology and entered valid measurements in the fields for 
gestational sac, the checkbox GSD appears. For more information about early pregnancy see Early Pregnancy (see 
page 36).

In case of a Biometry / Anatomy or Growth scan (2nd and 3rd trimester) examination, you can calculate the 
gestational age by the ultrasound measurements BPD, HC, AC and FL.

Another point on the Examination screen is the department list. Here you can add and edit departments. To 
change the list you have to be logged in as admin or user, who has the right to change popup lists. In order to add a 
new department click on the department list and go to the point "change this list". As you can see in the picture 
below you have the possibilities to add a new department, to hide an existing department and to set a department 
as default.

Note: You are not able to delete an existing department, but you can hide it.

The following fields can be assigned to a department: Operator, Operator 2, Supervised by and US System.

Please note that the gestational age will not be automatically adjusted if you have chosen to calculate 
the GA by measurements and afterwards change your measurement data. In that case, please re-open the 
gestational age calculator and date the gestational age one more time in order to receive the correct GA.



If you change the examination date, click on Gestational age again in order to refresh the calculation.
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In the menu Options - Users (see page 177) you can refer every astraia user to a department.

In order to refer an operator to a special department, click on the point "change this list" in the operator popup list. 
In the picture below you can see a list of operators and departments. Just click on on the department field right 
next to an operator and a pop-up window with the different departments will open. Now you can refer every 
operator to a department.
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5.1.2 Early Pregnancy
This is the screen Assessment of early pregnancy

The early pregnancy examination serves the purpose of determining the pregnancy site and confirming a 
pregnancy before the 10th week of gestation.

The date which can be used to calculate the gestational age (e.g. last period) will be transferred from the patient's 
pregnancy history. If you did not enter a date in the history and you enter a date in the early pregnancy screen, the 
date will be transferred the other way around. In the case of multiple pregnancies click on the tab New pregnancy
and a new tab Pregnancy 2 occurs. By clicking on the tab you can switch from Pregnancy 1 to Pregnancy 2 as 
required.

For each new multiple, you can once more click on the tab New pregnancy.

As soon as you have entered multiple pregnancies, the option chorionicity will appear. The data you enter here is 
the same for each pregnancy.

You can also delete the most recently added tab. Therefore you will have to right-click on the last tab and select 
Delete this tab page.

Determining the pregnancy site you have three choices:

within the intrauterine cavity
outside the intrauterine cavity
pregnancy of unknown location (PUL)

If the pregnancy is within the intrauterine cavity, you can enter the measurements for the gestational sac, the 
yolk sac and the amniotic sac and, if visualised, the heart rate and crown-rump length of the embryo.
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Should the pregnancy be located outside the intrauterine cavity, the options Location, Morphology and 
Management of ectopic pregnancy are available. To add the maternal blood values to the table, please click on 
blood taken to measure serum hCG and progesterone.
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In case of a pregnancy of unknown origin (PUL), a screen appears where you can enter various measurements. In 
addition, you can enter the results of the mother's blood.
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Independent of the pregnancy site, you can enter further management and a free-text comment.

5.1.3 First Trimester Ultrasound
After clicking on First trimester a tabular layout is used to display the six relevant sections in first trimester 
screening:
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The sections are:

History: This section is where maternal characteristics and information concerning previous pregnancies 
are entered. For more information: History chapter (see page 40).

Ultrasound: In this tab, the results of the ultrasound examination are entered. For more information: 
Ultrasound chapter (see page 43).

Detailed anatomy: Detailed information about the fetus anatomy can be entered here. For more 
information: Detailed anatomy (see page 45).

Biochemistry: This tab is for the results of the first trimester biochemistry screening. For more information: 
Biochemistry (see page 46).

Mean Arterial Pressure: In this section, the results of the Mean Arterial Pressure examination can be 
entered. For more information: Mean arterial pressure (see page 49).

Risk calculation: The First Trimester Risk is calculated in this tab. Note that to be able to perform the 
calculation, a valid FMF licence is mandatory. For more information about how to obtain a licence please go 
to Options - FMF Risks (see page 190). For more information about the risk calculation itself, refer to Risk 
calculation (see page 50).

5.1.3.1 History
The History screen brings together in a single screen the adjustment factors needed for the calculation of MoMs 
and a priori risks.

Most items are marked in green, indicating that they are required for the risk assessments. See below for more 
detail on which History fields contribute to which risk.

The Birthweight calculator allows determining whether a previous pregnancy was affected by SGA.
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Tip: most questions have a yes / no answer. Simply press n or y to fill the field and move automatically to the next 
one.
 

By pressing the  button, you will be provided with additional information regarding the field in the context of 
the risk calculation.

Also, all data fields regarding parity must be filled in. This means that if there were no previous cases of delivery (ie. 
Spontaneous deliveries or Deliveries at or after 37 weeks), you must enter a zero in the data field.

Some fields are conditional - for example, PE in a previous pregnancy and Previous small baby only appear if the 
patient is multiparous. Which of these input fields are used for which biochemical MoMs and risks are listed in the 
respective chapters Biochemistry (see page 46) and Risk calculation - [IVD] (see page 50).  

If you entered a parity value greater than 0, the field Previous small baby will appear, along with the Birthweight 
calculator. Upon clicking on the Birthweight calculator button the following small dialogue appears:
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After entering the Gestational Age at delivery and the Birth weight, the dialogue will tell you whether the baby was 
SGA or not and allow you to apply the result ('yes' or 'no') to the "Previous small baby" field. If a detailed obstetrics 
history has already been entered, the previous pregnancies are scanned to find the smallest live-born baby, and the 
corresponding weight and gestation at delivery are automatically filled in.
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5.1.3.2 Ultrasound
After clicking on First trimester in the navigator, the first trimester Ultrasound screen is the second tab in the set. 
The results of the ultrasound examination are entered here.

By pressing the  button, you will be provided with additional information regarding the field, in the context of 
the risk calculation.

Note that for all new examinations, the History tab will by default be shown first, when the First Trimester is 
selected in the navigator. However, once data has been entered in the Ultrasound screen, this will become the new 
default tab when you click on First Trimester.

Also, be aware that all popup lists can be populated with additional entries of your choice (see Editing Popup 
Lists (see page 92)). For example, in Findings, you can select from the list provided or choose Change this list.
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For some fields where measurement values are entered (Fetal heart rate, CRL, NT, etc.), graphs can be viewed 
where the entered value is displayed over median and percentile curves. With the cursor in the measurement field 
of interest, pressing the shortcut key  F7 displays the graph in question. For all graphs corresponding to the current 
screen, press F8. Growth bars also appear for the following fields: Fetal heart rate, CRL, BPD, HC, AC, FL and Ductus 
Venosus PI. In the default setting, the growth bar shows the mean (centred) and plus/minus two standard 
deviations of the respective value distribution. The actual measurement value is shown as a red dot placed 
accordingly. In Options - Charts you can choose which graph you would like your values to be measured against 
and if you prefer to use the chart settings (normally 5th and 95th percentile) or the standard deviations for the 
growth bars (see Options - Charts (see page 183) for more information).

Graphs of crown-rump length (CRL), fetal heart rate (FHR) and nuchal translucency (NT) are automatically provided 
in the Ultrasound screen, where the entered values are displayed graphically:

The anatomy section (Skull/brain, Spine, etc.) contains helper lists of observations and common anomalies which 
can be seen at 11-14 weeks. You can edit the inserted text or simply type in your observations. Popup lists are used 
to comment on the placenta, cord and amniotic fluid. A comment field is provided for any other remarks.

In the case of multiple pregnancies, you should click on the tab New Fetus and a new tab Fetus 2 appears. The 
functionality is the same as in Early Pregnancy (see page 36).

If you prefer fetuses to be called Fetus A and Fetus B instead of Fetus 1 and Fetus 2, an astraia administrator can 
change this in Options - Patient data.
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5.1.3.3 Detailed anatomy
After clicking on First trimester in the Navigator, Detailed Anatomy is available as the third tab in the set. It can 
also be found as a section in the screen Biometry / Anatomy.

For each tab in Detailed anatomy, there is a choice of four checkboxes that can be selected depending on whether 
the development of the respective body part is normal, not seen, not visible or abnormal. If the normal checkbox 
is marked, the Abnormalities checkbox disappears and the program automatically jumps to the next tab. If the 
abnormalities checkbox is selected, however, a new section appears where the most common characteristics of 
that abnormality can be documented. The normal checkbox in turn disappears (as you can see in the example 
above).

Each tab name that appears in plain text indicates that no information has been entered (in the example above 
Urinary tract). The tabs in which the normal checkbox has been selected appear in bold green (in the example 
above: Head, Brain, Face, etc.). If abnormalities have been documented the respective tabs appear in bold red (in 
the example: GIT). If the entries 'not seen' or 'not visible' have been selected, the name simply turns bold (in the 
example: Thorax and Genitalia).
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5.1.3.4 Biochemistry
After clicking on the First trimester in the Navigator, Biochemistry is available as the fourth tab in the set. The first 
trimester biochemistry screen is part of the first trimester risk assessment and can be used in one of three ways:

the analyte values of free ß-hCG and PAPP-A  can be entered and the multiples of the median (MoMs) will 
automatically be calculated; this option is currently available for FMF-approved kits BRAHMS Kryptor, 
PerkinElmer DELFIA Xpress, Manual DELFIA, AutoDELFIA, Roche and Siemens ADVIA Centaur XP/XPT, 
CP, Atellica. The MoMs are only calculated if all fields with a green label are filled in and if sampling and 
testing have taken place within the corresponding time window. The GA (dated by the CRL) at the time of 
sampling must be in the range 8+0 to 14+1 weeks.
Note that while the concentration and MoM of AFP can both be recorded, this biochemical marker is 
not used in the risk calculation.
the analyte values of PlGF can be entered and the multiples of the median (MoMs) will automatically be 
calculated; this option is currently available for FMF-approved kits BRAHMS Kryptor, PerkinElmer 
DELFIA Xpress, AutoDELFIA and Roche. The MoMs are only calculated if all fields with a green label are 
filled in and if sampling and testing have taken place within the corresponding time window. The GA (dated 
by the CRL) at the time of sampling must be in the range 11+0 to 14+1 weeks.

the kit PerkinElmer DBS (Dried Blood Spots) allows for the calculation of MoMs for free ß-hCG and PAPP-A. 
The factors for the risk calculation for Trisomy 21 based on the DBS kit are derived from Krantz et al.: First 
trimester Down syndrome screening with dried blood spots using a dual analyte free beta hCG and PAPP-A 
immunofluorometric assay. Prenat Diagn 2011;31(9):869-874. Currently, no published data is available for 
the calculation of risks for Trisomy 13 or 18 with this kit. The factors for the risk calculation for Trisomy 13 
and 18 based on the DBS kit are derived from an internal paper written by Prof. Dave Wright and approved 
by Prof. David Krantz. DBS assays can be used between 11 and 14 weeks. Correction for repeat pregnancies 
(adjusting distribution for previous MoM values) is not done.

the MoMs can be typed in directly (if you do not use one of the FMF-approved biochemical assays, your 
laboratory must give you the MoM values and these can be entered directly into the program. The risk will be 
provided on the basis of these. However, the FMF cannot take responsibility for risks calculated using 
biochemical systems that have not been approved, and a comment will appear on the report to reflect this).

The date the sample was taken can be different from the date of the ultrasound examination.

The biochemical medians are adjusted for:

( a ) maternal weight,

( b ) racial origin (ethnicity),

( c ) chorionicity in case of twins,

( d ) smoking status, yes or no (if stopped or not known is chosen, the entries are treated as 'no' for the MoM 
calculation)

( e ) conception,

( f ) parity,

( g ) diabetes mellitus and treatment

( h ) PE in a previous pregnancy

For all biochemistry MoMs to be calculated, all listed parameters must be entered in the History (see page 40) tab. If 
one or more of these are missing, some or all MoMs will not be calculated.
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This is the first trimester biochemistry screen:

For each analyte, you can choose separately which analyser was used to measure the respective concentration. The 
corresponding MoM value will be calculated accordingly.

The green fields on this screen are the fields that are necessary for the MoM and first trimester risk (see page 50)
calculation.

Status bar message for missing factors/other reasons why the MoMs cannot be calculated: If e.g. factors are 
missing or an incompatible risk version is used, the MoM calculation cannot be performed and a message appears 
listing the reason on the status bar:

Biochemistry MoM Monitoring:

In the first trimester risk calculation, all values for biochemical markers are converted to MoMs (Multiples of 
Median). astraia uses only these normalized MoMs in the risk algorithm. The medians to calculate these MoMs are 
pre-implemented based on published studies or FMF recommendations, and depend, among other factors, on 
analyte and population. The FMF recommends adjusting the MoMs regularly to reflect the local population and 
correct for slight changes in the analyte. If the median of the calculated MoMs deviates too much from 1.0, this is a 
sign that the used MoMs do not sufficiently reflect the actual data anymore and should be adjusted.

On this screen, you will see buttons beside the MoM values. These buttons indicate the levels of MoMs in your 
database over the last year.

a grey button means that there is insufficient data to analyze the quality of your MoM calculation (for PlGF 
you need a minimum of 100 values, for free ß-hCG and PAPP-A 140 values)
a green button indicates that median MoMs are with 5% of the expected value (1.0) and that there are more 
than 300 values (PlGF)/more than 500 values (free ß-hCG and PAPP-A) available.
an orange button indicates that 

the median MoM is running 5-10% from the expected or
 there is insufficient data to justify a green flag (you would need a minimum of 300 values per year to 
show a green button for PlGF and 500 values for free ß-hCG and PAPP-A)

a red button indicates a median MoM > 10%
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Click on the buttons to see more information. If any indicators are orange or red you should use the MoM 
adjustment tool in First Trimester Audit (see page 224) to add a correction factor. When the MoMs are adjusted, the 
traffic will not turn green instantly. The deviation that the traffic lights indicate is calculated based on data from the 
last 12 months. Since the MoM adjustment only applies to values recorded after the adjustment, only future values 
will have the correction factor applied to them. This means that it can take a while for these values to change the 
deviation enough to turn the corresponding traffic light orange and then green.

Biochemistry medians

The biochemical medians are always based on the gestational age by CRL, even if another method of calculating the 
gestational age has been chosen. BRAHMS Kryptor, PerkinElmer Delfia Xpress, Manual Delfia and Autodelfia, 
PerkinElmer DBS, Roche and Siemens ADVIA Centaur XP/XPT, CP, Atellica allow risk calculation from 8+0 - 14+1 
pregnancy weeks. For PlGF from 11+0 to 14+1 weeks.

AFP: Note that the concentration and MoM of AFP can both be recorded (MoM is not calculated by astraia), but this 
biochemical marker is not used in the risk calculation.

Risks given by a laboratory

If your lab provides you directly with background and adjusted risk values instead of raw concentration or MoM 
values, you can enter these in the corresponding fields at the bottom of the screen. The risk values are then used by 
the risk algorithm as the biochemistry likelihood ratio for Trisomy 21.

Please note that the fields are only available when the MoM fields are empty.

Previous Normal Pregnancy:

MoM values from a previous normal pregnancy checkbox: numerical fields for free ß-hCG and PAPP-A 
MoMs appear. 

Apply button: a button will also appear if (and only if) previous values are found in the patient record and 
the previous pregnancy outcome was normal. The button assists the entry of these values, by filling the 
MoMs in automatically.

 
 
Previous biochemical values: In the event that a repeat first trimester scan is performed in the same pregnancy, 
any biochemistry values from the first examination can be copied into the current one. A button Previous values is 
displayed in Biochemistry only when this situation arises.
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Lab interfaces

If you have set up and are licensed for a lab interface such as BRAHMS Kryptor, Perkin-Elmer, Labka, SSI (for 
Denmark only) or a JDBC lab interface (see Options - Lab interface (see page 199)), you can use the buttons Lab 
request and Lab results in order to request and import lab results, respectively.
For each Lab interface, you will receive a separate specific manual in addition to the astraia manual.

5.1.3.5 Mean Arterial Pressure
After clicking on First trimester in the Navigator, Mean Arterial Pressure is available as the fifth tab in the set. The 
Mean Arterial Pressure screen is part of the first trimester risk assessment and necessary for calculating the risk of 
early PET and FGR.

The average of the four recordings is calculated and used to generate a multiple of the median (MoM). The MoM is 
used to estimate the patient-specific risk for pregnancy complications (early PET and FGR).
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5.1.3.6 Risk calculation - [IVD]

After clicking on First trimester in the Navigator, the Risk calculation screen is available as the last tab of the set 
(see screenshot below).
 
The First Trimester Risk calculation has been developed for the Fetal Medicine Foundation London (FMF).

Any questions about the algorithm itself should be posted directly to the FMF. Also, licenses to enable the risk 
calculator are distributed only by the FMF and not by astraia. For FMF contact details, refer to the end of this 
chapter or Options - FMF Risks (see page 190).

Background risks for Trisomy 21, Trisomy 18 and Trisomy 13 are calculated from all of the following:

date of birth of the patient or for ART pregnancies with either frozen eggs or a donor egg, the patient's age at 
the time of freezing or the donor's age at the time of egg collection

expected date of delivery using the date of ultrasound and gestational age (where the GA is calculated using 
CRL)

previous trisomies.

Gestational age is calculated from the largest fetal CRL value, in cases of multiple fetuses.

Note that to be able to perform the calculation, a valid FMF licence is mandatory. For more information 
about how to obtain a licence please go to Options -> FMF Risks.


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Risks for chromosomal anomalies (Trisomy 21, 18 and 13) calculated by ultrasound are only available if:

the patient's date of birth is entered,
the crown-rump length CRL (Robinson HP, Flemming JEE: British Journal of Obstetrics and Gynaecology; 
Sep 1975; Vol 82; pp 702-710) is between 45 and 84mm (if the fetal CRL is less than 45 or greater than 84, no 
risk is calculated except a blood sample was taken in an earlier examination at a gestational age between 
8-14 weeks and an HC is available in the current examination. GA is calculated using the HC formula 
"Altmann & Chitty formula, Loughna et al. Ultrasound 2009; 17: 161-167", this may differ from the GA 
displayed on the biochemistry screen and may still be in range (between 8-14 weeks), while the displayed GA 
by CRL is not),
an operator with a valid FMF Code for NT has carried out the examination (if the user permissions do not 
include NT, no risks are calculated),
the patient consent checkbox is ticked (if this option has been enabled, see Options - FMF Risks (see page 190)).
Stage 1: the nuchal translucency NT value is entered or calculated from NT above and below the cord. The 
NT risk is a combined risk and is calculated from CRL and NT.
Stage 2: marker risks are calculated from Ductus venosus Doppler (DV PI), Tricuspid Doppler (TR), Nasal 
bone (NB), using CRL, NT and the racial origin and using the current user permissions in the FMF license
Stage 3: Fetal heart rate risk for trisomy 13 is calculated.
Likelihood ratios are truncated, the limits depending on whether biochemistry or additional markers were 
used.
Major marker minimum risks for Trisomy 21, Trisomy 18 and Trisomy 13 are calculated. If any of these are 
greater than the currently calculated risk, they are used.
If monochorionic twins are being calculated, all risks for each fetus are averages of the two.
If term risks were requested (if this option has been enabled, see Options - FMF Risks (see page 190)), all risks 
are adjusted by term factors.

The biochemistry MoMs are used in the risk calculation if:

the patient's date of birth is entered,
the crown-rump length CRL is between 45 and 84mm (MoMs are calculated with gestational age at sample 
between 8+0 and 14+1 weeks),
an operator with a valid FMF Code has carried out the examination,
the number of fetuses is either one or two - if the number of fetuses exceeds two, no risk is calculated,
required factors for MoM calculation are entered (see Biochemistry (see page 46)).

For each analyte, either the value or the MoM can be entered. If the value is present, a MoM is calculated, provided 
all required factors are present and the analyzer is Kryptor, PerkinElmer Delfia XPress, PerkinElmer Manual Delfia, 
PerkinElmer Autodelfia, PerkinElmer DBS, Roche or Siemens ADVIA Centaur XP/XPT, CP, Atellica.

If only the MoM is entered, the risk is calculated and the entered factors are ignored.
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Risks for pregnancy complications:

Risks for preeclampsia (PE), fetal growth restriction (FGR) and spontaneous preterm delivery can be calculated from 
maternal history and pregnancy characteristics alone, but detection rates are improved by the use of markers.

Preeclampsia: required items for calculating the a priori risk are maternal age, weight, height and racial origin; 
parity, gestational age at delivery of last pregnancy (>= 24w), date of delivery of last pregnancy (>= 24w), previous 
history of PE, patient's mother's history of PE, method of conception, SLE, APS, chronic hypertension and diabetes 
mellitus. Adjustment markers are any combination of uterine artery PI, MAP, PAPP-A and PlGF.

Fetal growth restriction: required items for calculating the a priori risk are maternal age, weight, height and racial 
origin; parity, previous history of FGR, method of conception, smoking, SLE, APS, chronic hypertension and 
diabetes mellitus. Adjustment markers are any combination of uterine artery PI, MAP, PAPP-A and PlGF.

Preterm delivery: required items for calculating the a priori risk are maternal age, height and racial origin; method of 
conception, smoking and obstetric history. Only one marker is currently used to adjust the preterm delivery risk: 
cervical length. Without this marker, no preterm risk will be calculated.

Note: Also, all data fields regarding parity  must  be filled in. This means that if there were no previous cases of 
delivery (ie. Spontaneous deliveries or Deliveries at or after 37 weeks), you must enter a zero in the data field.

For all three pregnancy complications, if the a priori risk can be calculated it is then combined with marker MoMs. 
The risks provided are as follows:

risk of developing preeclampsia before 37 weeks
risk of developing fetal growth restriction before 37 weeks
risk of spontaneous preterm delivery before 34 weeks

Presentation

Risks are presented as 1 in x, with the meaning that for 1 case affected, x-1 are unaffected. The total 
number of cases is 1 + (x-1) = x so, in terms of likelihood ratio, this corresponds to 1 / x.  To give an 
example, a risk presented as 1 in 100 means 1 case is affected and 99 are not affected. This then 
corresponds, in terms of likelihood, to 1 / 100 = 1 %.



Risks are displayed within the range of 1 in 4 for the highest risk and <1 in 20000 (default value) for the 
lowest risk. The lowest risk displayed can be configured in Options - FMF Risks. The actual risk might be 
calculated as a higher or lower number and is stored in the database as such, but the values displayed will 
be truncated. The query section will show the exact calculated numbers for the risks.


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The risks are displayed as you can see in the screenshot above. Trisomy risks above their respective cutoff are 
displayed in bold.

It is possible:

to calculate risks for aneuploidies at term.
not to calculate the Trisomy 13 + 18 risks.
to calculate the Trisomy 13 + 18 risks but hide them in the printout.
to calculate risks for preeclampsia and fetal growth restriction but hide them in the printout.
to calculate the risk for preterm delivery but hide it in the printout.
to calculate the combined risk for Trisomy 13 + 18

All these settings can be found in Options - FMF Risks (see page 190). There you can also choose to enable patient-
specific risk calculation settings which allows you to override the global settings on a per-patient basis. This screen 
then looks as follows:
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Ticking or unticking the checkboxes specifies which risks shall be calculated for this patient in this examination 
when the "Calculate" button is pressed, overriding the global settings. Please note: you need to save the patient 
record before switching to another screen in order to save the patient-specific screening options for this 
examination. Otherwise, the patient-specific screening options selected for this examination will not be 
permanently saved, i.e. astraia will reset the checkboxes according to the global settings when coming back to this 
screen. In that case, the 'Calculate' button will be in red asking you to re-calculate the risk.

In examinations where the risks have been calculated with the patient-specific screening options enabled, the 
checked boxes will reflect the calculated risks. Please note: the calculated risks will not be reflected by the 
checkboxes in examinations where the risks have been calculated with the patient-specific screening options 
disabled. In that case, the checkboxes are all empty.

When a risk has been calculated with certain options, checking or unchecking a check box that will result in a risk 
change will lead astraia to indicate that risks must be recalculated. Please note: this again applies only to risks that 
have already been calculated with the patient-specific screening options enabled. Old risks can also be recalculated 
with different patient-specific screening options, but astraia will not ask for recalculation.

For further explanation please refer to Options - FMF Risks (see page 190).

Operation

In order to display the risks, press the Calculate button. The risks are presented as Background risk (for the 
Trisomies) and Adjusted risk per Condition. The text beneath the risks provides information about the actual data 
that was used to calculate the adjusted risk.

If you change any examination data after having calculated the risks please return to the risk calculation 
screen and press Re-calculate in order to adjust the risk to the new data. If you try to exit the program or 
print a report without re-calculating the risks, a warning message will appear.



The calculate button will stay greyed out if you open an old examination where the risks have been 
already calculated with an older risk version than the current one. The software recognises this and will 
not re-calculate the risks with the new algorithm. The risks will remain. The reason for this behaviour is to 
ensure that you can always see the risks as they were given to the patient in the original examination with 
the original settings at that time. Furthermore, it is important for data security to avoid misleading 
changes in the database and to ensure correct handling of old data in your statistics and first trimester 
audit.


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In addition, the first trimester background and adjusted risks of trisomy 21 are presented graphically:

In this graph, the background risk of trisomy 21 pregnancies is represented by the green curve as a function of 
maternal age. A red vector is used to represent the change made by the adjustment factors to the background risk. 
The background risk is represented by the red dot whilst the adjustment risk is the endpoint of the arrow. A change 
in risk can be expressed as follows: an X-year-old woman has an adjusted risk that corresponds to the background 
risk of a Y-year-old woman (where the vector intersects the curve).

For the example given above, the background risk is given for a Maternal age of 27 and the adjustment risk is that of 
a Maternal age lower than 15. When the adjusted risk (ultrasound and/or biochemistry) is lower than the 
background risk, the vector continues to the left until it intersects with the curve and points to the appropriate risk. 
In this particular case, the adjusted risk is lower than the background risk for the minimum age for which this 
calculation is done, so there is no intersection with the graph of background risks. In that case, the vector continues 
to the left until it reaches the limit.

For cases where the adjusted risk is higher than the current background risk, the vector continues to the right side, 
moving up the curve, until it reaches the intersection with the background risk curve. In the example below, the 
adjusted risk (ultrasound and/or biochemistry) of this 27-year old woman corresponds with the background risk of 
a 41-year old woman:
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If a case of trisomy 21 is known from a previous pregnancy, the whole background risk curve shifts to higher values 
(see green line in the graph below). The adjusted risk is then plotted on the curve of increased background risks. 
This is illustrated in the example below: the adjusted risk (ultrasound and/or biochemistry) of this 27-year old 
woman with a known previous trisomy 21 pregnancy now corresponds to the background risk of a 47-year old 
woman with a known previous trisomy 21 pregnancy.
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For any further questions regarding the risk calculation please contact:

The FETAL MEDICINE FOUNDATION (Registered Charity No. 1037116)
First Trimester Screening Program
137 Harley Street, London WIG 6BG, UK
Tel: +44 (0)20 7034 3070
Fax: +44 (0)20 7034 3071

e-mail: FMFCertification@fetalmedicine.com

www.fetalmedicine.org

A full list of references can be found in the Help pages in astraia under the relevant chapters of FMF - First Trimester 
Risk Calculation Module - IVD.
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5.1.4 PE Screening
For the calculation of preeclampsia (PE) risks in the second and third trimester, the dedicated screen PE Screening
is available. It is divided into five sections for entering general information on the screening, maternal 
characteristics and history, biochemical markers, biophysical markers and the actual risk calculation. As for the first 
trimester risk calculation, a license from the Fetal Medicine Foundation (FMF) is needed to perform the calculations 
on this screen. This license needs to include permission to calculate preeclampsia risks. For more information, 
please see Options - FMF Risks (see page 190).

General screening information

The calculation factors and some of the input parameters depend on the gestational age (GA) at which the 
screening takes place. There are three gestational age ranges within which MoMs and the PE risks can be calculated:

Second trimester: 19+0 to 24+6 weeks
Third trimester: 30+0 to 34+6 weeks
Third trimester: 35+0 to 37+6 weeks

Outside these ranges no MoM or PE risk calculation is possible.

Please note: The risk of preeclampsia in the first trimester can be calculated on the First trimester screen only. If 
the current gestational age corresponds to the first trimester, a message on the screen will inform you accordingly. 
This screen and the First trimester screen are mutually exclusive, meaning that if the current examination is a First 
trimester examination, the screen PE Screening will be disabled in the Navigator.

At the top of the screen, there are mandatory input fields for gestational age and operator information. The GA can 
be calculated based on measurements that were entered on the Biometry/Anatomy screen, or it can be entered 
manually.

Based on the gestational age entered here, the label above it will indicate which of the screening ranges the 
gestational age corresponds to. A blue information label will inform you if the current gestational age is out of 
range. 



astraia user manual - 29.x

Published on: 15-Jan-2024
NEXUS / ASTRAIA GmbH

Selecting a Case- Page 59 of 263

Maternal characteristics and history

All input fields listed in this section are required for the calculation of the a priori risk for developing preeclampsia.

This a priori risk can be refined using adjustment markers which are any combination of Uterine artery PI, MAP, PlGF 
and sFLT-1. Their multiples of the median (MoM) are calculated based on the respective direct input field, e.g. the 
concentration value in the case of biochemistry analytes, and the respective mandatory history fields. These 
depend on the type of marker and the gestational age at which the MoM is calculated. The selected values may 
make other input fields mandatory. For example, selecting diabetes mellitus type 2 makes diabetes treatment a 
mandatory factor for some markers. Similarly, a parity of 1 or higher will require you to enter the dependent history 
fields before MoM values that need this information can be calculated.

When changing values on the screen, the application will attempt to calculate all available MoM values. If this is not 
possible due to missing input factors, a message at the bottom of the screen will inform you which factors are 
missing.
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Biochemical markers

As on the First trimester screen, you can choose for each analyte separately which analyser its concentration was 
measured with. The corresponding MoM value will be calculated accordingly.

It is possible to transfer biochemical markers to this screen, via lab request and lab result buttons, depending on 
the type and license of lab interface used.

Biophysical markers

The software will calculate the uterine artery PI mean and combined MAP fields based on the respective input 
fields, but the values can also be entered directly.

Please note: At 35+0 weeks and above the UtPI MoM will be calculated but it will not be used for risk calculation.

Risk calculation

In order to calculate the preeclampsia risk, please click on the button Calculate at the bottom of the screen. If 
mandatory factors are missing, a message box will inform you. The factors that were used in the risk calculation are 
listed in the methodology text below the risk result.
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In the three gestational age ranges, the following risks for developing preeclampsia are calculated:

Gestational age range Risk of preeclampsia before

Second trimester: 19+0 to 24+6 weeks 32 weeks
36 weeks

Third trimester: 30+0 to 34+6 weeks 36 weeks

Third trimester: 35+0 to 37+6 weeks 41+3 weeks

Printing

For printing these results, a dedicated report called Preeclampsia Screening is available in the printout selection 
dialogue File -> Print.

A full list of references can be found in the Help pages in astraia under the relevant chapters of  FMF - First Trimester 
Risk Calculation Module - IVD - Screening for preeclampsia.
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5.1.5 Fetal Neurosonography
The Fetal Neurosonography Module is a licensed module. It consists of two screens, morphology and biometry, and 
is integrated into the Obstetrics module.

5.1.5.1 Fetal Neurosonography
The first screen, Fetal Neurosonography on the navigator, covers general neurosonography findings concerning the 
fetal brain's structure and malformations.
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5.1.5.2 Cephalic Biometry
The second screen, Cephalic Biometry (a subset of Fetal Neurosonography on the navigator) documents cephalic 
biometry measurements. It includes several growth charts as well as a number of integrated information buttons 
with sample ultrasound images with example measurements. The screen can also be configured to document 3-D 
cerebellar measurements (Edit - Configuration - Pregnancy - go to Fetal Neurosonography - Cephalic Biometry).

5.1.6 Delivery
The module Delivery is a licensed module. It consists of the screens, Delivery, Check-in and Postpartum / Discharge, 
and is integrated into the Obstetrics module.
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Delivery

The module Delivery contains tabs for information on Labour induction, Rupture of membranes, Labour, Delivery, 
Caesarean, Placenta delivery, Perineum, Medication and Complications.
In this section, interfaces to the modules Nexus CTG, Nexus Partogram and Nexus Ward View can be activated.

CTG: The astraia delivery module offers seamless integration with the Nexus WHC CTG software. This software will 
give the opportunity to users to follow the CTG of a single patient as well as offering a general view of all CTGs 
running in the ward.

Partogram: As well as for CTG, the astraia delivery module is integrated with the Nexus WHC Partogram. From there 
the user will be able to enter various delivery data on a "standard" graphical partogram. The user will also be able 
to register data for dilatation or descent up to very detailed medications given during all delivery process.

Ward View: The last module from Nexus WHC to be integrated with the astraia delivery module is the Ward View, 
which should be considered as an electronic equivalent to the whiteboard usually used in the Delivery Ward. From 
here, any user can have a general overview of the current ward activity.

Check-in

Document various check-ins, like surveys done, labour progress, fetus or mother well-being and new risk factors, 
during the delivery.

Postpartum / Discharge

Record information on the postpartum phase and discharge.

5.2 Gynaecology
The case gynaecology covers the following areas:

Patient details (see page 91) Shows personal information about the patient and her partner.

History The branch history informs about the gynaecological history.

Obstetric History Gravida, Para and a detailed record screen for the obstetric history.

Medication List of medication and radiation exposure.

Family History Detailed family history with pedigree.
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Examination

Indication Shows the indication of the examination.

Clinical Examination Describes the results of the clinical examination.

Ultrasound You can choose from Early pregnancy, Uterus, Right ovary, Left 
ovary, Free fluid, Pelvic assessment, Adnexal masses, Follicle 
Tracking, HyCoSy, Kidneys / Bladder and Ultrasound summary.

Counselling This screen allows documenting the indication and details of a 
counselling session. 

Procedures Available are Cervical smear, Infection screen, IUCD insertion, 
Endometrial biopsy, Implant, Cyst aspiration and ERCP.

Investigations requested You can choose between different investigations from haematology, 
biochemistry, endocrinology, early pregnancy, immunology and 
standard profile.

Laparoscopy A detailed record screen for laparoscopic findings.

Laparotomy Here you can enter the results of a laparotomy.

Hysteroscopy This record screen shows the hysteroscopic results.

Investigation Results Investigation results from haematology, biochemistry, 
endocrinology, early pregnancy, immunology and standard profile 
are shown.

Conclusions Conclusions offer a lookup table for diagnosis and procedure codes. 
Furthermore, you can add individually configured text elements for 
standardized letters (see The Reporter (see page 102)) or memos or 
enter a free text.

Letters Within this submenu standardized letter components can be 
created, structured hierarchically and utilized in printouts.

Accounts Accounts for examinations and procedures.
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Outcome Here you can specify the clinical results of an operation made and 
the progress.

For multiple screens in the case gynaecology, there are alternative screens that can be selected (see Screen 
Configuration (see page 213)). In this list the preset screens are printed in blue, the screens for which you can change 
the configuration are printed in bold:

Patient details:

Screen selection - Patient name:

Patient name
Patient name (Netherlands)
Patient name (Swiss)
Patient name (Portugal)
Patient name (Greek)
Patient name (Canadian)
Patient name (China)
Patient name (neonatal)
Patient name (SGH)
Patient name (Russian)
Patient name (Hungarian)
Patient name (Albanian)

Screen selection - Patient demographics:

Patient demographics (default)
Patient demographics (Canadian)
Patient demographics (Netherlands)
Patient demographics (UK/NHS)
Patient demographics (Denmark)
Patient demographics (Austria)
Patient demographics (Mamma)
Patient demographics (Russian)
Patient demographics (Hungarian)
Patient demographics (Albanian)

Screen selection - Partner:

Partner
Partner (Canadian)
Partner (Albanian)

History - Maternal Medication:

Screen selection - Maternal Medication:

Maternal Medication
Maternal Medication - record

Examination:

Screen selection - Examination header:

Examination header
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Examination header (Portugal)
Examination header with order button
Examination header (Gynae referral)
Examination header (SGH)
Examination header (Albanian)

Accounts:

Screen selection - Accounts:

Accounts
Accounts detailed

5.2.1 Risk of malignancy for adnexal masses
Various prediction models have been developed to estimate the risk of malignancy of adnexal masses, with the aim 
of matching the performance of subjective interpretations of ultrasound findings by experienced ultrasound 
examiners.

Three risks are made available to the user in astraia: Simple rules, IOTA LR2 and RMI.

In the adnexal mass screen, the user can press the Calculate button to activate the calculation window. Three tabs 
enable the user to move from one risk calculation to another. The user can also choose whether to include the 
risk(s) into the report (see checkbox at the bottom of each window). All entries used in the calculations are taken 
from the adnexal masses screen with the exception of the patient's age and menopausal status, which are 
automatically imported from Patient details and Gynaecological History. The field serum CA 125 is the same entry 
as can be found in Investigation results (Standard Profiles/Tumour Markers/ Result), added here, so the user does 
not have to navigate out of the screen to access the field. Furthermore, if a user modifies an entry of a field in the 
adnexal mass screen that changes the outcome of any one of the risk calculations, the Calculate button changes 
status to Re-calculate to encourage the user to revisit the calculation window.

Certain fields on this screen appear in green. These are the criteria and measurements that are most relevant to 
calculate the risk of malignancy, making it easier for the doctor to examine the patient as efficiently as possible.
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5.2.1.1 Simple Rules
Simple ultrasound rules can be used to classify adnexal masses as benign or malignant. When conclusive, they 
perform as well as a subjective assessment conducted by an experienced ultrasound examiner (Timmerman et al.
2010). The rules comprise of five ultrasonic features based on shape, size, solidity and results of a colour Doppler 
examination:

The calculation window in astraia lists the five features under B-rules (benign features) and M-rules (malignant 
features). A blue tick appears next to a feature when the corresponding entry in the main astraia Adnexal Mass 
window has been marked as present. The result of the classification is given as malignant, benign or unclassified.
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Reference: Timmerman et al. Simple ultrasound rules to distinguish between benign and malignant adnexal masses 
before surgery: prospective validation by IOTA group. BMJ 2010 Dec 14; 341.

5.2.1.2 IOTA LR2
The IOTA LR2 uses information from 6 variables: (1) age of the patient (years), (2) presence of ascites (yes/no), (3) 
presence of blood flow within a papillary projection (yes/no), (4) largest diameter of the solid component (mm), (5) 
irregular internal cysts walls (yes/no) and (6) the presence of acoustic shadows (yes/no). Variables with a yes/no 
result are assigned to 1 for yes and 0 for no. The largest measurement allowed for (4) is 50 mm.

Reference: Timmerman et al. Ovarian cancer prediction in adnexal masses using ultrasound-based logistic 
regression models: a temporal and external validation study by the IOTA group. Ultrasound Obstet Gynecol 2010; 36: 
226-234.

5.2.1.3 RMI
The Risk of Malignancy Index (RMI) was the first model to combine clinical, ultrasound, and tumour marker 
information to predict the likelihood of malignancy of an ovarian mass. The Index is based on the following 
features:

age (pre or post menopausal), multilocular cyst, evidence of ascites, evidence of solid areas, evidence of 
metastases, bilateral lesions, serum CA125.

If RMI < 100 the classification is set to benign. If RMI > 100 the classification is set to malignant.

Reference: Jacobs I, Oram D, Fairbanks J, Turner J, Frost C, Grudzinskas JG: A risk of malignancy index 
incorporating CA 125 ultrasound and menopausal status for the accurate preoperative diagnosis of ovarian cancer. Br 
J Obstet Gynecol 1990; 97: 922-929.

5.3 Colposcopy
The case colposcopy covers the following areas:

Patient Details (see page 91) Shows personal information about the patient and her partner.

History The branch history informs about the gynaecological history.

Referral Referral details with indication and present symptoms.

Examination
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Findings Colposcopic findings are presented.

Treatment Loop excision of the transformation zone (LLETZ) and other treatments.

Results This area shows the results of the colposcopic examination. 
Furthermore, you can add individually configured text elements for 
standardized letters (see The Reporter (see page 102)) or memos or enter a 
free text.

Letters Within this submenu, standardized letter components can be created, 
structured hierarchically and utilized in printouts.

Outcome Describes further management of the case.

For multiple screens in the case colposcopy, there are alternative screens that can be selected (see Screen 
Configuration (see page 213)). In this list the preset screens are printed in blue, the screens for which you can change 
the configuration are printed in bold:

Patient details:

Screen selection - Patient name:

Patient name
Patient name (Netherlands)
Patient name (Swiss)
Patient name (Portugal)
Patient name (Greek)
Patient name (Canadian)
Patient name (China)
Patient name (neonatal)
Patient name (SGH)
Patient name (Russian)
Patient name (Hungarian)
Patient name (Albanian)

Screen selection - Patient demographics:

Patient demographics (default)
Patient demographics (Canadian)
Patient demographics (Netherlands)
Patient demographics (UK/NHS)
Patient demographics (Denmark)
Patient demographics (Austria)
Patient demographics (Mamma)
Patient demographics (Russian)
Patient demographics (Hungarian)
Patient demographics (Albanian)

Screen selection - Partner:

Partner
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Partner (Canadian)
Partner (Albanian)

Examination:

Screen selection - Examination header:

Examination header
Examination header (Portugal)
Examination header with order button
Examination header (Gynae referral)
Examination header (SGH)
Examination header (Albanian)
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5.4 Fetal Echocardiography
The Fetal Echocardiography module can either be used as part of the pregnancy case (see Pregnancy (see page 28)) or 
as a separate case.
The case fetal echocardiography covers the following areas:

Patient Details (see page 91) Shows personal information about the patient and her partner.

History In this branch, you can enter data about the present pregnancy and 
the mother's pre-pregnancy condition.

Obstetric History Gravida, Para and a detailed record screen for the obstetric history.

Chronic Disease Selection of common chronic diseases.

Family History Detailed family history with pedigree.

Maternal Medication List of medication and radiation exposure.

Examination The examination includes the indication, suspected diagnosis and a 
detailed fetal echocardiography assessment.

Cardiac Biometry You can enter the important biometry data of the fetal heart. For 
some measurements, measurement guidelines and ultrasound 
images are displayed.

Doppler An extensive input option for all the important vessels and valves 
near the heart.

Letters Within this submenu, standardized letter components can be 
created, structured hierarchically and utilized in printouts.

Outcome
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The screens of this module offer a special feature that assists the user in their workflow: Depending on the 
suspected a-priori diagnosis that is selected on the main Fetal Echocardiography screen, certain fields on this 
screen and its sub-screens will turn green. These are the criteria and measurements that are most relevant to this 
particular suspected diagnosis, making it easier for the doctor to examine the patient as efficiently as possible.

For multiple screens in the case pregnancy, there are alternative screens that can be selected (see Screen 
Configuration (see page 213)). In this list the preset screens are printed in blue, the screens for which you can change 
the configuration are printed in bold:

Patient details:

Screen selection - Patient name:

Patient name
Patient name (Netherlands)
Patient name (Swiss)
Patient name (Portugal)
Patient name (Greek)
Patient name (Canadian)
Patient name (China)
Patient name (neonatal)
Patient name (SGH)
Patient name (Russian)
Patient name (Hungarian)
Patient name (Albanian)

Screen selection - Patient demographics:

Patient demographics (default)
Patient demographics (Canadian)
Patient demographics (Netherlands)
Patient demographics (UK/NHS)
Patient demographics (Denmark)
Patient demographics (Austria)
Patient demographics (Mamma)
Patient demographics (Russian)
Patient demographics (Hungarian)
Patient demographics (Albanian)

Screen selection - Partner:

Partner
Partner (Canadian)
Partner (Albanian)

History - Maternal Medication:

Screen selection - Maternal Medication:

Maternal Medication
Maternal Medication - record

Examination:

Screen selection - Examination header:
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Examination header
Examination header (Portugal)
Examination header with order button
Examination header (Gynae referral)
Examination header (SGH)
Examination header (Albanian)
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6 Navigation and Summary
On the left of a patient record, you can see the Navigator (of an obstetric case in the screenshot below). It is 
designed to help you jump quickly to any area of the report. The Navigator represents a tree structure. The highest 
level is similar for most modules (Patient details, History, Examination, Outcome):

The Navigator and the Summary will be explained in their own sections below.

The content of the window title bar can be modified to e.g. display the hospital number instead of the astraia 
patient ID. To configure this please contact the astraia support team.



astraia user manual - 29.x

Published on: 15-Jan-2024
NEXUS / ASTRAIA GmbH

Navigation and Summary- Page 76 of 263

•
•

•

•

•

Below the Navigator, you can find icons for Reminders, Documents (only if external documents are 
available), Quick Print, Quick Print Preview and Save and close the patient.

The Reminders icon is used to view this patient's reminders and add new ones.

The Documents icon will only appear if external documents have been saved with this patient (via Data - External 
documents - Import a document).

The Quick Print will automatically print the preselected report template to the default printer.

The Quick Print Preview will automatically open the print preview of the preselected report template.

Save and close the patient will directly save the record and close it without showing a confirmation window.

6.1 The Navigator
The arrow symbols in the navigator indicate the presence of one or more branches. In the example shown, the 
History branch is closed (arrow pointing to the right), whereas the Examination branch is open (arrow pointing 
down), as is the Ultrasound sub-branch. By clicking on an arrow in the navigator you can open and close these 
branches. By clicking on a tab in the navigator you can open the corresponding area of the report. The 
administrator can adjust the content of each screen (see Screen Configuration (see page 213)).

The administrator can also reduce the navigator and thereby limit the number of possible inputs by hiding unused 
screens (see Screen Configuration (see page 213)).

The colours used indicate the active examination:

a white branch shows the currently selected screen (in this example the Summary)
the normal text shows that the corresponding screen is empty (for example Indication, Maternal structures 
or Doppler)
bold text indicates that the screen contains some entered data (for example Patient details, History, 
Examination, Ultrasound and First Trimester)
in a single pregnancy examination, you can only navigate to one of the four following examinations using the 
navigator: Early pregnancy, First trimester, Biometry / Anatomy or Growth scan. This depends upon which of 
the four examinations has been filled out (printed in black). If you have not entered any examination data 
yet, this restriction does not apply
if you move the mouse over the navigator fields the position of the mouse is shown with a darker colour

The navigator allows you to move between different screens in the same examination.

6.2 The Overview
The Overview provides a condensed summary of the current case by displaying a list of problems and noteworthy 
values of the patient's history and the examinations. astraia comes with a pre-defined selection of fields and values 
that are included in the Overview (called "flagged" fields and values), but this selection can be changed by the user 
(see chapter Screen configuration (see page 213)).
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The sections displayed here depend on the current case's data. To keep the Overview condensed and short, a 
section (History or an examination) will only be displayed if it contains at least one unique flagged field or value. 
This means that out of two subsequent examinations where the nasal bone is missing, only the first one will be 
included in the Overview (unless the second examination contains other unique flagged fields or values).

At the top left the gestational age at the time the Overview is opened can be seen, including the parameter its 
calculation is based on.

The Overview functionality is accessible

via the function key F5  
via the menu Data -> Overview
via the button Show Overview on the Summary screen.

If you need a printout of the Overview, click on the printer symbol. After that, you can choose between a preview or 
a direct printout.
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By default the below set will be added to the overview window when entered:

Screen Fields

History Maternal blood group rhesus (if Rhesus is negative), Alcohol (if yes), 
Cigarettes (if yes or stopped), Diabetes Mellitus, Chronic Hypertension, 
Nephropathy, Respiratory disease, Gastro-intestinal disease, Cardiac 
disease, Coagulation disease, Endocrinological disease, Liver disease, 
Epilepsy, Autoimmune disease, Thrombophilia, Thyroid disease, Mental 
disorder, Infection, other maternal diseases, Gravida, Parity, Previous 
caesarean is yes, Patient wants to know fetal sex is no, Chronic disease, 
other, Uterine anomalies, Previous cervical surgery, UTI / Polynephritis, 
History of domestic violence, History of drug abuse, Allergies

Examination data Chorionicity, Free ß-hCG MoM, Uterine artery Notch, Cord, abnormal Fetal 
heart activity, Presentation, Pregnancy site (if outside the intrauterine 
cavity or pregnancy of unknown location PUL), abnormal Amniotic fluid, 
abnormal placenta, Ectopic location, abnormal Nasal bone, abnormal 
Tricuspid Doppler

Detailed anatomy - Abdominal Wall Gastroschisis, Exomphalos, Body stalk anomaly, Bladder extrophy, 
Cloacal extrophy, other abdominal wall anomalies

Detailed anatomy - Brain Microcephaly, Macrocephaly, Anencephaly, Agenesis of the corpus 
callosum, Teardrop sign, Encephalocele, Exencephaly, 
Holoprosencephaly, Iniencephaly, Dilated Cisterna Magna, Small Cisterna 
Magna, Blake pouch cyst, Vermian hypoplasia, Vermian agenesis, 
Rhombencephalosynapsis, Cerebellar hypoplasia, Cerebellum banana, 
Cerebellar damage, Posterior Fossa cysts, Porencephaly, 
Hydranencephaly, Schizencephaly, Hemimegalencephaly, 
Ventriculomegaly, Calcification, Cysts, Tumour, Aneurysm of the vein of 
Galen, other brain anomalies

Detailed anatomy - Face Cleft, Ears abnormal, Eyes abnormal, Flat face, Macroglossia, 
Micrognathia, Nose abnormal, Facial tumour, Face other abnormalities

Detailed anatomy - Genitalia Findings (if ambiguous genitalia), Hydrocoele, Hypospadia

Detailed anatomy - GIT Ascites, Abdominal cysts, Double bubble, Hyperechogenic bowel, Liver 
nodule, Small bowel obstruction, Large bowel obstruction, Situs inversus, 
Stomach not visible, Stomach collapsed, Stomach dilated, 
Hepatomegaly, Splenomegaly, Absent gall bladder, Duplex gall bladder, 
other GIT anomalies
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Screen Fields

Detailed anatomy - Head  Acrania, Brachycephaly, Craniosynostosis, Dolichocephaly, Prominent 
occiput, Cloverleaf shape, Lemon sign, Strawberry sign, other head 
anomalies

Detailed anatomy - Heart Dilation, Dysrhythmia, Ebstein's Anomaly, Fallot's Tetralogy, Pericardial 
effusions,  Atrium-ventricular septal defect, Ventricular septum defect,  
Uni-ventricular heart, Uni-atricular, Acardia, Aortic coarctation, 
Transposition of the great arteries,  Hypoplastic left heart syndrome, 
Hypoplastic right heart syndrome, Aberrant right subclavian artery, 
Mediastinal shift, other heart anomalies

Detailed anatomy - Urinary tract Ureters (if dilated), Bladder (if dilated, thick-walled, septum or 
Ureterocele), Hydronephrosis,  Multicystic kidneys, Polycystic kidneys, 
Renal agenesis, Pelvic kidney, Horseshoe kidney, Duplex kidney, Renal 
dysplasia, Tumour, other urinary tract anomalies

Detailed anatomy - Extremities Hand absent, Adactyly, Arachnodactyly, Brachydactyly, Hand Cleft, 
Clinodactyly, Oligodactyly, Overlap, Polydactyly, Syndactyly, Hands other 
abnormalities, Foot absent, Adactyly, Brachydactyly, Foot Cleft, 
Clinodactyly, Oligodactyly, Foot overlap, Polydactyly, Rocker bottom, 
Sandal Gap, Foot other abnormalities, Humerus absent, Humerus bowed, 
Humerus fractured, Humerus short, Humerus other abnormalities, Femur 
absent, Femur bowed, Femur fractured, Femur short, Femur other 
abnormalities, Fibula absent, Fibula bowed, Fibula fractured, Fibula 
short, Fibula other abnormalities, Elbow abducted, Elbow adducted, 
Elbow fixed extended, Elbow fixed flexed, Knee abducted, Knee adducted, 
Knee fixed extended, Knee fixed flexed, Radius absent, Radius bowed, 
Radius fractured, Radius short, Radius other abnormalities, Tibia absent, 
Tibia bowed, Tibia fractured, Tibia short, Tibia other abnormalities, Ulna 
absent, Ulna bowed, Ulna fractured, Ulna short, Ulna other abnormalities, 
Wrist abducted, Wrist adducted, Wrist fixed extended, Wrist fixed flexed

Detailed anatomy - Neck/Skin Nuchal oedema, Cystic hygromas, Generalised oedema, Neck/skin 
tumour

Detailed anatomy - Spine Spina bifida, Hemivertebra, Kyphosis, Sacral agenesis, Sacrococcygeal 
Teratoma, Sirenomelia, Scoliosis, Cerebellum absent, Cerebellum 
banana, Lemon shaped head, other spine anomalies
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Screen Fields

Detailed anatomy - Thorax

Bronchogenic cysts, Cystic-adenomatoid malformation, Congenital 
diaphragmatic hernia, Pleural effusions, Sequestration, Pulmonary 
hypoplasia, Laryngeal atresia, Chest wall: short, barrel-shaped, long, 
narrow, narrow, pear-shaped, rib fractures, Mediastinal shift (if yes), other 
thorax anomalies
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6.3 The Summary
The Summary screen has an important role for two reasons:

It allows you to create new examinations and switch from one examination to another
It gives you a short summary of all examinations of the current case allowing you to get a quick overview of 
the relevant patient data

In order to create a new examination, click on the button New examination at the bottom or press the  Ins  key on 
the keyboard.

To change from the current examination to another one, click on the respective examination column.

When you go to the Summary, the Navigator is automatically arranged so that each screen visible in the Navigator 
corresponds to a line in the summary.

The screens of the patient report that already contain data are marked with a tick or a text entry in the Summary. In 
our example, in the active examination of the 5th of October 2016, on the History screen, the entry for EDD (8th of 
April 2017) is shown. The row for the Ultrasound screen displays the gestational age (13+4) and the operator. For 
the First Trimester, the measurements for the CRL (75mm) and NT (1.5mm) are displayed.

When you hover your mouse cursor over one of these rows, a tooltip will appear. It displays the data of the 
respective row in a structured format where each entry has its own row. This is especially useful in more advanced 
and detailed examinations as shown in the following screenshot, where the displayed data may not fit into the 
column's space. If you place your mouse cursor on the tooltip, it will not disappear until the mouse cursor is moved 
away again.

If the option Validation for examinations (see Options - Administrator (see page 167)) is selected, the physician in 
charge can validate each examination in the Summary If the field is inactive (grey), the current user does not have 
permission to validate reports (see Options - Users (see page 177) and Options - Groups (see page 179)).

The currently active examination is highlighted in white, the other examinations have a grey background.
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If the worklist has been licensed and set up correctly, the button Worklist appears in the Summary. By clicking on 
it, you can transfer patient data to an ultrasound machine's worklist (see Options - Imaging / Worklist (see page 
194) and Options - Workstation (see page 211)).

If you want to navigate through the program with the use of the keyboard only, you can quickly change to the 
Summary by using the F2 key. You can change from any data screen to the Navigator with the F3 key. If the focus is 
on the Navigator, the background colour of the Navigator will change to white. You can move up and down the 
Navigator fields with the up and down arrow keys. To open and close sub-screens use the right and left arrow 
keys. To change from the Navigator to the currently selected data screen press Enter . It is also possible to hide the 
Navigator using the F4 key. This will give the rest of the screen more space. In order to make the navigator re-
appear, press the F4 key again.

Summary configuration

There is a set of values that are displayed in the Summary by default, but it is possible to change these values and 
their appearance or even add new values. For example, you might want to add the patient's title to the summary 
line corresponding to Patient details or remove the department's name. This is explained in Screen 
Configuration (see page 213).
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6.4 The Validation Process
The validation process can be used in order to enable e.g. supervising doctors to take a second look at an 
examination and then to give their OK on the results.

In order to use the validation properly, you will first need to activate the validation in Options - Administrator (see 
page 167). There you can also set reminders, e.g. on exiting a patient or on exiting the program. Furthermore, you will 
need users who are assigned to groups (see Options - Users (see page 177) and Options - Groups (see page 179)) with 
permission to ' validate exams '.

If the validation has been enabled, an examination can be in three different states:

unvalidated
validated
modified (validated and afterwards modified)

a fourth pseudo-state, 'Validation not required' will be also discussed later in this document.

An exam is considered to be validated only when it is in the state of 'Validated'. 'Modified' indicates that it once was 
validated, but has been modified since. Because it has been modified, it can not be considered currently valid and 
known to be correct until it is again re-validated.

Validation states

In this diagram, the different possible states of validation are displayed graphically:
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Fine control of validation enablement

If exams should only be considered for validation if they were created after a particular date, then this condition can 
be configured in the astraia 'administration' options.

Examinations not meeting the configured condition are considered to be in the state of 'Validation not required'. 
Otherwise, they take on one of the other 3 states as mentioned above. This new functionality (fine control of 
validation enablement) allows us to introduce the 4th state simply via a configuration that specifies a condition that 
each examination must meet to be considered for either 3 original states. If the condition is not met, the exam is 
said to be in the 4th state; that of 'Validation Not Required'. This state can be seen in the summary screen if 
examinations in that particular episode do not meet the configured condition. See the following screenshot:

To validate an examination:

In order to validate an examination, any user can go to the summary and then click on the field Not validated.

 If the user has validation permissions, he can select Validate by "current user name" and validate the 
examination by pressing OK.
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If the user has no validation permissions, he can select the option Validate by authorized user. The astraia login 
screen will appear and a user with validation permission needs to enter his password - this is also the user who will 
have validated the exam. This user will not actually log in, he will only validate the exam.

If an examination has successfully been validated, the field in the summary will change to Validated by "user who 
has done the validation".

To undo a validation:

If the same user wants to undo one of his validations, he can simply go to the summary, click on the field Validated 
by "user who has done the validation" and then remove the tick from the checkbox Validate by "current user 
name". If the user is not the same one, the procedure is the same, but after having removed the tick, the astraia 
login screen will open and the user who has done the original validation will need to enter his password.

To validate a modified examination:

If any user modifies an examination, which has been validated before, the state of the exam changes from validated 
to modified. In order to re-validate the exam, go to the summary and then click on the field Validated by "user who 
has done the validation", Modified by* "current user name"*.

The next step is the same as in the validation, depending on if the current user has validation permissions. If an 
exam has been modified, the option Diff is available, by pressing it you can view the changes that have been made:

Both examinations are displayed, the old one on the left, the new one on the right side. The changes are colour-
coded (deleted data is red , added date is blue and modified data is green ). In this example the estimated fetal 
weight has been deleted; HC, OFD and HC/OFC has been added and the value of the BPD has changed).
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The Reminders

The reminders (which can be set up in Options - Administrator (see page 167)) will recognize all unvalidated and 
modified examinations and remind the user to validate these examinations. These are the four reminder options:

no reminder
on closing patient (current exam only)
on closing patient (all non-validated exams)
on exiting program

No reminder for validation

If this option is chosen, while users may validate an exam at any time, there is never a reminder to do so.

Reminder to validate 'on closing patient (current exam only)'

If the option on closing patient (current exam only) is chosen, the user is given a reminder to validate an 
examination 'on close' of a patient record. This reminder only appears when the currently selected examination has 
not been validated. When reminded, the user is given the option to open the standard validation dialogue where he 
can validate the exam.

Reminder to validate 'on closing patient (all non-validated exams)'

If the option on closing patient (all non-validated exams) is chosen, the validation process asks for validation of 
all examinations of the current case which are not validated or have been modified. The validation will offer to 
redirect the user to the Summary, where all examinations can be validated.

In case the quick validation method has been activated, a dialogue-box will open upon closing a patient with 
modified or not validated examinations. By clicking on the Validate button, the corresponding exam is validated 
and the button's text turns to Validated. By clicking on Close, no further changes are made and the dialogue is 
closed.



astraia user manual - 29.x

Published on: 15-Jan-2024
NEXUS / ASTRAIA GmbH

Navigation and Summary- Page 87 of 263

Additionally, there is a configuration option for a button Validate all to appear which allows you to validate all 
examinations at once. This affects the ease and speed with which users are able to click past this dialog and 
validate exams.

By default, this button is not shown. Please contact astraia if you want to use this button in the quick validation of 
the option on closing patient (all non-validated exams).

Reminder on exiting the program

The user is given a reminder to validate examinations at the close of the application.



astraia user manual - 29.x

Published on: 15-Jan-2024
NEXUS / ASTRAIA GmbH

The Record Screen- Page 88 of 263

•
•
•
•

7 The Record Screen
After you have found an existing patient or entered a new patient you can choose between starting a new case - 
pregnancy, gynaecology, colposcopy, fetal echocardiography or breast screening - or opening the current case or a 
past case.

The different report areas can be selected directly with the help of the navigator. The patient's data are displayed 
on scrolling screens. To move up and down the record, you can:

press PgUp and PgDn , or
use the scrollbar on the right, or
use the mouse wheel, or
press the left mouse button on the screen and drag up or down.

Additionally, as the focus is moved to a field that is not in view, the screen is automatically scrolled

Navigating the screen is simple: press the up or down arrows to move from one field to the next. You can also 
move down with the Tab key. The Space key opens lists.

Patient details and examination data are recorded in various field types. These include:

Text fields

Plain text fields: For example, the patient name. Where a name is expected, the first letter is automatically 
capitalized for you.

Text field with lists: An arrow sign on the right of the text box indicates that a helper list (see page 94) is available. You 
can customize this list to your own requirements. To open the list, click on the arrow, double-click on the text field 
or press Space when the flashing cursor is at the start of the text field. If an entry is chosen from the list it will 
replace anything already typed. However, after a list selection has been made, you can edit the text manually.

For helper lists, a multiple selection of list elements is possible by putting the focus on the element you want to 
select and pressing the Tab key. For the second item, you want to select put the focus on this item and press the 
Tab key again.

To change (see page 94) the helper list, choose the entry Change this list from the list or hold down the Alt key and 
press Enter (only if you have permission to change lists, see Options - Users (see page 177) and Options - Groups (see 
page 179)).
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Dates

Date fields: You can enter dates in a variety of formats, for example '17.10.00', '17 Oct', '17-10-2000'. If the year is 
omitted, the current year is assumed. If the year is entered as a 2-digit value, it is converted to a year in either the 
past 80 years or the future 20 years,e.g. 45 becomes 1945, whereas 12 becomes 2012.
TIP : to quickly enter today's date double-click on the date field.

Time

Time fields: This type of field is for entering the time in values ranging from 00:00 to 23:59. You will only be able to 
leave this field if the time is not invalid such as 24:15.

TIP: similar to the date field, double-clicking on the time field will enter the current time.

Numbers

Number fields: Number fields often have minimum and maximum expected values. A warning message is displayed 
if your entry is outside this range. If you try to enter a negative value where it is not expected or a value that is too 
large, the program will display an error message. You will need to correct your entry before you can proceed.

You can display a graph for all number fields by pressing F7 . If these number fields do not have a specific graph, the 
value will be displayed in relation to the gestational age (in the case pregnancy) or to the examination date (in other 
cases).

Choice fields

Popup lists: Popup lists (see page 92) are used where a limited selection of fixed choices are available (yes/no, male/
female, etc.). Press the Space key or click on the list to open it. You can select an entry with the mouse or use the up 
and down arrow in combination with the space key. If you want to delete a list choice use the Del key or click on 
the Popup list and select the empty entry at the top.

To change the popup list, choose the entry Change this list from the list or hold down the Alt key and press Enter .
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Checkboxes: A checkbox indicates 'yes' or 'no'. If 'no' should be recorded actively, then a popup list will be used. 
Press Space to check or un-check the box.

Lookup table: Lookup tables (see page 98) are designed to allow the selection of one or more entries from a table. For 
example, this could be a table of referring doctors or a list of diagnoses. Press the Space key to activate the list 
chooser, or click on the ... symbol at the left.

In the list chooser, you can edit and create new entries.
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7.1 Patient Data
The name, other names and date of birth will have been filled during booking (and other fields may be pre-filled if 
you have a link to a Hospital Information System(HIS)). It is not required to enter any more data before continuing.

Note: A blue label characterizes a field, that must be filled.

To enter the referring doctor / GP, click on the field and select the small ... button at the left side of the lookup 
table (see page 98). You will see a list of doctors (which may be empty when you begin using the program). In this list, 
you can search for a doctor, or enter a new one.

This is the patient demographic screen:

The demographic data of one patient is the same in all cases (pregnancy, gynaecology, colposcopy and fetal 
echocardiography) and is also kept if you start a new case. Changes in the demographic data will be transferred to 
past cases as well.

Data on a partner, however, can be different from case to case.

If you create a new case, the patient's data will therefore be filled out automatically, all data fields in the partner 
section will be empty and can be filled out again. Changes in these fields will not be transferred to past cases.

Mask configuration for other countries

There are various country-specific patient data screen definitions that can be selected in the Screen 
Configuration (see page 213) menu.
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For Canada, you can e.g. select the pre-set patient screen 'Patient Name (Canadian)'. Two additional data fields 
('Middle name' and 'Previous last name') appear.

If your country has a National Health Service, you can also select the pre-set screen 'Patient demographics (UK/
NHS)' and the fields 'Health authority' and 'NHS number' will be added next to the field 'Hospital no.':

If you have any questions about pre-set screens for your country, please contact our Technical Support (see page 260).

7.2 Editing Popup Lists
A popup list is a list displayed by clicking on a button field in the astraia program which has the same colour as the 
background. Popup lists are used whenever a small number of possible options are available (e.g. yes / no / not 
known / positive / negative) in order to ensure a consistent set of medical terms. Only then, a statistical evaluation 
is possible.

Popup lists adapt to the colour setting of the program:

The fixed list is opened by pressing the space key or clicking on the field with the mouse, the list is shown:

To clear a field, click on the blank space at the top of the popup list.



astraia user manual - 29.x

Published on: 15-Jan-2024
NEXUS / ASTRAIA GmbH

The Record Screen- Page 93 of 263

•

•

To edit a fixed list, click on Change this list or hold down the Alt key and press Enter .

You should be aware that whenever you choose an entry in a fixed list the Id number is stored in the database. This 
is especially useful in multilingual databases.

The fixed list editor shows two columns:

the ID number of the list entry (numbers higher than or equal to 10000 indicate that this is one of your own 
entries). IDs under 10000 are reserved by astraia. Only IDs under 10000 are translated by astraia and have a 
functionality (e.g. if you create your own entry in Examination - Ultrasound - First trimester - Ethnic group 
and select that entry, you will not be able to calculate a risk).
the list entry text
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On the right-hand side of the editor, you will see three buttons and four checkboxes. The functions of these are: 

Move up: moves the selected entry up in the list (this button is greyed when the selected entry is at the top 
of the list).
Move down: moves the selected entry down in the list (this button is greyed when the selected entry is at 
the bottom of the list).
New item: Use this when you want to add a new list item. The Id column will show a value greater than or 
equal to 10 000, and you can type your text into the list. 

Hide: If you click on this checkbox, or the checkbox is ticked, this list entry will not be shown in future, unless 
it was used in a previously-entered examination being reviewed. The list entry has not been deleted from the 
database, it is invisible.
Show hidden items: If this checkbox is deselected, all hidden items will also be invisible in the editor.
Default: This option fills out the list entry with the default entry, as soon as you open the respective screen.

Highlight: This list entry will be highlighted in red when chosen. Additionally, on printouts, the highlighted 
entry will be displayed in bold. This option is used for important findings or abnormalities.

Note for users of multilingual versions:

User-defined entries are single-language, unlike the supplied lists. If you want to add texts in more than one 
language, you should contact our Technical Support (see page 260).

7.3 Editing Helper Lists
A helper list is attached to most text fields in the astraia program. It is designed to help whenever you are likely to 
enter the same text more than once. For example, Hospital Number has no helper list - it is quite unlikely that you 
will want to enter the same hospital number more than once; however, Town has a helper list because it is very 
likely that you will want to type in the name of a town which has already been entered for another patient. Having a 
helper list also helps to ensure that the spelling of an item is consistent. In comparison to a popup list, a helper list 
entry can be supplemented or edited by a manual entry.

The helper list has a light-grey background:

Please note that list entries cannot be deleted from the database, therefore we recommend to choose 
new list entries carefully.



We recommend caution when using this option: for example, if the default option for a particular 
examination is changed from 'not examined' to 'normal' and the window is opened but the automatically 
created entries are not reviewed, there could be medico-legal implications.


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The helper list is opened by pressing the space key, double-clicking on the field with the mouse or clicking on the 
arrow symbol on the right side of the field, the list and sublists are shown. The helper list editor shows three 
columns; if there is a sublist to a list, it is indicated with an arrow on the right side of the entry:

It is possible to add multiple values from the helper list by:

pressing the Ctrl key while clicking on several helper list entries
selecting a value (with the keyboard arrows or placing the mouse cursor over the entry) and then pressing 
the Tab key. This is especially useful when using the keyboard to fill the fields as it does not require any 
mouse interaction.

Additionally, helper lists allow you to create fairly complex sentences by the use of further menus. A good example 
of further menus is found in the Obstetric database, under Indication - Fetus. The menu entries (Head, Brain, Spine, 
etc.), contain sub-menus listing the specific conditions corresponding to the chosen organ system. The sub-menu 
entries can themselves contain sub-menus.

To edit a helper list, click on Change this list or hold down the Alt key and press Enter.

The helper list editor shows three columns:

the ID number of the list entry (numbers higher or equal 10 000 indicate that this is one of your own entries)
the list entry text
the name of the sub-menu (if one exists)
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On the right-hand side of the editor, you will see three buttons and four checkboxes. The functions of these are :

Move up: Moves the selected entry up in the list (this button is greyed when the selected entry is at the top 
of the list).
Move down: Moves the selected entry down in the list (this button is greyed when the selected entry is at the 
bottom of the list).
New item: Use this when you want to add a new list item. The ID column will show a value greater than or 
equal to 10 000, and you can type your text into the list. Please note that list entries cannot be deleted from 
the database, therefore we recommend to choose new list entries carefully.

Hide: If you click on this checkbox, or the checkbox is ticked, this list entry will not be shown in future, unless 
it was used in a previously-entered examination being reviewed. The list entry has not been deleted from the 
database, it is invisible.
Show hidden items: If this checkbox is deselected, all hidden items will also be invisible in the editor.
Default: This list entry should be entered by default. Use this option sparingly - for example, for the field 
Town, if the vast majority of your patients come from the same town so that you will only have to change a 
few entries.
Note: We recommend caution when using this option: for example, if the default option for a particular 
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examination is changed from 'not examined' to 'normal' and the window is opened but the automatically 
created entries are not reviewed, there could be medico-legal implications.
Highlight: This list entry will be highlighted in red when chosen. Additionally, on printouts, the highlighted 
entry will be displayed in bold. This option may be used for important findings or abnormalities.

If the selected list entry contains a further menu, you will see an additional button (Further menu). If you want to 
define a sub-menu for an entry click on the third column and type in the name of the sub-menu. The button 
'Further menu' is then available. Clicking on this button shows the list editor for the named menu. You can edit this 
list and further sub-menus. On closing the editor you will return to the editor of the main menu. If you choose the 
option Include parent text, the whole text (menu and sub-menu) will be shown in the text field, including all the 
list elements.

Note for users of multilingual versions:

User-defined entries are single-language, unlike the supplied lists. If you want to add texts in more than one 
language, you should contact our Technical Support (see page 260).
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7.4 Editing Lookup Tables
Lookup tables are a general input component for the structured storage of more complex data where the selection 
of one or more entries of a list should be possible. They are used in several places in the application for different 
kind of data. The exact layout and fields a Lookup table offers depend on the data it stores.

This is one example of a lookup table, the Referring Doctor(s) field on the Conclusions screen:

7.4.1 General functionality
To open the lookup table, select an entry and press the Space bar or click with the left mouse button on the ...
symbol. The list is shown. The data for a Lookup table is entered in a separate screen, which contains different data 
depending on the table.

This is for example the opened Lookup table for referring doctors on the screen Ultrasound:

The functions in an opened list are:

Select: In order to choose a list entry, select the entry with your mouse and press Select (Alt + L). 
Edit: With the edit function, details can be changed or completed. For this click on the entry, you want to 
edit and press the Edit button (Alt + E).

New: To add a new entry to the list use the option New (Alt + N) and enter the new entry's details.
Cancel: You can close the list without making or changing the selection using the Cancel button (Alt + C). 
Saved entries within separate fields will not be discarded.
Delete entry: New entries can be deleted from the database as long as they have not been used.

All changes you do to existing lookup table entries will also affect the information in previous cases 
and examinations - please be very careful editing existing entries!


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7.4.2 Search
With the exception of trees like the one which is used for the Diagnosis tree (see the section 'The Diagnosis tree' 
below), all Lookup tables offer a search field at the top of each column. Entering a search term here will only 
display those entries of the list whose value in the respective column matches the search term. You can even enter 
search terms in several columns at the same time and only those entries which match all columns' search terms will 
be displayed.

Just start typing e.g. the name of a doctor in the respective field above of the Name column and only those doctors 
whose name starts with the entered search term will be displayed in the list, similar to the Patient Lookup 
Window.

Entering smi  will find Smith , but not Blacksmith

(because, while Blacksmith  contains smi , it does not start with it)

For a more advanced search, you can use wildcards. They allow you to search for entries that do not simply start 
with the search term, but entries that contain the search term(s).

There are two types of wildcards:

The asterisk (*): The asterisk represents any number of characters (including no characters)
The question mark (?): The question mark represents exactly one and only one character

This allows you to create more complex search queries. If, for example, you remember that a doctor's name 
contains the letters smi , but may or may not start and end with a different string, you can use the following: 

Entering *smi*  will find both Smith  and Blacksmith 

Entering Ti*  will find both Tim and Tina

Entering Ti?  will find Tim , but not Tina

(because Tina  has more than one letter after Ti )

You can use several wildcards in one search and also combine both types of wildcards.

Please note: As was explained before, entering a search term without a wildcard will find all entries which start
with the search term. However, once at least one wildcard is being used, an exact search with that term will be 
performed. This means that the end of the search term will be compared to the end of all possible entries. *smi

alone would not find Smith  (but, for example, Tasmi ). If Smith  should be found, a second wildcard needs to 
be used, as can be seen in the example above.
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7.4.3 Examples
In the following sections, three important types of Lookup tables will be explained in more detail.

7.4.3.1 Referring doctors / GP
The Lookup table for Doctors (which can be used for Referring doctors or a general practitioner (GP)) If you press 
New, the editing screen for referring doctors appears:

Fill in all information you know about the doctor and add the information to the database by clicking on the Save
button. If you do not want to save your changes, exit the screen by pressing the Cancel button; the changes will be 
discarded.

If you want the greeting in your letters to the referring doctors to be generated automatically, just enter a Greeting
for each referring doctor in the respective field, e.g. 'Dear Dr Johnson'.

7.4.3.2 Procedure codes
The next example shows the table Procedure codes (in the screen Conclusions):
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In order to add a list entry, the New (Alt + N) button should be pressed. An entry field opens to input the text block 
(in this case the procedure) and the respective code.

After this has been entered and saved, it will appear in the table and can be selected. By marking the respective text 
(procedure) and pressing Select the procedure will appear in the respective examination.

7.4.3.3 The Diagnosis tree
In the Diagnosis field one can additionally create a hierarchical structure of the text modules:

In order to create a list entry here, the level on which you would like to enter it needs to be marked before pressing 
New. The following window with a text entry field for the diagnosis and the ICD code appears:

Once this has been entered and saved, the text block will appear on the respective level. In order to create a new 
level-folder (which can also be utilized as a text block itself) the file to be turned into a folder needs to be marked 
and again New needs to be pressed. After having entered and saved the respective text block, it will turn into a 
folder:



astraia user manual - 29.x

Published on: 15-Jan-2024
NEXUS / ASTRAIA GmbH

The Record Screen- Page 102 of 263

•
•
•

turns into

By clicking on the checkbox Drag & Drop you can move a diagnosis from one folder to another, add it to a new 
folder or take it from one folder and create a separate new diagnosis. After having moved one item, the checkbox 
has to be reactivated to move another item.

7.5 The Reporter
The reporter is a tool for entering text quickly and reliably by

using pre-defined entries,
entering the text manually or
copying and pasting ( Ctrl + C , Ctrl + V ) text passages from the clipboard.

It stores its results in HTML (like a web page) so you can use basic formatting such as bold, italic and underlined text 
by selecting text and clicking on the appropriate button. It is also possible to influence the size and the alignment of 
the text blocks (left, right or centre) and to utilize the provided spelling correction tool (right-click on words to 
show the correct spelling possibilities).
The reporter consists of a tree of entries on the left (which you can delete, expand or complete), the text editor on 
the right and a toolbar. You can adjust the proportions of the reporter display by dragging the central divider to the 
left or right.
To use entries in the tree simply double-click with the mouse on the selected entry. The pre-defined text is then 
inserted into the text editor at the current position. You can then continue editing in the text editor, or simply select 
another entry from the tree.

The tree may be initially empty, in which case it contains a single entry Text. The toolbar contains three icons for 
modifying the tree: Add entry, Edit entry and Delete entry. To add an entry to the tree, select either the root Text 
entry (to create a new text item at the top level like Date and Greetings in the screenshot above) or any other 
existing but empty entry (which will become the parent of the new entry). An existing entry that is converted into a 
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folder cannot be used anymore as a text item. Therefore the button Add entry will only be enabled if the currently 
selected entry itself does not contain any text.

The advantage of the tree structure is that it allows you to create a complex but well-organized set of frequently-
used texts.

For example, a gynaecological ultrasound reporter might contain an entry 'Uterus', which would itself contain 
entries describing various normal findings, plus sub-sections for different pathologies.

To expand or hide sections of the tree you can click on the handles with the mouse or, using the keyboard, press the 
left and right cursor keys.
The up (Move this item up) and down (Move this item down) arrow icons in the toolbar are used to reorder 
selected items (with rectangles around them like 'Uterine pathologies' in the above example) in the tree.
If you want to drag and drop reporter items to another place in the hierarchy, activate the Enable drag and drop
icon. This functionality is not activated by default, as items are moved easily by mistake if this is always active and 
must be re-activated if you change screens.

When adding a new entry or editing an existing entry, the edit report item (see image) dialogue is shown, as below. 
Each entry has a title (which is displayed in the tree) and text which is inserted into the editor. Typical uses for an 
entry include:

empty, acting simply as a heading for other entries
text, usually a frequently-used expression
text with one or more markers which will be replaced by values typed into the editor
text with variables

As the item name is a required value, the OK button will be disabled as long as the item name is empty.

The following is an example of an entry. Note that you can format text directly in the report item which will be kept 
when adding it to the Reporter text field.
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7.5.1 Using variables
Notice the Variables popup list in the following screenshot. It contains a list of useful database items which can be 
included in the entry. A variable will be replaced by its correct value once it is inserted into the Reporter text field.

         

There are two ways of adding variables to the report item's text:

Select a variable from the dropdown list Variables. It will be added at the current cursor position in the text.
Enter the variable's name (the way it appears in the dropdown list) enclosed in two curly brackets, 
e.g. {Patient DOB}. If it is a known entry in the dropdown list, it will automatically be converted into a 
variable.

In the example, we have included the current patient's names and date of birth. As you can see, even variables can 
be formatted by selecting them like text and using the formatting options.
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7.5.2 Creating new variables
The Edit button to the right of the Variables list shows a dialogue where existing variables can be edited and new 
ones can be added (only available to admin users).

To add a new variable to the list of variables, click on the icon Edit on the right-hand side of the Variables popup 
list. Select the list entry New Variable in the window Reporter Variable Editor. Fill in the description of the variable 
in the text field Variable name.
In the text field, Variable value enter the database name of the variable.

You can find the variable value/database name of the field you want to include in the variable list in the section 
Queries (see page 141). Click on the option New query and select the case (Pregnancy - Gynaecology - Colposcopy - 
Fetal Echocardiography) to which the field belongs. The window Query builder opens and you can change to the 
screen in which the field is. Select the field (indicated with a red border) and the query builder options will become 
visible in the lower half of the screen. The variable value is defined in the text fields Table and Column in the format 
'Table.Column'.

The following example adds the field crown-rump-length CRL from the first trimester examination to the variable 
list in the reporter:

select the module Queries and click on New query from the case pregnancy,
with the navigator change to the screen First trimester,
select the field CRL and write down the contents of the fields Table and Column (Table=Fetus, 
Column=CRL),
exit the Query module without saving and change to the reporter,
click on the icon Edit on the right-hand side of the variable popup list in the window Edit report items; 
select the list entry New variable in the window Reporter Variable Editor,
enter 'CRL' for the variable name,
for the variable value enter the CRL table and column name in the format 'Fetus.CRL' (Table.Column),
exit the window with OK,
the window Edit report items shows the new list entry CRL in the popup list.

7.6 The Drawing Module
The drawing module is a tool for displaying findings graphically with simple drawings, notes and objects. This 
module can for example be found in the case Pregnancy in the screen History - Family History.
On the left-hand side, you see the toolbar, the right side shows the drawing area:
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The following actions can be accomplished:

Selecting an object in the drawing area

Drawing a freeform

Drawing polygons

Drawing circles

Drawing lines

Drawing arrows

Inserting text

Inserting pedigree symbols
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Selecting an object in the drawing area

In the toolbar click on the icon for selection . Move your mouse over the object until it turns into a cross and 
click on the object.

The object chosen can be relocated and deleted, if you select a self-drawn circle, line or arrow you can also resize it.

to relocate an object, drag it with the held mouse button to the desired position
to delete an object, use the Del key on your keyboard and the selected object will be removed. Please make 
sure that the focus is on the drawing area. If some other field is focused (e.g. comments) and you press Del, 
the text in the focused field is deleted. You can select the drawing area by repeatedly pressing the Tab key 

until you can see the focus on the selection button (Selection button with focus: , selection button 

without focus: )

Drawing a freeform

On the toolbar click on the icon for freeform . Hold the left mouse button and move the cursor to draw the 
desired line.

You can choose different colours or line width / broken lines on the right-hand side to the drawing field:

The colour range in the upper part shows the standard colours and the last chosen 
colours. The larger quadrat below shows the current colour (in this example: black). 
The arrow symbol next to the current colour opens a palette with colour patterns. 

In the lower part, you can choose the line width of the solid line or a broken line in 
different widths.
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Entering text

Click on the icon for text  on the toolbar. Then choose the position where you would like to place your text in 
the drawing field, choose the typeface and enter the text. Confirm your entry by pressing Enter.

On the right-hand side of the drawing area, you can choose the font, size and 
formatting options (bold, italic).

If you want to change the typeface retrospectively, click on the selection icon and select the text in the drawing 
field. Then change the typeface on the right-hand side.

Drawing polygons

Click in the toolbar on the icon for polygon . Then click in the drawing field for the starting point of the 
polygon using the left mouse button. With further clicks on the left mouse button, you can set additional corners of 
the polygon. With a click on the right mouse button, you will need to close the polygon by connecting the last 
corner with the starting point.

You can also fill polygons:

On the right-hand side of the drawing area, you can choose the line colour and 
the filling of the polygon with the colour palette. The polygon can either not be 

filled , can be filled with a colour  or can be filled with a pattern 

. You can select the different patterns by using the same symbols as the line 
width.

Drawing lines/arrows

Click on the icon for line  or arrow  on the toolbar. Hold down the left mouse button and drag the 
cursor to the end of the line. Between the start- and the endpoint a straight line is drawn automatically.

For the line/arrow, you can choose different colours or line widths/broken lines on the right-hand side of the 
drawing area (see freeform).
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Drawing a circle

With the symbol for the circle , you can draw circles or ovals. By keeping the left mouse button pressed, you 
will have to determine the shape and size of the circle. Using the selection you can modify the size retrospectively. 
You can also fill the circle (see polygons).

Inserting symbols

Click on the icon for symbols  on the toolbar. A selection of pedigree symbols appears on the right-hand side:

For further symbol meanings, just move the cursor over the respective symbol and the meaning will be displayed.
After selecting a symbol you will have to click on the desired position for the symbol on the drawing area and the 
symbol will be placed there. There is a grid in the pedigree which aligns the symbols correctly, so you will only have 
to put the symbols near the correct place.

As described above, you can move and delete all symbols after they have been selected (selection ).

7.7 The Image Module

7.7.1 Image Browser
If the DICOM image viewer option has been licensed and is used on this machine (see Options - Workstation (see page 
211)), an area on the right-hand side of the patient record window is reserved for images. This area is called 
the Image Browser. By dragging the frame, you can change the frame's size.

When images are sent from the ultrasound machine (using for example a designated print/send button on the US 
machine), they appear as a thumbnail in the Image Browser and are grouped by the date of the respective open 
examination in astraia. The Image Browser shows the thumbnails of the images of one day sorted by study time. If 
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you hover your mouse pointer over one of these thumbnails, a preview of that image will be shown if the 
corresponding image has been loaded before (i.e. it is available in memory).

Images are linked to the correct patient using the patient ID in the DICOM header of the image. This patient ID can 
be the astraia patient ID (an automatically generated integer when the patient is registered the first time), or the 
hospital number (see Options - Imaging / Worklist (see page 194)).

Above the thumbnails of the image viewer there are some options allowing images to be displayed , exported 

, imported , acquired  (this option has to be licensed and the computer has to be connected to a 

device that complies with the TWAIN specification), viewed in the 4D viewer   (if available depending on the 

DICOM file) and printed . Images can only be imported manually if the current patient with an existing 

examination has been saved. Besides the image viewer window can be detached  from the astraia screen and 
moved e.g. to a second screen.

In order to interact with images (e.g. display or print), they need to be selected first. To select an image, just click
on it. An orange border shows which images are currently selected. If you want to select several images, just press 
the Ctrl key while clicking on all the images you want to select. You can also select a range of images by clicking on 
the first, pressing the Shift key and then clicking on the last image of a range. All images in between will be selected 
as well. At the bottom of the Image Browser, you will also see the number of currently selected images.
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Exporting Images and Sequences  

In order to export images, please select the desired image(s) and click on the Export image icon . A dialogue 
opens where you can choose the location where the image(s) will be stored and the file type. Supported file types 
are JPG, TIFF, BMP, PNG, DCM as well as AVI for sequences. You can also choose whether to save annotations and 
measurements in the exported image.

Additional options depend on whether you are exporting just one image or several images at once.

If you export just one image, you will see an image preview on the right. 
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If you export several images at once, the following dialogue is shown:

Please select the folder where the exported files will be saved and the file type.
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Regarding the naming of the exported files, you have two options:

Option Functionality Example

Tick 'Name and organize files 
automatically'

astraia will automatically create a folder 
whose name contains the patientID 
("patient7" in the screenshot above). In this 
folder, the images will be given a name 
according to the following scheme:
image_exportDate<export 
date>_examDate<examination 
date>_<incremental number>

patient7\image_exportDate2
8052016
_131546_examDate04052016
_1.jpg,

patient7\image_exportDate2
8052016
_131546_examDate04052016
_2.jpg, ...

Untick 'Name and organize 
files automatically'

The text box File name prefix is now enabled 
and you can enter your own file name prefix. 
Every exported file's name will start with this 
file name prefix, followed by an incremental 
number.

patient1.jpg,

patient2.jpg,

...

To export the files, click on Save.

Importing Images  

Pressing the Import images icon  opens a window where the desired image can be selected. You can also 
paste the image directly: For this, you will have to copy the image file ( Ctrl + C ), then open a patient in astraia and 
paste the image file there ( Ctrl + V ). The copied image should then appear in the image viewer.

Supported files are

*.png Portable Network Graphics
*.dcm Digital Imaging and Communications in Medicine DICOM
*.tif Tagged Image File Format TIFF
*.vol Volume File
*.jpg Joint Photographic Experts Group JPEG
*.dci DICOM Image

Acquiring Images 

Images can be acquired from a device that complies with the TWAIN specification via this icon. This option has to be 
licensed.
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Floating & Dock Image Browser window    / 

The image browser can be floated (e.g. to an additional monitor) with the Float the window icon  and docked 

again with the Dock the window icon . If multiple patient windows are open, the images window of the 
currently activated patient will automatically be activated. The floated image browser window will include the 
patient information in the title bar so the user can always make sure the images of the correct patient are reviewed.

The floated image window can be resized to be able to view a large number of images on a second monitor while 
reporting the information in the patient file. With this functionality, images can be selected more easily for printing 
or deleting. The image browser only displays thumbnails of the original DICOM image and the quality might 
decrease with increasing the window size.

3D/4D Images  

If 3D images or clips have been imported, additional functionalities are available.

Once a 3D/4D file has been selected, the button   in the header becomes active. Click on it and the file will be 
opened in a new window. This window and its features are described in section 3D/4D images at the end of this 
chapter. 
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Print Images 

Images can be printed not only from the File - Print menu (see chapter Printing Reports (see page 129)) but also 
directly from the image browser and the image viewer. Click on the Print icon and the following dialogue will be 
shown:

You can choose the orientation from Portrait or Landscape.

Select how many images you want to have displayed in one line (1 to 3) and how many lines per page (1 to 5). E.g. If 
you choose to have 3 images per line and 5 lines per page the layout grid will allow a maximum of 15 images on one 
page.

If the checkbox Include the annotations is ticked, any text and arrows will be printed. If Include the 
measurements is ticked, all measurements are printed. Both checkboxes can be ticked and all user additions will 
be printed.

Please note: Depending on your computer's hardware, printing many images at the same time may cause 
problems. For that reason, there is a threshold of 100 images for an installation with 512 MB of memory (200 images 
for 1024 MB of memory, depending on what you chose during installation). If you select and try to print more 
images than that threshold, a notification will appear asking you to reduce the number of images you are trying to 
print. Please deselect the specified number of images and click on Print again.
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7.7.2 Image Viewer 
Displaying and navigating through images

In order to view one or more images in more detail in the Image Viewer, they need to be selected in the Image 
Browser with the mouse (left click) and then opened by pressing the Display button. Alternatively, the images can 
also be selected by marking them and double-clicking on them. You can select multiple images (max. 9 can be 
opened at the same time) by pressing the Ctrl -Key while clicking on them. You can configure some options 
regarding the appearance of images in the Image Viewer in the menu at the bottom of this window. You can find a 
description of these options in section The menu at the end of this chapter.

Reopen 

If there are several images opened at the same time in the Image Viewer, you might want to select a subset of one 
or more of these images and only have these displayed. The Reopen tool allows you to do that. Just select one or 
more images using the Ctrl key and click on the Reopen icon. Only the previously selected images will be shown 
now. If you want to go back to the images that were shown before, you can use the Browse buttons (see below). 
You can use the Reopen tool as often as you like, as long as there is more than one image shown in the Image 
Viewer.
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Select and move 

The Select and move tool has several functions. It allows you to move the entire image with its annotations if 
you've zoomed in and the image isn't fully visible by left-clicking somewhere in the image (not on an annotation or 
measurement) and dragging the image while keeping the left mouse button pressed.

It also allows you to move any text, be it the value of a measurement or manually added text (using the Text tool), 
simply by hovering over it (the mouse cursor will turn into a hand), keeping the left mouse button pressed and 
dragging it to its new position. Text that belongs to a measurement can only be moved along the outline of the 
corresponding element so that measurement values can not mistakenly be swapped. If you want to move an entire 
element such as a measurement or an arrow, you will need to Edit it (see below).

In order to show the context menu described in General behaviour (see below), just hover over the element and 
right-click.

Zoom in and out 

This allows you to zoom in and enlarge the image by positioning the mouse cursor in the image and pressing the 
left mouse button. Once the image has been enlarged it is also possible to zoom out again by in turn pressing the 
right mouse button. The zoom factor of the image is constantly shown in the bottom right corner. By clicking on 
the zoom factor, the image will return to the original size (100%). By default, the zoom tool will zoom in on the 
position of your mouse pointer, but this can be configured in the menu at the bottom of the Image Viewer window. 
You can find a description of this menu and its options in the section The menu at the end of this chapter.

Browse 

The arrow buttons have two functionalities:

When there are several images available in your Image Browser and you open one of them, the arrow 
buttons allow you to browse through your images without leaving the Image Viewer. If e.g. you've opened 
the first image in the Image Browser, clicking on Next Image (the right arrow button) will take you to the 
second, third, etc. image. The same applies to the Previous Image button (the left arrow) for going in the 
other direction. If there are no images to browse through in a certain direction, the corresponding arrow is 
greyed out, like the left arrow in the above image.
When you have several images opened in the Image Viewer at the same time, you can open one or more 
of them by selecting them and double-clicking on one of them or using the Reopen tool. Now only the 
images you just selected are visible. If you want to go back to all images that were visible before, you can 
now use the Back button (left arrow). If you want to go to the previously selected subset of images again, 
you can use the Forward button (right arrow).

You can also use the Page Up and Page Down buttons for going back and forward respectively.
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The general behaviour of the tools

There are various tools available to utilise when images are displayed. The general functionality of all these tools is 
the same: after selecting the desired tool from the toolbar on the top of the window, the chosen measurement or 
annotation can be added to the image by one or more left-clicks. If you make a mistake while measuring or for any 
other reason, you can cancel with a right-click. Once an item has been added, it can always be edited or deleted.

The context menu that allows these actions to be performed can be displayed by selecting the Select and move 
tool (see the previous section) and right-clicking on a measurement's value or an annotation (such as an arrow or 
text) itself.

A context menu with the items Use measurement (only for measurements), Edit, Delete and Properties is shown:

How to use a measurement will be explained in the section Measurements below.

Edit

If you would like to change an item, e.g. change the endpoint of a distance measurement, you select Edit. You will 
now be taken to the last step of the respective tool. Making a measurement can consist of several steps, e.g. in 
order to measure parallels, you will

choose a starting point for the first line, then
an endpoint for that first line and finally
the parallel whose distance from the first one you would like to measure.

Using the Edit tool will take you to that last step (3) of placing the parallel and you can continue to use the parallels 
tool as usual. This also means that you can always go back one step by clicking the right mouse if e.g. you also 
want to change the endpoint of the first line from step (2).

Delete

If you would like to delete an item, simply choose Delete from the context menu.

Properties

Selecting Properties will show a dialogue similar to the following depending on what type of element you clicked 
on:
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The element's type and values such as the distance for a distance measurement are shown. You can give a 
measurement a tag which will be displayed on the image next to the measurement. Depending on the element, you 
may also choose a different colour for the box which contains the measurement's value or the element (such as an 
arrow) itself. If you've added a tag, you can also choose a colour for the tag box by opening the Properties
dialogue again. Note that the tag will be set automatically if you choose to use the measurement (see next 
section) so you only have to enter a tag for measurements that you are not going to store directly in the 
examination.

Measurements

Use measurements 

It is possible to directly export the measurement data into the current examination. To do this, one selects Use 
measurement, then selects what measurement field it is to be entered into and then presses OK.
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The value is exported into the respective field of the examination and the field's name will automatically be added 
to the measurement as a tag.

Measure distances 

In order to make a measurement, the mouse cursor should be positioned on the image object to be measured. By 
pressing the left mouse button a cross is positioned at the starting point. By moving the mouse to the endpoint 
and pressing the left mouse button again, the distance between the two points is shown in the image.
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Measure parallels 

This tool allows you to measure the distance between two parallels. Select the tool and place the first line by 
clicking on two points that define it. Now move the mouse in order to place the second line which is automatically 
placed parallel to the first line. Click again if the second parallel is placed correctly. Now the distance between the 
two lines will be displayed.

Measurement of ellipses 

Similar to the above it is also possible to place ellipses in the image and measure their circumferences. These can 
also be exported to the currently open examination.

The precision of the circumference is less than or equal to 4 times the maximum of PhysicalDeltaX and 
PhysicalDeltaY.

Given 52 mm as the circumference and a PhysicalDeltaX of 0.01 cm, a PhysicalDeltaY of 0.015 cm.

4 x (0.015 cm) = 0.06 cm this means the real circumference is between 51.4 mm and 52.6 mm.

Measurement of angles 

It is also possible to measure angles. To do this the three points of the angle must be set using the left mouse 
button and the angle will be displayed.
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By default, the angle tool will interpret the chosen angle as smaller than 180°. By clicking the middle mouse 
button, the angle will be measured on the other side making it possible to measure angles bigger than 180°. 

Annotation tools

Draw an Arrow 

To draw an arrow, select the corresponding tool and use the left mouse button to first determine the start point 
and then the endpoint (where the tip will be). By using the mouse wheel the arrow's thickness can be changed.

As with other elements that can be added to an image, the arrow's colour can be changed using the Properties (see 
above) once it's placed on the image.

Draw Text 

The draw text icon allows text to be integrated into the image. After the icon is pressed and you click on a position 
in the image using the left mouse button, a cursor allowing text input will appear. Once the text has been entered, 
press Enter to finalise the entry. Using the right mouse button and selecting Properties allows you to change the 
entered text.

Mask the Image 

In order to mask out certain details of the image (for example the patient's name, the date, etc.), this function 
allows the blackening of these. After you have pressed the Mask the image icon, you can choose the part of the 
image that should remain visible by drawing a rectangle around it: place the first corner of the rectangle by 
pressing the left mouse button and press it again to place the opposite corner.
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The image can be unmasked afterwards, by right-clicking in the masked area and choosing Delete. 

Hide Measurements and Annotations 

In order to hide all measurements and annotations, click on this icon.

Printing images 

As from the Image Browser, it is possible to print images directly from the Image Viewer. The feature is described 
in the section Image Browser above.

Brightness and Contrast/Window Center and Window Width  / 

For increasing visibility of certain features, two sliders are shown which have a slightly different meaning depending 
on the type of image that you opened. For coloured images, brightness and contrast sliders will be shown. For 
greyscale images, sliders for changing the window centre and window width are shown. Dragging the sliders to 
the right will increase the respective value. The symbols to the respective left of the levers reset the adjustments 
back to the initial default. When there are multiple images opened, the sliders will only be available if there is one
image selected. If none or several images are selected, the sliders are disabled, but it is still possible to use the 
symbols to reset the respective value for all images.

Look-Up Table (LUT)

For monochrome pictures, an additional function appears to view these pictures with various colour variations.
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Image / Training Notes 

For each image, it is possible to write notes into the comments field. Additionally, it is possible to construct 
hierarchical Image notes and Teaching files categories that can be chosen for every image. In order to add an 
entry, mark the appropriate level, press the Add item button, input a category name and press Enter . If one of 
these note categories has been selected for an image, a large tick appears on the respective tab.

You can search for images by tags using the Find images tool, see Queries - Querying the Database (see page 141) -> 
Finding images. This feature can be used to e.g. easily organise all images belonging to a case study.

Image sequences 

For image sequences ('clips') the above tool allows you to play the sequence. Further, you can view individual 
frames and move back and forth from frame to frame using the arrowed buttons or the lever. It is also possible to 
loop the sequence using the far right button. On the right, it is always shown what frame of the sequence is 
currently being viewed.
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1.
2.
3.
4.

3D/4D Images

Navigation

3D images are opened in a 3-side-view, showing the sagittal, the transverse and the coronal plane. The correlation 
between the three views is indicated by a small yellow dot.

There are four ways to navigate through the slices:

Left-click in a view and drag the image to the region of interest
Left-click in a view and scroll through the slices with the mouse-wheel.
Use the X-, Y- and Z-sliders below the images to rotate the image around the axis.
Click on a view to activate it. A white frame will show which view is the current active one. Move the Slice 
slider to navigate through the slices. The arrow keys on your keyboard have the same functionality.

Use the Magnification ruler to zoom in and out of the image.

The bias and its position can be changed with the Bias and the Pos ruler.

Different colour schemes can be selected from the ColourLUT menu.

Press the Reset button to discard all changes and to see the original presentation of the images.

The reference slice is indicated by a white frame. It can be selected either by clicking on it or selecting it from the 
Reference slice menu.

The slice thickness can be adjusted from 0mm to 3mm.

Select the number of views from the View menu. One, two or three views, or a Tomographic view can be shown.  
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In the Tomographic view, you can scroll through a defined area. Up to 22 slices can be shown with distances from 
0,2mm up to 5mm. The images can be arranged in two or three images per line, or in two lines with four images 
each.

For 4D files, additional player buttons will be shown. You can play/pause the clip, step through single frames and 
adjust the speed.
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Measurements

Measurements can be performed on each slice of the 3D/4D images.

It is possible to measure

distances
distances between two parallel lines
areas
circumferences
angles
angles between two lines

All measurements can be hidden by pressing the Hide measurements button.

The active slice can be saved as a PNG, GIF or JPG image.

Please be aware that all measurements disappear as soon as you move an image, or scroll through the slices

Changing the viewer

If 3D/4D images cannot be opened, please verify that the correct 4D viewer has been selected in Options - 
Workstation (see page 211) where you can choose between several options. Please note that after changing the 4D 
viewer a restart of astraia is required.
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i.

ii.

The menu 

The menu offers to export images and options that are related to zooming and appearance.

File -> Export: This will export all currently selected images visible in the Image Viewer. If no images are 
selected, this will export all images that are currently visible. This works like the feature Export in the Image 
Browser which is described at the beginning of this chapter.
View -> Columns: astraia will automatically determine a reasonable amount of columns in which multiple 
images are going to be displayed. In this submenu, you can manually choose the number of columns by 
using the up and down buttons.
Options ->

Layout -> Column width fixed: If there are several images displayed at the same time, they do not 
necessarily have the same size. If this option is checked, all columns will have the same size, 
irrespective of the size of the images that the columns contain. If this is unchecked, columns that 
contain smaller images will be smaller themselves which leaves more space for columns with bigger 
images.
Zoom -> Type: This determines which part of the image the zoom tool will zoom in on. There are 
three options:

Fixed: The zoom tool will zoom in on the upper left corner of the window.
Zoom to centre: The zoom tool will zoom in on the centre of the window, indicated by the 
red circle (if the zoom tool is selected).
Zoom to pointer: The zoom tool will zoom in on where your mouse pointer is located in the 
window. This means you can move your mouse pointer onto a feature you are interested in 
and it will stay in focus during zooming. This is the default setting.

Zoom -> Block max zoom to the biggest in column: Within one column, there can be images of 
different sizes. The biggest image in the column will always fill 100% of the column's size, but there 
are two ways a smaller image can be sized:

The smaller image will also fill 100% of the column's size (Block max zoom to the biggest in 
the column set to unchecked).
The smaller image will have the same zoom factor as the biggest image (Block max zoom to 
the biggest in the column set to checked). This means that an image that is only half the size 
of a bigger image will always be half the size of the bigger image, even when zoomed in on. 
This is the default setting.
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8 Printing Reports
The program is supplied with standardized reports to print the entered data.

To print, select Print from the File menu, or press Ctrl + P. The window Print selection appears:

Here you can choose from different examination reports, charts, request forms or consent forms and select from 
the options Preview, Print or PDF (for configuration of the printout and the PDF options see Options - Printouts (see 
page 185)). If configured, you can also use the options Fax (see Options - Printouts (see page 185)) and Email (if licensed, 
see Options - Administrator (see page 167)).

You can choose from the following reports:

Examination reports: The above print selection shows the examination reports for a pregnancy case. You 
can choose from a complete report to referring doctors / GP over growth scan and anomaly reports to 
multiple first and second trimester reports.

Please note

The standardized reports do not discharge the reporting person of their duty to check the correctness of 
the report and to counsel the recipient - be it a patient or a medical colleague - about the intended 
meaning of the report's content. The latter means that the reporting person needs to assure in an 
appropriate way (e.g. via comments in the comments fields in the respectively examined screen section or 
more generally in the section "Letter") that the report is understood by the recipient in the same way as 
understood by the reporting person. This is especially true when handing out reports in a language 
different from the one used for entering data in the astraia application.


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When selecting the complete report to referring doctors / GP, a list of all the referring doctors / GP of the 
actual patient will be displayed at the bottom of the window. Here, you can select the doctor you wish to 
send a copy to. You can send your reports to multiple doctors, a list of all recipients will be printed at the 
bottom of the report. In addition, you can select a copy for the patient, a personal copy and a copy for the 
files.
Further, by selecting the checkbox print selected charts, it is possible to add additional charts to the 
printout. The following windows will open:

The desired charts need to be selected from the list *charts used in this exam*. Those charts shown in the 
selected charts window will then be printed. You can specify how many charts should be displayed per line 
(2, 3 or 4) and whether the literature reference should be printed as well. If a selection of charts is to be 
saved for future reports, this can be done using the Create chart set button. Created chart sets are 
displayed on the top left and can be selected for further printouts.
If the Image Viewer option is licensed it is furthermore possible to add images to the printout. These images 
have to be connected to the respective patients, and you will need to highlight the images that are to be 
printed. You can select multiple images by keeping the Ctrl-Key pressed while selecting the images with 
your mouse. After having selected the images, the option print selected image(s) will be available in the 
print selection:

Charts:
These reports contain no text, only charts. Here you can choose second-trimester charts, including BPD, 
HC, AC and FL, or in addition to the four charts mentioned before HC/AC and estimated fetal weight EFW. 
Additionally, you can print the Doppler charts including UA, MCA, TA and DV, or the uterine artery charts.
If you want to print out your own selection of charts without any text, you can choose the option Selected 
charts and then select the checkbox print selected charts and choose your charts as it is described above.
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Request and consent forms:
A request form is available for the outcome of pregnancy. Consent forms can be printed for Amniocentesis, 
CVS and Fetal blood sampling.
Ad hoc letter:
Prints the letters generated in section Letters, which you can find in the navigator of the program.
Image printout: This option is only visible if you have a licensed image viewer. This printout enables you to 
print a selection of ultrasound images without text or charts.
You can add the images as has been described above. You can also use the option to directly print images 
from the image browser or image viewer, see Image module (see page 109) - Print image.

After having selected your report you have the choice between Print, Preview, PDF or if configured Fax or Email.

Print

In case you want to print the selected report directly, the printing program will open instantly, and you will not be 
able to preview the report. The astraia standard print dialogue opens (you can also use the Windows print dialogue, 
see Options - Printouts (see page 185)) where you can select your printer, the number of copies, etc.

Preview

Printing is done by a special print module - if you preview the report, the print module is started and shows the 
report as it will be printed in the window Print preview. Here, it is possible to change the size of the preview by 
pressing the zoom button. You can then close the printing module or print the report. If you press the printer 
symbol, the astraia standard print dialogue will open.

Further settings such as font type, font size, paper size and margins are available in Options - Printouts (see page 185).
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Quick Print - Quick Print Preview

While in a patient record, you can access the print functionalities directly underneath the navigator. You can find 

icons for Quick Print and Quick Print Preview: 
The Quick Print will automatically print the preselected report template to the default printer.

The Quick Print Preview will automatically open the print preview of the preselected report template.

Fax

In case your computer is connected to a fax machine, and you configured the fax in Options - Printouts (see page 185), 
you can also send the report directly by fax without printing it out.

Email

To send reports by email, you will also have to configure your outgoing Email settings in Options - Administrator (see 
page 167). A valid licence is required to use this functionality.

In the following window, you can select each referring doctor / GP for whom you have entered an email address. 
Furthermore, you can send an email to the patient if you have entered the patient's email address or manually 
enter any other recipient.
Additionally, you can select whether you want to send your report as an HTML-text or as a PDF attachment. The 
name of the PDF attachment is created automatically and can be configured in Options - Printouts (see page 185). You 
can also specify the default e-mail subject there.
Furthermore, you can select different sender names with their email addresses. You can choose between the sender 
name which has been set up in Options - Administrator (see page 167) and each user for whom an email address has 
been entered (see Options - Users (see page 177)).

Please note the legal advice in chapter Options - Administrator (see page 167) - Email Settings.
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PDF

This option enables you to save your reports as PDF-files and view and print them with a PDF reader application. It 
is a very useful option for archiving purposes. You can either enter the file name and path manually, or you can 
change the PDF settings in Options - Printouts (see page 185). Here you can change the default name, disable the 
prompt for the file name and path, enter a default path and enable an automatic PDF saving routine upon each 
printout. If you want to save the report manually, the following window opens upon pressing PDF in the print 
selection.
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2.

9 Reminders
This feature is designed to record patient-linked tasks. For example:

A patient should receive an appointment for a followup scan in six months, but cannot decide on a 
date. We arrange to call the patient in six months to arrange the scan. We add a reminder to 
'Phone patient' in 6 months and add a note detailing the reason. When this action becomes due, 
the record appears in Outstanding reminders; the call is made and the reminder is completed.
A pregnant patient has an ultrasound scan which shows unusual features. We put the patient on 
the list 'Weekly review' to be discussed with other staff at the weekly meeting. At the meeting, we 
view the contents of this list and can open each patient on the list directly. At the end of the 
meeting, each entry on the list is completed.

In the two active views, the right-hand button is used to close the entry. This shows a dialogue in which you can 
enter any additional comments. In the case of an email action, an email will be sent using the subject and text. If 
astraia is not configured for sending emails (see Options - Administrator (see page 167) -> Email configuration), your 
locally installed email application will be started with the relevant data entered so you can send the email 
manually. In the case of a phone action, the patient's contact numbers are shown.

Adding Reminders

The patient record must be open. Reminders are accessed via the Action Panel at the bottom left of the patient 
record window:

 In order to view this patient's reminders or add a new one, click on the Reminders icon. The following window 
opens:
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In the dropdown menu on the left, you see a list of available actions (which can be modified, see section 
Configuring Actions below). Depending on what action you choose, several input fields appear.

For example in the case of the action Telephone the patient, the input mask looks as follows:

In order to add this Reminder, click on OK. If you don't want to save it, click Cancel.

The Reminders icon will now display the number of outstanding Reminders for this patient. If you open the 
Reminders list again, you will see the Reminder you just created (and any other previously created Reminders that 
belong to this patient) above the input mask.

Available input fields 

In general, the following fields are available, but not all of them may be shown depending on the action that is 
selected:

Description: This is a 'memory list'. If instead of selecting from the list you enter a new description, it will be 
added to the list the next time you select the same action.
Number of time units (1-30)
Time unit (days / weeks / months)
Action date (calculated by adding the selected time units to today's date)
Action time
Comment section

Any action which involves email will only be visible if the patient's email address has been entered in 
Demographics.

It is possible to associate an action with one or more user groups. If this is the case, the action will not be visible to 
users who are not members of the listed group(s).

Viewing and Completing Reminders

Click on the Reminders icon on astraia's main screen:
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The following window opens:

In the list, all reminders of the current view are displayed. On the top-left you can select what kind of reminders to 
view out of these three options:

Outstanding reminders: This is a list of all dated open reminders which are due on or before the current 
date. If you want to also display reminders that are not yet due, you can check the checkbox show future 
reminders. In the dropdown list Description, you can choose from all descriptions entered before. Selecting 
one of them will only show reminders with the selected description such as 'Followup appointment'.
Lists: This is a list of all un-dated open reminders for a specified list.
Closed reminders: This displays all completed records.

The button  in the leftmost position opens the patient the reminder belongs to.

On clicking the Complete button  for a reminder the following dialogue is shown:

Additional text can be entered in Comments. On clicking OK the reminder is closed and removed from the current 
view. From now on it can be viewed in the list of Closed reminders.

Configuring Actions (Administrators only)

In order to add or remove actions that can be used for new reminders, click on the Options button in the top-right 
of the Reminders window. This is available to administrator users only.
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A dialogue opens where all currently available actions are listed:

On clicking on New action, a dialogue opens where you can enter the action's name and choose various properties 
such as the user group that will see this action. Remember that actions that involve sending emails will only be 
shown for patients where an email address has been entered.
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After clicking OK, this new action will appear in the list of available actions.

To edit an action, select it from the list and click on Edit action. The same options as to when adding an action are 
available and additionally, there is an option to hide the action so that is will not be displayed for any patients. You 
can choose to show the action again later on by unticking the checkbox.

You can also delete an action permanently by selecting it and clicking on Delete action. Please note that this is 
not possible if the action has already been used for creating a reminder. In that case, the button Delete action will 
be disabled.
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10 Messages
 It is possible to send messages from one user to another which then will be displayed the next time that the user 
logs in.

This functionality can be useful if e.g. the receptionist wants to make sure a doctor calls a patient the next time he is 
available.

Sending a message

In order to send a message, go to the menu File -> Message to users.

The following dialogue opens: 

In the first row, you may select one or more users that will receive your message. In the bottom row, you may enter 
your message. Now click OK. The next time the selected users log in, they will see a notification described in the 
following section.

Reading messages

 When a user logs in and has received a message, there is a notification in the top-right corner with a mail symbol 
and a flashing text indicating the number of messages received.

Click on it. All unread messages are displayed, in this case just one:
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If you click OK right away, the message will remain unread and the notification will continue to be shown in the top-
right corner. If you've read the message and don't need it to be shown anymore, you can select mark as read and 
click OK. If there are several messages, you can mark each individually as read or keep it unread.

Filtering by department

When there are many users registered in astraia, it is often desirable to filter the list of users by department. A list of 
the departments which enables filtering is shown automatically when Options -> Administrator -> Logins are 
filtered by department is enabled. See also Options - Users (see page 177) to see how to add users to a department.

The dialogue for sending messages will then look as follows:
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11 Queries - Querying the Database

Click on the Queries button in the main menu. The program will display several prepared database queries. To run 
any query in the list, select it and then click on View results, Count results, Print results or Export results.

The View results window displays all the selected records in a table. From this view the respective patient records 
can be opened (via the Open button) in read-only mode to review the complete patient record - this is valid for any 
patient based queries. If you want to open the patient records from the result list in the editable mode you will need 
to activate the checkbox Results can be edited in the Window Edit SQL for each query. From this view, the results 
can also be counted and printed.

Counting the results will simply tell you how many rows the query returned, where the rows normally reflect the 
number of total examinations. The result will also count the number of patients and display the result in brackets. 
The number of rows will normally be higher than the number of patients, as patients will have multiple 
examinations.

Selecting Print results gives you the choice of whether to print the query directly or to preview the printout. 
Furthermore, you can select the format and sorting criteria.

The option Export results writes the results of the query to a file in Excel, .txt. or .cvs format.

You can filter your queries by the entry in the column Category. Select the query category you want to view from 
the combo box in the upper right corner (the current view shows All categories).
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Please note that all predefined queries only work properly with PostgreSQL and Sybase SQL Anywhere and might 
not be supported by MS SQL or Oracle.

11.1 Creating queries
Click on the field New query and choose the module (pregnancy - gynaecology- colposcopy - fetal 
echocardiography - breast screening) for which you want to create a query.

The Query builder will come up and display the familiar data-entry screens with the navigator on the left-hand 
side. Note that you can only exit the Query Builder in the Summary section of the navigator.

You can now select the fields which should be included in the query. A selected field will be presented with a red 
border (in the example below the fields Findings, CRL, NT and BPD are selected). You can set a condition for each 
chosen field. If a condition has been set for a field, this field will additionally be presented with a blue border (in the 
example below this is the field Findings). In order to set a condition, select the field, tick Set a condition and select 
the desired condition. If you click on the same field again, the red border will disappear. The condition is still set, 
however, the value will not be listed as a result anymore.
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This screenshot shows a part of the first trimester ultrasound screen in the upper half (selection screen). The lower 
half of the screenshot shows the options of the query builder.
In the selection screen, the field Findings was chosen (red border) to be implemented in the query. After selecting a 
field, the options of the query builder will become visible at the bottom of the screen. The fields Table and Column
display how the selected field is defined in the database (e.g. for the field Findings as Fetus.First_Trim_Diagnosis). 
The field Label specifies the column header for the data output of the query. The label field will automatically 
assume the name of the field in the data entry screen. However, you can also enter or edit the label manually.

Setting a condition:

The following list will give you an overview of the field types and the conditions you can set for them:

Field type Condition
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popup lists (see page 92) the field is not empty The output of this condition will display a list of 
all patients with an entry in the specified field 
and the entry made.

the field is empty The output will be a list of all patients with no 
entry made in this field.

the field is equal to: This condition will bring up a table with all the 
list elements of this field (see example in the 
screenshot above); you can select one or more 
list elements and the output will be a list of all 
patients with all the specified list elements.

text fields / helper lists (see 
page 94)

the field is not empty The output of this condition will display a list of 
all patients with an entry in the specified field 
and the entry made.

the field is empty The output will be a list of all patients with no 
entry made in this field.

the field is equal to: This condition will bring up the helper list and 
you can select the entry you want to search the 
database for; the output will be a list of all 
patients with the specified list element.

the field contains: As you can add free text to a helper list entry, you 
can also search for words or phrases you 
manually specify.

number fields / date delta value / centile delta values (z-score) or centiles can be included 
in the query for all number fields with an 
assigned chart that has valid data to calculate 
them

is empty The output will be a list of all patients with no 
entry made in this field.

is not empty The output of this condition will display a list of 
all patients with an entry in the specified field 
and the entry made.
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is equal to: A number field will be shown where you can 
specify a value; type in the value you want to 
search for and a list of all patients with this 
measurement will be displayed in the result.

is less than: You can specify a maximum value up to which 
you want to get the measurement data.

is greater than: You can also specify a minimum value from 
which you want to get the measurement data.

is less than or equal to: You can specify a maximum value (including the 
value) up to which you want to get the 
measurement data

is greater than or equal to: You can specify a minimum value (including the 
value) from which you want to get the 
measurement data.

is between: Specify a minimum and a maximum value; all 
measurements between these values will be 
displayed.

checkboxes the checkbox is ticked The result of this condition will be a list of all 
patients with a ticked checkbox in the specified 
field.

the checkbox is not ticked The result of this condition will be a list of all 
patients where 
the specified checkbox is not ticked.

In case you have set more than one condition, you will need to specify if both conditions need to be fulfilled (AND) 
or if only one needs to be fulfilled (OR). This is done in the saving screen (see below).
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Saving a query:

After you have chosen all the fields you want to include in your query, change the focus in the navigator to 
Summary. The following screen appears:

The field Description defines the name of the query. You should enter a detailed description of your query in order 
to remember the contents of your query later on. In order to sort your queries more easily please define a Category. 
To add a new Category write it manually in the field Category. For any continuing use, you will be able to select it 
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from the list. Adding a description in the Notes text field may also be helpful here.
Additionally, you can include the fields Case number, Examination number, Total examinations and/or Fetus 
number in your report by selecting the checkboxes.
Furthermore, you can include duplicate records (faster), search only for results in the current case type (e.g. 
Pregnancy) and remove duplicate results. In case you use the date range option, the following window will appear 
every time you execute the query:

11.2 Editing queries
The astraia system works with different databases, but all supported databases understand SQL (Structured Query 
Language). A query is simply a SQL statement. You can edit the queries in two ways

if you click on the field Edit query you can edit the query with the help of the data input screens, as 
described above, or
if you click on the field Edit SQL you can change the SQL statements (see page 149) directly. If you choose to 
edit the SQL statement directly, note that you cannot edit queries you have once edited with SQL with the 
graphical data input screens anymore.

You can also export and import queries between two astraia databases. Just click on the field Export query or 
Import query. The system will export your query as a .xml file to the folder you have specified.

You can copy a query with Copy query if you want to modify a query, but also want to keep the original contents.

If you want to delete a query, click on the field Delete query.

11.3 Finding images
By clicking on Find images, you can search for images using the image notes you assigned to them (see The Image 
Module (see page 109) -> Image / training notes). Select the tags you're interested in and choose whether they should 
be linked by a logical AND or OR. If you choose AND, only images will be shown to which all of the selected tags 
were assigned. If you choose OR, images with at least one of the selected tags are shown. Click on OK. If any images 
matched your search criteria, they will be shown in a new window that allows you to open, export or print them. 
This allows you to e.g. easily collect all images you want to use in a case study and export them to a special folder.
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11.4 Print results
If you want to print your results, the following window appears:

Portrait or Landscape defines the format, you can also specify by which value the results should be sorted. From 
here you can either print directly, preview the printout or cancel.
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11.5 Editing SQL queries
A query is simply an SQL (Structured Query Language) statement. An introduction to SQL is beyond the scope of this 
help file, but we will provide a short introduction. Statements take one of the following forms:

SELECT <field list> FROM <table list>
SELECT <field list> FROM <table list> WHERE <conditions> ORDER BY <order fields>
SELECT <field list> FROM <table list> WHERE <conditions>
SELECT <field list> FROM <table list> WHERE <conditions> GROUP BY <groups>
SELECT <field list> FROM <table list> WHERE <conditions> GROUP BY <groups> HAVING <group condition>
SELECT <field list> FROM <table list> WHERE <conditions> GROUP BY <groups> HAVING <group condition> 
ORDER BY <order fields>

The field list consists of one or more field names, such as Name, DOB, CRL. If these field names are unique they can 
be specified without qualification, but we usually prefix the field name with the appropriate table name, as in 
Patient.Name, Patient.DOB, Fetus.CRL. One important field name is ID, which exists in every table, so we must 
always qualify this field. The most useful is the patient ID number, Patient.ID.

The table list contains one or more table names. If more than one table is required we have to join the tables to get 
the right result. Our data tables follow a simple parent-child relationship. For example, a patient (Patient table) can 
have multiple episodes (Episode table). The episodes are joined to the correct patient record by a field called, 
unsurprisingly, Patient. This contains the relevant Patient.ID value. Therefore, we join these tables using one of:

Patient JOIN Episode ON Patient.Id=Episode.Patient, or
Patient LEFT OUTER JOIN Episode ON Patient.Id=Episode.Patient

The first join will produce one record (row in the query result) for each patient episode. However, if the patient has 
no episodes, there will be no result. This may be what we want, but in order to display patients without episodes as 
well, we would use the second form.

In a more complicated query, where we want fetal information in addition to patient data, we must join all the 
parent-child tables, as follows:

Patient LEFT OUTER JOIN Episode ON Patient.Id=Episode.Patient LEFT OUTER JOIN Exam ON 
Episode.Id=Exam.Episode LEFT OUTER JOIN Fetus ON Exam.Id=Fetus.Exam

In practice, most queries require similar table lists, and it is simple to copy an existing query and modify it.

Without a WHERE condition, all records in the database will be returned.

This is how such a query could look like:
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If you check Results can be edited, you can open patients and examinations directly from the query results window 
and edit your data.
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12 Diary

To open the diary, click on the field Diary on the main screen. The diary allows you to manage appointments for 
different examination and procedure rooms. You can define individual setups like intervals for examinations and 
breaks for every location. The diary consists of a toolbar at the top and a survey of locations in the main part.

By pressing the button   you can change the presentation of the rooms (or clinics) to a single view (only 

one location displayed).  brings you back to the survey view.

By clicking on the empty space between the name of the scan room and the first time of the day, you can write a 
note for that day.
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12.1 Choose a date
You can choose a date in two different ways:

choose a day with the help of the calendar:

Click on the button calendar  (Alt + C) and a window with the current month will be displayed. If 
you want to change the month, choose another month from the popup list. You can change the year with the 
up-and down-arrow buttons or just type it in. Click on the day in the calendar where you want to change the 
focus to, and the appointments for this day will be displayed, either in the survey or the single view, 
depending on your previous settings.
with the help of the browse symbols:

Previous week, browse back one week

Previous day, browse back one day

Next day, browse forward one day

Next week, browse forward one week

Using these buttons, you can easily book appointments within the following days / weeks. The symbol 

Today  brings you back to today's appointments.

12.2 Manage appointments
You can book, change, search for or delete appointments in the day survey.

12.2.1 Book an appointment
To book an appointment for a selected time, click on the appropriate time field. The window Appointment comes 
up. The first line shows the date, the time and the duration of the appointment according to your selection. It is 
possible to edit the time and duration of the appointment manually.

To book an appointment, you can:
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enter a patient manually (the patient is not yet booked in the database)

or

search for a patient with the help of the patient list (see page 24). Click on the button Search  next 
to the field Patient ID. The familiar patient list from the patient lookup appears. Here you can search for a 
patient by patient ID or patient name. If you know the patient ID you can also enter the ID in the field Patient 
ID directly and the patient data will be transferred automatically.
If you choose a patient from the patient list, the fields will be automatically filled with the data from the 
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database. These patient data cannot be edited in this window.

You can manually add an Indication, the gestational age at the appointment will be filled in if you have 
already calculated it at any time of the current pregnancy. Additionally, you can mark the Appointment 
Type with a colour from the popup list (if you want to add an appointment type to the list, see diary setup 
below for details).

Book/open patient: In case a new patient arrives you can add her data to the database from the 
appointment screen. This option is only available if the patient has not been selected from the 
patient lookup nor by Id. In that case, the option Book patient is replaced with the option Open 
patient.
Letter: A letter to the patient with the appointment information can be printed from this screen. This 
letter can be customized for you, please contact our technical support (see page 260).
Email: An e-mail can be sent to the patient, to inform him about the appointment. After clicking this 
button a dialogue lets you optionally define and append a calendar-event (iCal-attachment) to the e-
mail. With this, the patient can easily add the event including all comments to his personal calendar. 
(This button is only enabled if an e-mail address is entered in the patients' contact details and if you 
have a license for sending emails. Please see Options - Administrator (see page 167) for more 
information.)
Arrived: If you click on the button Arrived, the background colour of the patient in the appointment 
list will change to a darker blue and the field Arrived will be filled out. The field Seen will be filled out 
as soon as the patient is opened from the diary
Missed: If a patient has missed an appointment it can be indicated by selecting the checkbox Missed
- the colour of the appointment will change to red and the appointment status cannot be set to 
Arrived anymore. By opening the patient from a missed appointment, the colour will switch to a 
darker blue and the field Seen will be filled in, however, the status will still be Missed.
Worklist (if licensed): see below information.
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You can also set an appointment for a patient from any patient screen if the case is a pregnancy: If you have 
an open examination of the patient, select appointment from the menu data (Alt + P) and the following 
window will be available.

The same feature is available for gynaecological cases. Select the appointment from the menu data (Alt + 
P) and choose a date from the drop-down list.

   

12.2.2 Change an appointment
If you want to move the appointment of a patient, you can do the following:

To change the time or the location within the same day, you can drag and drop the appointment from one 
time slot to another. Just click on the respective appointment box with the left mouse button and drag it to 
the new time slot. Changing the location like this is supported in the survey view only.

To move an appointment to another day you need to open the calendar (using this button: ). You 
can now drag the appointment onto the calendar and drop it on another date. Note, that the time of the 
appointment will be changed: it will be moved to the first free slot on the target day.
You can also change the time within the same day, by clicking on the appointment, thus opening the 
window Appointment. Enter the new time in the field Time.
To change the duration of an appointment, click on the appointment (to open the window Appointment) 
and edit the field Duration.
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12.2.3 Next free appointment

Pressing  will display a window where you can see the next free appointments. You can set conditions for 
the time, date and location of the next free appointment. Here you can also enter the last menstrual period and 
search for the next free appointment at a certain gestational week.
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12.2.4 Find appointment
You can search for an appointment by patient name, in addition, you can define a start date for your search:
Click on the button Search (Alt + N) in the toolbar of the diary. The window Find appointment will appear.

Here you can enter the name of the patient in the field Search (it is enough to enter the first letters of the name). 
The field On or after defines the start date of your search (optional). If you select exact search the search will only 
look for the exact search input (e.g. if you enter 'Te' and select exact search, patients with the name 'Test' will not 
be displayed). If you check the option Show only missed appointments, a list of all the patient's appointments 
with the status missed will be displayed.

If your search has been successful, a list with the patient's name, location, date and time of the appointment, 
hospital number and indication will be displayed. The list can be sorted by any of the given columns, just click on 
the column heading. Selecting a patient and pressing OK, will bring you to the day with that patient's appointment.

12.2.5 Delete an appointment
If you want to delete an appointment, click on the  in the top right corner of the appointment in the day survey. 
Confirm the security question 'Do you really want to delete this appointment?' with Yes.

12.3 Add Notes
Click on the first field of each column to add a note. A new window will open, allowing you to enter your note.
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12.4 Worklist (if licensed)
If the patient has already been booked into the astraia database, you can send patient data to a connected 
ultrasound machine by clicking on this button.

Important: the Worklist feature for the Diary is only available if the hospital number is chosen as the Type of patient 
ID.

You can choose to either put individual patients or all patients of a day and room on the Worklist.

To put individual patients on the Worklist click the Worklist button on the individual appointment window. To send 
the full patient list of one location for one complete day to the Worklist click the Worklist button on top of the day 
list.

More information about the Worklist functionality and configuration instructions can be found in Options - Imaging/
Worklist (see page 194) and Options - Workstation (see page 211)).

12.5 Setup

The Diary can be customized in the section Diary Setup  (Alt + S). In this section, you can define the 
number and names of locations and the duration of examination intervals and breaks individually for each day of 
the week. Also, you can define appointment types (e.g. routine scan, NT screening, etc.) and mark them with 
different colours.

Diary setup - locations

add/delete locations: Add or delete locations, with the  or  symbols on top of the table Locations.
change name of a location: Double click in the name field, erase the old name and type in a new one.
visibility of locations in the day survey:
If the checkbox visible is active for a location (e.g. Scan room 1, 2 and 3), the room will be displayed in the 
day survey. If the checkbox is not ticked (e.g. Fetal Echocardiography, Invasive Procedures), the room is not 
displayed.
This setting is specific for each machine. In a networked installation you can hide specific rooms on specific 
computers (e.g. only display Scan room 1 and hide the other rooms on the computer in Scan room 1).
Intervals and duration of examination periods:
You can define examination intervals for every location and every day of the week individually (just click on 
the weekday in the middle section):

Highlight the location and the day you want to define an interval for. On the right-hand side of the 
window, the setup for the selected location and day are displayed (e.g. Scan room 1 - Wednesday). At 
the beginning of your work with astraia, standard intervals are defined; you can edit these according 
to the requirements of your clinic.
To add an examination interval, click on the symbol in the title bar, an interval is added before the 
already existing time intervals.
To add an examination interval between already existing intervals, click on the symbol in the row 
after which you want to add the interval.
The Duration of the interval defines the length of an average examination unit. You can change the 
duration of an appointment manually to a shorter or longer interval.
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If you want to change the Start, End or Duration of the interval, double click in the field and enter the 
times manually.

Diary setup - appointment type

When booking a patient appointment you can mark the appointment type. The appointment will be marked with a 
coloured flag in the survey. The window Appointment offers a popup list with predefined appointment types. You 
can define these appointment types in the diary setup - appointment type.

Add/delete appointment types:
With the help of the  or  symbols on top of the list of appointment types you can add  or delete 
appointment types:

click on the  symbol on top of the table of appointment types and a row will be added to the table.
define a name for the new appointment type and add a description.
choose a colour from the colour table by clicking on the colour field. A popup window appears, from which 
you can select a new colour. 
confirm your entries with OK and the new appointment type will be added to the popup list in the window 
appointment.
the area Recent shows your individual colour selections. You can easily go back to previously selected 
colours.
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Diary Setup - Appointment configuration

In this section of the diary, you can configure the appointments - this section is only available for administrators.

You can choose which fields are shown on the booking screen.

 

You can also change the colour scheme of the appointment status by clicking on the sample appointments and 
choosing a colour.
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 Here the field in the Appointment window which will have the initial focus can be selected.

  

In the last group, it can be configured whether or not snapshots of appointments and printouts should be saved in 
the Diary Audit Trail.
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12.6 Diary Audit Trail
This button is only visible to users who have the right to view the Audit Trail (see page 240). The Diary Audit Trail works 
like the Audit Trail, only here all changes that were made in the Diary are logged such as adding or modifying 
appointments and booking patients from the Diary window.

 

 There are six different types of Diary Audit Trail entries:

Archived: These are changes that were made to an appointment. This includes adding a new appointment, 
but also events such as when a patient has arrived or missed an appointment.
Printout: Printed letters or sent emails are logged under this category.
Query: Whenever the Find appointment function was used, an entry is created which shows the resulting 
search query.
View: This type of entry is created when an appointment is viewed.
Deleted: When an appointment has been deleted, this entry is added to the Diary Audit Trail.
Settings: This indicates that diary settings were changed.

You can choose whether or not snapshots of the appointments and printouts should be saved in the Diary Setup as 
described above.

Like in the standard Audit Trail, various actions can be performed on the Diary Audit Trail entries such as 
comparing different changes or opening the corresponding patient directly from the Diary Audit Trail entry using 
the buttons below the entry list. Their functionalities are the same as the ones described in Audit Trail (see page 240). 
As it is possible to create appointments for patients that have not been booked yet, it is important to note that the 
patient search function, which is available by clicking on Patient, is only available for booked patients (i.e. the 
patients that have an entry in the PID column).
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13 Options

Only admin users can change all program options found in the section Options on the main screen. Users that do 
not belong to the Admin group will only see a small subset of the following tabs. Note: The tabs DICOM and Lab 
interface are only visible if your license includes the astraia Image Viewer and a lab interface.

Appearance (see page 164): Here you can change the language settings, the user interface, the colour scheme 
and some minor appearance settings.
Administrator (see page 167): This section contains options that can only be changed by the admin user such as 
the database configuration and archive and report options. You can also change the directory for the backup 
of your database, configure your email and import/export your astraia settings.
Users (see page 177): With the user editor you can create new users, edit users and set group memberships.
Groups (see page 179): In the group editor, you can create and edit user groups. You can also display all users 
who belong to certain groups.
Charts (see page 183): Using the chart selector you can select the different charts (references) used in the 
program, change the settings for growth bars and import your own charts. Please note that the standard 
deviation can only be displayed for publications that account for the normal distribution.
Printouts (see page 185): Here you can set the report font type and font size and define the margins for the 
printout. You can also change the settings for saving reports as PDF files and for sending them via fax.
FMF Risks (see page 190): In this screen, you can import your FMF license and adjust the risk display according 
to your preferences.
DICOM (see page 194): Here you can change your settings for the Image, Worklist and Measurement servers. 
This tab is available with any DICOM licenses.
Lab interface (see page 199): This tab allows you to set up interfaces to different types of analyzers (e.g. Brahms 
Kryptor, Perkin-Elmer). This tab is only available if a Lab interface is licensed.
Patient data (see page 207): You can set up an interface to a hospital interface on this screen. Furthermore, you 
can customize your patient lookup screen.
Workstation (see page 211): The host system (e.g. Protos), measurement data transfer, DICOM worklist (e.g. 
Astraia Worklist Server, ALI Worklist) and auto image import can be set up here as far as they are licensed. 
Furthermore, you can change the settings for the 4D viewers and the memory reserved for Java.
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13.1 Options - Appearance

The language setting affects three program areas - the presentation of data screens, the language used for system 
messages/dialogues and the presentation of dates and numbers. In all cases, if no equivalent language support is 
found for an item, English will be substituted. If you have to change the language frequently (e.g. for different 
patients), have a look at the Language selector (see page 176) that allows quick language changes. Important: In 
astraia the order of the day, month and year in date depend on the language that is selected. Therefore, all 
users must be aware of astraia's default date format in every language they use. Please take a look at the list of 
default date formats in the download section of the astraia website: www.members.astraia.com/en/service/
login.html or contact us at support@astraia.com.

You can also change the user interface. In case you select the 'default' user interface, astraia will look like the local 
operating system (Windows, Mac, Linux).

In order to change the colour settings, you can choose from different colour schemes: 'Default', 'astraia Blue', 
astraia Dark, 'Chinese', 'Japanese', 'Matte Blue', and 'Steel'. The 'Chinese' and 'Japanese' colour setting should be 
used if you want to run astraia in Chinese or Japanese respectively, the 'Default' scheme will use the colour settings 
of the operating system.
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Every user can select their own colour scheme, however, only Admin users may edit the colour schemes or create 
new ones.

We recommend the Metal user interface in combination with the Matte Blue or the Kunststoff 
with astraia Dark (optimised for darker environments) colour scheme.


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The following window appears after pressing Edit...:

To add a new colour scheme, select New in the File menu or press the shortcut Ctrl + N. In the following window, 
enter a name for the new theme. This name will appear in the list Current theme where you can select the colour 
scheme which you want to edit.

After having selected the colour scheme, you can choose your primary- and secondary colour combination. You 
should use brighter colours with ascending numbers (for example, Primary3 should be brighter than Primary2).

To edit the font style click on the field of one of the four font types (Control font, System font, ...) and the window 
Select font comes up. Here you can select the font, the font style (bold or italic) and the font size. A sample for your 
current settings will be displayed. In order to leave the colour editing window, press the Exit button. You will then 
be asked if you want to save your changes.

The font size can be set to minus or plus a given factor - you can choose from Automatic, -3, -2, -1, 0, +1 or +2. 0 will 
not change the font size (the font size is determined in the colour settings), +1 will display all texts one size larger 
than the original settings. The settings will be applied as soon as you exit the options menu by clicking on OK. The 
setting Automatic will adjust the font according to various factors, e.g. the screen resolution. Therefore, we 
recommend the automatic setting.

You can choose whether the entries in the Navigator should have a shadow using the checkbox Display shadow in 
Navigator.

If your computer is connected to the internet, you can enable the option Notify me about new astraia versions 
when starting the program. astraia will then compare your current version with the current version on our website 
www.nexus-astraia.com and notify you, it will not automatically update your version or download any data.
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If the option Show email data protection warning on send is enabled, each time an email is sent from within 
astraia, the user will be presented with a warning message. It asks them to confirm that the email configuration 
complies with the local security policy and the country's legal requirements.

13.2 Options - Administrator
Only admin users can change the options in the Administrator section. Normally these options do not need to be 
changed after the installation.

 

Database options:

By clicking on the different tabs you can set up three different database connections, one for the real 
patients (Production), one for training and one for testing purposes. By renaming them, you can also use 
them for different purposes. You will need to select a database on every astraia startup if you have 
configured more than one database.
Display name: If you do not want the name production, training or test displayed, you can enter a different 
name here.
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Type: Here you can choose your database type - astraia supports the Sybase Adaptive Server Anywhere 
JDBC, the Oracle JDBC thin client, the MS SQL Server JDTS, the Java DB network and standalone and 
PostgreSQL.
URL: Normally the default options of the URL are correct, you will only need to replace the localhost with the 
server's computer name or IP-address and eventually modify the port (e.g. the default Sybase URL is 
'jdbc:sybase:Tds:localhost:2638', if your server is called AstraiaServer and the database port 2639 instead of 
2638 the URL has to look like this: 'jdbc:sybase:Tds:AstraiaServer:2639'). Nevertheless, the URL for the 
database is vendor-specific; refer to the vendor product information for details. The essence of JDBC is that 
the database can exist on any server, provided that the server is accessible via an Internet or intranet 
connection. Most vendors provide URL syntax modifiers that control various database features.
The user name and password are required to access the database. The default settings apply only to the 
Sybase database but in some cases, you will need to modify them as well.
Pressing the Test... button provides confirmation that a connection to the specified database exists, but 
does not guarantee that an astraia database is provided there (it just checks if any database is available on 
the specified computer name and port). If the connection cannot be established please check your settings 
or contact our Technical Support (see page 260).

Validation:

Validation for examinations allows a supervisor to validate an exam in the patient record's summary. This feature 
can be enabled, depending on the examination date or disabled.

In addition, you can choose whether a reminder should be displayed on closing patients (current exam only), on 
closing patients (all non-validated exams) or on exiting the program or whether no reminder at all should be 
displayed. Selecting on closing patients (all non-validated exams) will unlock the further menu enable quick 
validation. Only users with permission to validate reports will see these reminders.

To learn more about validation, see The Validation Process (see page 83).
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Summary screen layout:

This option enables you to change the order in which multiple examinations are displayed in the summary screen. If 
you choose Date order, the latest examination will be shown on the right side of the summary table, when choosing 
Reverse date order it is leftmost. To allow users to change this setting directly in the summary screen, tick the 
option Users may change exam order in summary screen.

If you enable the checkbox Users may change exam order in summary screen, a checkbox will appear in the patient 
Summary. With this checkbox, you can switch the order of the examinations.

  becomes   

 

Report options:

The admin window contains the path to the report files. You can normally find the report files in the astraia
program directory (usually C:\Program Files\Astraia\Obgyn\reports). This folder will be used if it only says 'reports'. 
If you want to use another folder, you will need to enter the full path (e.g. C:\Documents and Settings\User\My 
Documents\reports).

Backup option:

The automatic backup option is only available in the options menu if you have a licensed standalone installation. It 
will only work with a Sybase database.
In the field Backup directory, you can select the directory or the hard disk where you want to save a backup of the 
database (see page 244).

You can also enter the path by using the ... button.



astraia user manual - 29.x

Published on: 15-Jan-2024
NEXUS / ASTRAIA GmbH

Options- Page 170 of 263

Storage of external documents:

It is possible to store external documents (such as patient's reports from other doctors) in two different ways. If 
store a link to the document file is selected, astraia will only save where this file is stored and can be opened from 
- if the file is moved or deleted, you won't have access to it any longer. The other option is to store the document in 
the database, then the file is copied into the astraia database and that copy will remain available in the database 
even if the original file is moved, but the size of your database could grow very fast. Please note that this is a 
convenience feature and not meant to replace a safe data storage solution for the original data.

Info pop-up after login:

Here you can configure a message which will be shown to all users on every login. This can be used to remind users 
of certain regulations regarding privacy or security.

Just click on Configure... and a window prompting for a text input will appear. Simply type the text to be shown 
into the window and click on OK. Please note that only plain text is supported.

You can also import a message from an existing file by clicking on Import and selecting the file. Only plain text files 
are supported.
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Please note: The message you configure here will be shown to everybody on each login. If you wish to notify your 
users of something only once or not all, but only a subset of users, Messages (see page 139) might be the more 
appropriate feature.

Filter logins by department:

You should only activate this option if you have created more than one department. This option is active as soon as 
astraia is restarted. In order to work properly, you will need to assign the departments to your users in Options - 
Users (see page 177). The assignment can be done in the user editor:

Upon each login, an additional drop-down menu for the department will be available. Users who are assigned to a 
certain department are only visible if that department has been selected, all users without assignment can be found 
in 'No department'.
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Login/Logout policies:

Automatic logout: The admin can also set a time after which idle users will be automatically logged out. Any 
opened patient records will be saved at the time the user is logged out. If the settings are the same as in the 
following image, the automatic logout option is deactivated.

After you set a time for the automatic logout the checkbox and shutdown appears. If you activate this checkbox, 
astraia will quit after every automatic logout.

Login on one machine only: Users can be valid for login at one machine only. With this policy, the user is forced to 
log out of astraia when he moves to another room. If this checkbox is not ticked the same user can log in on 
multiple astraia clients. By default, the checkbox is not ticked.

Please go to the Astraia Service Manager - License Server Configuration on your astraia server installation to 
configure this setting.

Export and Import settings: 

It is possible to export and import individual settings which have been adjusted for a certain installation.
All these settings can be imported/exported:
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If you export the Language changes, all label-changes which have been done in the Screen 
Configuration (see page 213) will be exported. Upon importing the language settings, the current language 
settings will be overwritten.
Exporting the Screen settings includes the Screen Configuration (see page 213), e.g. the required and the 
hidden fields and the required and the hidden screens. Upon importing the screen settings, the current 
screen settings will be replaced.
The List entries include all Popup lists as well as all text fields with lists (see The Record Screen (see page 88)). 
If you import them, they will be added to the existing list entries.
If you export the SQL queries, all database queries (see page 141) will be exported and upon importing them, 
all old database queries will be replaced.
The Diary configuration will export all Diary (see page 151) settings. The old configuration will be replaced.
Exporting and importing the Reporter texts will replace all pre-defined text items in the reporter (see page 
102).
The Users and groups settings will transfer all users (see page 177) and groups (see page 179). The old settings 
will be discarded.
If you export and import the Chart settings, all selections in Options - Charts (see page 183) will be replaced.
If you export the Referring doctors and import them on another installation, these referring doctors will be 
added to the already existing list of referring doctors.
Upon exporting and importing Diagnoses/Procedures, the list of already existing diagnoses and procedures 
will be extended by the new ones.
Exporting User-defined fields allows you to transfer all self-defined database fields in the Screen 
Configuration (see page 213). The imported fields will be added to the already existing self-defined fields.
All Properties which are set in Help -> About -> Properties can be exported and imported. These properties 
include many default options such as colour scheme settings, but possibly existing less common 
modifications such as user-defined date formats are included as well.
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After having decided which settings to export, you can define a path and name for the file which will be created. The 
exported settings will be saved as a .zip file which can be transferred. This .zip file contains several .xml files, one for 
each of the settings described above. You can also send separate .xml files.

In order to import settings, define the path of the .zip or .xml file which you want to import. In the following screen, 
you can choose which settings to import. Fields with grey boxes are not available (this means these settings were 
not exported), all black fields can be selected and imported.

Attention: Settings may only be imported into a new database without patient data in it. Please also verify that 
importing a settings file resulted in the settings you intended.

Email settings 

In case you want to send your reports via email (see Printing Reports (see page 129)) or appointment reminders from 
the Diary to your patients (see Diary (see page 151)), your computer has to be connected to the internet and you will 
need to configure your email settings here.

However, please note that the email feature is disabled unless activated by a license. The reason is that many 
countries impose strict rules on the exchange of patient data (e. g. the European Union with the GDPR). You may use 
the email functionality on your own responsibility. Please contact sales@astraia.com for a free license.

In the following window you can set up your outgoing email (please contact your provider for all information 
necessary).
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The Default sender name and Default email address will be entered automatically for each outgoing email. If you 
have entered email addresses for different users in Options - Users (see page 177) you can also send emails with the 
user name as sender name and the entered email address as the sender's email address.

Important: Please check that your astraia and email server configuration (e.g. encryption) comply with your 
security policy and that of your country.
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Language settings 

For astraia users who work in a multilingual environment and therefore have to change the language frequently, 
there is a handy tool that allows a quick change of the astraia language setting from all screens. This Language 
selector has to be configured here by clicking Select languages. In the subsequent pop-up window, all favoured 
languages can be selected. Hence there is a small icon in the upper right corner of astraia, that shows the currently 
used language setting. By clicking on it, you can activate one of the previously selected languages instantly.

User settings: 

With this option the administrator can define some parameters to increase password security:

First, a period can be set up, after which a user password expires and has to be changed. The user will then 
be notified that his password has expired and is prompted to define a new password.
To ensure, that the user won't reuse an old password, this can be prohibited by entering the number of last 
passwords, whose reuse is avoided.
Furthermore, unused user accounts can be disabled or deleted after a number of days, which are defined 
here.
You can choose that you don't want to allow passwords to contain the user's username or full name.
At last, a level of password strength can be defined, that a new password must fulfil to be accepted by the 
astraia program. There are 6 strength levels from No strength requirements (which disables this feature) to 
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Very strong. Password strength depends on the number of characters and can be improved by the use of 
numbers, symbols and upper and lower case characters.

13.3 Options - Users
We strongly recommend that each user, whether on a networked database or a standalone program, should have 
their own user name and password. If this is done correctly, the program's archive and audit trail (see page 240) will 
accurately record any changes and the user who made these changes.

Each user belongs to a group, which determines the user's privileges.

These are the default groups:

Admin
Clerical
Clinical Admin
Consultants
Doctor
Guest
Lab
Operator

As an admin user, you can edit these groups and their access rights, delete groups and create new ones and in 
Options - Groups (see page 179).
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Adding and changing user information is only available to admin users. Each user has a login name, a password 
(must have at least 5 characters), a group, a department (only if you have different departments), an email address 
and a comment field, where e.g. the user's full name can be entered. In order to create a new user, you will need to 
enter at least the user name, the password and the group. After creating a user, the user name cannot be changed 
anymore.

In order to refer a User to a department, just activate the check-boxes. Have a look at Examination and 
Ultrasound (see page 33), if you want to know, how to add new departments.

Any admin user can suspend users and undo the suspension and change any user's password. A user without 
permission to edit or create users can only change his own password.

Furthermore, only admin users may delete other users.

Changing passwords:
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To maintain the security of the database, the program administrator should define an interval after which the 
passwords have to be changed by every user (see Options - Administrator (see page 167)). Each user who is logged in 
can also change his own password without reentering his old password.
 Passwords are stored in the database, securely encrypted by a one-way algorithm: there is no way to discover a 
password. If users forget their passwords, any admin user can change these passwords without reentering the old 
password. 

Communication between users

 astraia also offers basic communication between users allowing users to send messages to one or more other 
users. See Messages (see page 139) for further information.

13.4 Options - Groups
In section Groups, you can configure different user levels. Each user must be a member of one group. You can edit, 
rename and delete the supplied groups or create new groups. The predefined groups are admin, clerical, clinical 
admin, consultant, doctor, guest, lab and operator. These groups are only proposals, you can change them by 
selecting a group and then pressing Edit (Alt + E). The permissions will be described in this chapter.

The default groups have the following permissions:

Admin: All permissions, no restrictions.

Clinical Admin:

Permissions:

Patient management: view patients, book patients, change patient data, import and export patients and 
validate exams. Is also allowed to export images. May delete patients and examinations.
Data entry: modify helper lists and popup lists, change reporter texts and variables and configure screen 
settings.
Diary: edit and create diary appointments, create diary appointments at restricted times and change the 
diary settings.
Options: change the colour themes, edit the chart settings, edit and create users, and change the FMF 
Options.
Further permissions: run queries, run the first trimester audit, view the audit trail, unlock locked records, 
and create PDF reports.

Restrictions:
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Cannot change strictly administrative options like database settings.
Cannot delete lookup records nor modify those records.

Consultant:

Permissions:

Patient management: view patients, book patients, change patient data, import and export patients.
Data entry: modify helper lists and change reporter variables.
Diary: edit and create diary appointments.
Further permissions: run queries, run the first trimester audit and view the audit trail, edit the chart settings, 
and create PDF reports.

Doctor:

Permissions:

Patient management: view patients, book patients, change patient data, import and export patients. Is also 
allowed to export images.
Data entry: modify helper lists and popup lists and change reporter texts.
Options: change colour themes.

Operator:

Permissions:

Patient management: view patients, book patients, change patient data and export patients.
Data entry: modify helper lists and change reporter texts.

Lab:

Permissions:

Patient management: view patients, change patient data and export patients.
Data entry: modify helper lists and popup list
Further permissions: run queries, run the first trimester audit

Clerical:

Permissions:

Patient management: view patients, book patients, change patient data and export patients.
Data entry: modify helper lists
Diary: edit and create diary appointments.

Secretary:

Permissions:

Patient management: view patients and book patients, not able to access any examination data.
Diary: edit and create diary appointments.

Guest: May only view patients.

Click on the field New Group (Alt + N) and choose a name for the group if you want to define your own group. For 
each group, there is a list of permissions and restrictions. As soon as all settings are finished and the new group has 
been created, the users (see page 177) can be added. Each admin can change the permissions of any group at any time 
and add or delete users from it. Changes take effect the next time a user logs in to the program.
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Patient management:

book patients: create a new patient (see Selecting a Patient Record (see page 24)). If a group should be able to 
book patients, they also need permission to change patient data in order to be able to save the patient 
record.
change patient data: edit patient and examination data (see The Record Screen (see page 88))
can not view examination data: makes the section examination and all sub-sections unavailable (see 
Navigation and Summary (see page 75)). The user will also not be able to print examination reports for patients 
or open Images using the ImageViewer.
can not export patient data: restriction which prohibits patient data export. All users without this 
restriction may export patient data (see Options - Administrator (see page 167) and The Menu Bar (see page 230))
delete examinations: see The Menu Bar (see page 230)
delete patients: see The Menu Bar (see page 230)
validate exams: permission to access the Validation Process (see page 83)
export images: export DICOM ultrasound images to images files on your computer in the Image module (see 
page 109))
create PDF reports: permission to print reports as PDF (see Printing Reports (see page 129))

Data entry:

modify helper lists: permission to edit Helper Lists (see page 94)
modify popup lists: permission to edit Popup Lists (see page 92)
change reporter texts: permission to create new pre-defined entries and modify already existing entries in 
the Reporter (see page 102)
change reporter variables: permission to create new variables or edit existing ones in the Reporter (see page 
102)
can delete lookup records: permission to delete entries from lookup tables (see page 98)
can modify all lookup records: permission to modify all lookup tables (see page 98) including diagnosis and 
procedure codes
configure screen settings: this permission allows access to the Screen Configuration  (see page 213)

Diary (see Diary (see page 151)):

edit and create diary appointments
create diary appointments at restricted times
change the diary settings

Options:

change colour themes: possibility to change colour themes in Options - Appearance (see page 164)
edit the chart settings: the tab Options - Charts (see page 183) will be available
edit and create users: permission to create new users and edit existing users in Options - Users (see page 177)
access FMF Options: permission to change all options in  Options - FMF Risks (see page 190). Users without this 
permission can still import their FMF license

Further permissions:

run queries (see page 141)
run the first trimester audit (see page 224)
view the Audit Trail (see page 240): permission to access Audit Trail and Database Archive (see page 240)
unlock locked records: if a patient is accessed in a network, this patient is locked for all other users on 
different computers - they can only open the patient record as read-only. With this permission, it is possible 
to unlock this patient record from The Menu Bar (see page 230) (sometimes necessary if the network 
connection has been interrupted and the patient record is permanently locked)
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In case you want to delete a group, you will first need to reassign each user in this group to another group.

13.5 Options - Charts
In the charts dialogue, you can select which charts and which dating methods you would like to use, each in their 
respective tab.

Charts

The chart selection tool displays a list of all charts in the database; each chart has a checkbox, a chart name, a note 
and the journal reference. You can add personal comments in the column Note by double-clicking on the field.

The list can be sorted by clicking on any of the column headers. An arrow will indicate the sort direction (see 
column Chart). Any chart can be selected by clicking on its checkbox. All other charts with the same name will be 
deselected. Ticked checkboxes tell you, that this chart is used as a reference.

To help you choose a graph, the option Display will show the graph that is currently highlighted (not ticked).
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Furthermore, you can decide whether the growth bars next to the measurements should represent the standard 
deviation (2 SDs) or the deviation cited in the graph (usually given in percentiles).

You can also activate the tooltips: either the z-score (the exact standard deviation) or the exact centile will be 
displayed if you move your mouse cursor over the growth bar. The z-score is only displayed if the chart is based on 
normalized data.

 

It is also possible to import charts in the .xml format via the import a chart button. These custom charts can be 
prepared by astraia upon request.

Dating
For each of the presented values, you can choose whether to use the default growth chart or an alternative dating 
method (where available). In the following screenshot, you can see the default settings with all but the CRL 
measurements using the growth chart.

A full list of all chart references can be found in the Help pages under Chart references.
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13.6 Options - Printouts

All settings for printing reports, sending them by fax or saving them as PDFs can be done here in Options - Printouts. 
All the settings which cannot be done here can be found in the reporter and printing module (see page 129).

There are two basic settings for the font: the font type and the font size. The font size can be separately adjusted 
for printing out reports, e.g. examinations, and for printing out queries.

If your letterhead has been adjusted to your needs, the font settings in this section normally won't influence the 
design.

You can adjust the format of your printouts on the one hand by changing the paper size ('A4', the American format 
'Letter', 'Legal', 'A5', 'A6' and 'Custom') on the other hand by adjusting the margins. Please note that you can 
choose between either inches or centimetres as units.
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When selecting 'Custom' from the list Paper size, you can manually input the size of your paper. This is especially 
useful for printing labels.

Furthermore, you can select the faster graph printing which will disable the colour gradient in the printed graphs 
and therefore prints quicker and save toner or ink. You can justify the report labels on the left or/and add a colon
to printout labels. Here are two printouts, one where the text is justified in the centre and there are no colons, and 
one with a justification on the left with colons.

You can also use the Windows print dialogue instead of the standard java print dialogue and cache loaded 
reports in memory (activated by default). The second option will speed up the printing process a little bit. 
However, you will need to restart astraia every time you make a change to your reports folder (which should not 
happen very often). When astraia sends you an individually adjusted header, footer or report, you will need to shut 
down astraia on every computer before you can import these new files in case this option is activated.

To change the colour of headings click on the field you see in the image below and choose or create your favourite 
colour.



astraia user manual - 29.x

Published on: 15-Jan-2024
NEXUS / ASTRAIA GmbH

Options- Page 187 of 263

Fax:

If you want to send your reports directly by fax, you will need to set up the fax connection here. You have two 
options: using a direct connection to the fax via a serial cable or using a RightFax Server.

Fax:

You will need to change these settings on the workstation which is directly connected to the fax machine. The fax 
needs to be connected to the workstation via a serial cable. You will then need to select the COM port, the class of 
the fax and your identification.

RightFax Server:

In this dialogue, you only need to select the location of your RightFax Server and press OK.

PDF:

In case you want to archive your reports as PDF files you can modify some settings here as well:
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The default name of the PDF file can contain different database fields as well as any valid characters. These are the 
variables for the different fields (you can also display the list by clicking on the ?):

%PID% = astraia patient ID,

%HIS% = hospital number,

%EXAM% = exam ID,

%EXAMDATE% = exam date,

%EXAMTIME% = exam time,

%DEPT% = department,

%PNAME% = patient name,

%PONAMES% = patient other name,

%DATE% = current date,

%TIME% = current time,

%REP% = report name,

%USERNAME% = current logged-in user name,

%ACCESSION% = Accession Number.

By combining these variables you can set up an automatic archiving process that will give you a very accurate 
description of your files.

For example:
'%HIS%_%PNAME%.%PONAMES%_%EXAMDATE%'
will result in the file
'Hospitalnumber_PatientName.PatientOtherName_ExamDate.pdf'

If you select the option prompt for PDF file name, a window with the automatically created PDF file name and path 
will open every time you want to save a report as a PDF file. The path will lead to the same folder where you saved 
your last PDF file (the path which you can enter in the PDF options will be ignored). You can then manually modify 
the path and the file name.

In case you want to save the PDF files automatically, you will need to deselect prompt for PDF file name and enter 
a valid path in the setup. Make sure to design your variables for the file name in such a way, that no PDF files with a 
similar name will be created (the best option to do this is to include %TIME% variable).

You can also automatically create a PDF file each time you print out a report. Just enable Create PDF 
automatically when printing, enter a valid path and deselect prompt for PDF file name.
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If you want to send PDF files as e-mail attachments you can select the option Use the file name when sending PDF 
printouts by e-mail (activated by default). This will result in the attached PDF file name using the specified file 
name as opposed to a random file numbering.

E-mail:

For e-mailing patient reports, the standard subject for the e-mail can be defined here. The e-mail subject can 
contain any valid characters plus any of the above-listed variables (click on ? to display the list).

For example:

 
will result in the subject
'Astraia Patient Report 1234 - Examination 2021-12-13'
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13.7 Options - FMF Risks

The tab FMF Risks is only important if you want to calculate the risk for chromosomal abnormalities and pregnancy 
complications. In order to activate the risk calculation in the astraia program, you will need to request a license 
from the Fetal Medicine Foundation (FMF), London. Without a license or, indeed, with an expired license, the risk 
calculation will not be available anymore although no data, such as previously calculated risks, will be lost. 
Therefore, please make sure you regularly send your first trimester audit to the FMF. For further information about 
the licensing process, please contact the FMF directly (see the end of this chapter).

If none of the options is accessible, you may be missing the group permission access FMF Options. Please check 
Options - Groups (see page 179).

Provided you have completed the necessary course(s) on the Fetal Medicine Foundation website and have internet 
access, you can download your license from the FMF website directly on this screen - Download license.
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You will need:

Your FMF user ID
Your login name
Your password

The downloaded license will be added to the user list. You can also delete user licenses, e.g. if a sonographer has 
left the clinic, by selecting the respective entry (click the checkbox at the beginning of the line) and then pressing 
Delete user(s).

Alternatively, you can download your license file from your personal FMF site and copy it to the computer where 
astraia is installed; you can then import the license into the astraia program. By clicking on Import license, you will 
be able to search for your license file. If the import was successful, you will receive a message and the data in your 
FMF Risks windows will change, e.g. the expiry date.
When selecting which file to import, you may need to change the Files of Type that is being displayed to All files in 
order to see and select the file that you need to import. When you are at the correct location, select Open. The 
license will be imported automatically.

You will be able to see the following information: licensed users in combination with their FMF user Id and the 
permissions to use the following factors as input for the risk calculation:

ultrasound markers in general (NT)
nasal bone (NB)
tricuspid regurgitation (TR)
ductus venosus PI (DV)

You will also see the permission for calculating risks for the following complications:

preeclampsia (PE)
fetal growth restriction (FGR)
preterm delivery (PT)

Every feature's expiry date is given in the respective column. After the expiry date, the corresponding feature is not 
available anymore. In the case of markers, the marker will not be taken into account in the calculation of risks 
anymore. In the case of risks, the risk cannot be calculated anymore. A value of 'N' indicates that the feature is not 
included in the user's FMF license.

All active operators must be mentioned by name and by the correct FMF user Id assigned to them by the FMF; you 
cannot manually assign operators.

You can change settings in the screen FMF Risks, although these can only be modified by users with the group 
permission to access FMF options; see Options - Groups (see page 179).
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If you choose to calculate Risk for aneuploidies at term, you should be aware that the risk for chromosomal 
abnormalities will go down as miscarriages linked with chromosomal abnormalities are taken into account.

You can also decide how to handle the risks for Trisomy 21, Trisomy 13 and 18 and the risks for preeclampsia, fetal 
growth restriction and preterm delivery. Please note that these options apply to the first trimester risk calculation 
and printout only. The screen PE Screening which is dedicated to the calculation of preeclampsia risks in the 
second and third trimester will always calculate the PE risks. The corresponding dedicated printout will always 
print the PE risks.

You can:

calculate and print the risks, or
only calculate the risks and hide them on the printout, or
neither print nor calculate these risks.
for Trisomy 13+18: calculate a combined risk by activating the check box

Usually, these settings apply to all patients, but you can choose to enable patient-specific screening options by 
ticking the corresponding checkbox on the right. This allows you to choose which risks to calculate on a per-patient 
basis. A patient's risk calculation screen then looks as follows:

For new examinations, the global settings from the options dialogue will be used as the default values for these 
checkboxes. This means a checkbox will be preselected when either 'calculate and print' or 'calculate, do not print' 
is selected in the options; otherwise, it will not be ticked. For existing 1st trimester examinations, done without the 
individual screening options, the checkboxes are all empty.
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Furthermore, you can exclude ultrasound markers from the risk calculation: you can exclude nasal bone, tricuspid 
flow, ductus venosus and fetal heart rate.

With regard to the first trimester risk printout, you can choose if you want to include graphs or suppress racial 
origin.

In order to be able to calculate a risk, the default setting requires you to tick the checkbox patient counselled and 
consent given. You can turn this requirement off by unticking the checkbox here.

Automatic updating of users' FMF licenses is possible, provided an internet connection is available.

The last settings in this section concern the screen-positive values - the cut-offs for trisomy 21 and trisomy 18+13. 
The default cut-offs are 1 in 100 and 1 in 50, but these can be changed arbitrarily and have no effect on the risk 
calculation. The effect of having these screen-positive values is to sort the risks: risks greater than or equal to the 
cut-off are highlighted in bold type in the risk report. Also, the first trimester audit (see page 240) records the number 
of cases where the calculated risk was above this value (as a %). Risk values lower than the value defined in 
the Lowest risk will not be displayed. The default value is 1 in 20000. This option also applies to the preeclampsia 
risks in the second and third trimester.

This risk calculation is only available to registered members of the Fetal Medicine Foundation, London. The Fetal 
Medicine Foundation takes full responsibility.

Please contact:

The FETAL MEDICINE FOUNDATION
(Registered Charity No. 1037116)
First Trimester Screening Programme
137 Harley Street, London WIG 6BG
United Kingdom
Tel. +44 (0)20 7034 3070
Fax. +44 (0)20 7034 3071
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13.8 Options - DICOM

The tab DICOM is available with any DICOM licenses. In this section, you can modify the settings for the Image 
Browser, the DICOM image archive, the DICOM Worklist Server and the Measurement Server.

Imaging

In the first section, you can configure the Image Browser and the image archive.

If you do not need the Imaging functionality, you can set the DICOM Archive type to Disabled.

 

In case you do not use a DICOM storage system, you will need to select File Storage as DICOM Archive type. Please 
enter a valid path or select one using a directory browser by clicking on the button next to the Images path text 
box. If your computers are networked, this path needs to be a UNC path to a shared directory with full write access.
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Choose the Generic DICOM archive if you want to connect to either the astraia Image server (which has to be 
licensed and set up separately) or an external PACS system.

If you are using the astraia Image Server as the Generic DICOM archive, you will need to specify the DICOM 
archive host name (server name or IP address), the DICOM archive host port and the DICOM archive AET. All these 
settings except the host name can be modified in the Image Server configuration. By pressing Verify you can test 
your connection (this test is a simple pinging test and will only test for connectivity, it does not test the data 
transfer).

If you are using an external PACS as the Generic DICOM archive, you will need to specify an additional local port 
and Calling AET, as default the computer/client name and the port 1104 will be entered. You can also specify a 
different port for storing images which is necessary for some PACS systems. Each time a patient is opened, astraia
will send a request for images to the port on the DICOM archive host. If the PACS system can find images, it will send 
them back to the port on the local machine and the image will be visible in astraia. For the settings on the Generic 
DICOM archive, please contact the technician in charge.

 In this section, you can also modify the refresh interval of the Image Browser.

 

There are advanced options available in a different dialogue which you can open by clicking on Advanced....

This dialogue and its options are described in section Imaging - Advanced at the bottom of this chapter.
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Worklist

In the next section, you can set up a DICOM worklist connection. Enter type (Astraia Worklist Server, Other or None) 
and name or IP address of the computer on which your worklist server service is running, then the port of the 
worklist server. By pressing Verify you can test your connection.

When Astraia Worklist Server is selected above, you can additionally change the following settings: You can 
specify the time before a worklist entry is deleted, the number of days after which an examination is considered 
not to be the current one anymore, the date/time of the worklist and the type of patient ID. If it is convenient for 
you to send every patient to the worklist when an exam is created, you can automate this by activating the option 
to automatically push patients to the worklist when exams are created.
In time/date, you can choose between the current time/date, the time/date of the examination or a manually 
entered time/date.

The type of patient Id can be changed to either

the Astraia Id number
the hospital number
the OHIP number (for Canada).

Note that if you change the type of patient ID, all previous images will not be available anymore. In order to enable 
a worklist button in the diary, the type of patient ID needs to be set to hospital number or OHIP number.

Imaging - Advanced

After clicking on the button Advanced..., the following dialogue with two tabs, Images and DICOM, is shown:
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In the tab Images, you can choose whether a preview should be shown when you hover your mouse over a 
thumbnail in the Image Browser. You can also choose the resolution of the thumbnail at which it will be stored in 
the database. It is advised to only change this setting when no images have been stored in the database yet.

The images can be displayed by date or by accession number.

You can also choose to buffer DICOM clips, which means that a DICOM clip will first be rendered to memory and 
then played. This can improve the frame rate on slower computers.

In the tab DICOM, the following set of options is available:
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You can choose to limit the number of concurrent connections to the PACS. In order to improve image loading 
performance, astraia will try to use as many PACS connections as possible. Depending on your setup, this may 
exclude other applications from accessing the PACS at that moment. Here you can choose a number of concurrent 
connections that astraia will use. The more concurrent connections, the faster the images load will be.

You can also choose that astraia will use one C-MOVE for the whole study (instead of per image). When there are 
no images in the database for a specific patient yet, astraia can perform one C-MOVE per study, which means less 
network overhead, but for some PACS servers, this also means that only one channel is used to send images one 
by one. This can be desirable as it is less load for the PACS, but the overall image loading performance decreases.

Astraia will automatically detect the PACS capabilities at the beginning of a new session, but that is not necessary 
if you specify these capabilities manually.

Measurements

With a measurement data transfer license, the option only import values if accession number matches becomes 
available. If this option is selected (a restart of astraia is required afterwards), only these values whose accession 
number matches the one in the currently active patient record will be imported.
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13.9 Options - Lab interface

The option Lab interface must be licensed otherwise the tab will not be available. In order to set up the interface 
you will need to select your interface type: The supported interfaces are

KRYPTOR
Perkin-Elmer LifeCycle 2
Labka
SSI
Perkin-Elmer LifeCycle 3
Delfia XPress
AutoDelfia
JDBC lab interface

The screen for KRYPTOR looks like this
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By clicking on  you can add a new analyzer and set up the connection:

The analyzer name does not influence the data transfer, it will only determine the name of the analyzer which will 
be displayed in astraia. The remote computer (you can either enter the name or the IP address) needs to be 
accessible via network and the folders for the requests and results need to be shared with full writing access. The 
UNC paths (here e.g. \\Analyzer\Results) will be created automatically and will be tested as soon as you press OK. If 
these folders cannot be accessed, an error message will be displayed. Please check the UNC path or your network 
configuration and sharing permissions.

By clicking on  you can edit an already existing connection to an analyzer, by clicking on  you can delete 
connections.

With the drop-down list "Patient ID", it is possible to select what identifier is to be used for the patient. There is a 
choice between the astraia patient ID or the hospital number.

You can also determine whether your sample number should be left unchanged or filled up / reduced to either 8, 10 
or 12 digits. If you select 'Sample ID 8 digits' and want to send a lab request with fewer digits, the first digits will be 
filled up with 0, in case the lab request has more digits, the sample number will be reduced to the last 8 digits (e.g. ' 
1234' will be changed to '00001234', '1234567890' will be reduced to ' 34567890').

You can also display error messages from the analyzer in astraia by activating Show analyzer flag messages.

In order to use the interface, you will need to check the interface has been tested. The test needs to be done as 
explained in astraia.

Note: In order to ensure the correct function of the interface, you must test each parameter on each BRAHMS 
KRYPTOR by sending a test request and importing the results back into the astraia system. After that, you must 
compare the test results displayed in the astraia system with those shown in the BRAHMS KRYPTOR result list. You 
must disable the interface if you are not sure that the results match.
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This is the Perkin-Elmer LifeCycle 2 screen

You will need to modify the URL according to your configuration: SERVERNAME needs to be replaced with the name 
or IP address of the computer where Perkin-Elmer LifeCycle is running, DBNAME with the name of the Perkin-Elmer 
LifeCycle database and possibly 1433 with the port of the Perkin-Elmer LifeCycle. If you do not know these 
parameters, please contact your Perkin-Elmer technician. The correct URL could look like this:
jdbc:jtds:sqlserver://LifeCycleServer:1433;database=LifeCycle

You will also need to enter a valid User name and Password. Please contact Perkin- Elmer and request a user name 
and respective password for astraia.

As a Machine type, you can choose between the Delfia Xpress, Manual Delfia and Autodelfia.

Your Import fields selection will influence the risk calculation directly, the effect can be seen in the non-editable 
field Risk. You have three choices:

Import the ß-hCG and PAPP-A concentrations, astraia will calculate the MoMs. The risk calculation will be 
based on the concentrations.
The corrected ß-hCG and PAPP-A MoMs will be imported, the concentrations cannot be entered anymore. 
The risk calculation will be based on the MoMs.
The ß-hCG and PAPP-A concentrations as well as the corrected ß-hCG and PAPP-A MoMs will be imported. 
The risk calculation will also be based on the MoMs.

Furthermore, you can select the type of ID: You can use the astraia Patient ID, the Hospital Number or the OHIP 
Number.

By clicking on Test connection you can verify the connection between astraia and the LifeCycle database.
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Note: In order to ensure the correct function of the interface, you must test each parameter for LifeCycle by sending 
a test request an importing the results back into the astraia system. After that, you must compare the test results 
displayed in the astraia system with those shown in the LifeCycle result list. You must disable the interface if you are 
not sure that the results match.

This is the screen for Labka

Here you will only need to select whether the interface file is available on the local computer / the local network 
(File) or via the Internet (FTP). As Path, you will need to enter the UNC path (for File) or the full URL (for FTP).

Note: In order to ensure the correct function of the interface, you must test each parameter for Labka by importing 
the results into the astraia system. After that, you must compare the test results displayed in the astraia system 
with those shown in the Labka result list.

You must disable the interface if you are not sure that the results match.

The SSI interface is only used in Denmark

As Import path, you will need to enter the UNC path where the temporary SSI files are saved to. By specifying a 
string in the File pattern, only files with this string in the left part of the file name will be analyzed, all other files will 
be excluded (e.g. if the File pattern is ' SSI_' and the files 'SSI_2008-01-27.cvs' and 'Random.jpg' are in the folder, 
only the first file will be analyzed).

The CPR (Danish patient ID) settings will influence the identification of the patients in astraia. CPR field specifies 
whether the astraia Patient Id or the Hospital number should be used, CPR length specifies the length of the 
identification number (8, 10, 12 or 14 digits).

In the pop-up list Machine type, you will need to select the correct analyzer, the choices are BRAHMS Kryptor, 
Delfia Xpress, Manual Delfia and Autodelfia.

Perkin-Elmer LifeCycle 3
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No configuration is necessary for the LifeCycle interface, as the work is all done by the LCService astraia service. 
Ensure that this service is installed and running, and configure it in the astraia Service Manager. Results can be 
imported into the biochemistry screen with the Result button.

Note: For all further questions concerning lab interfaces, please contact the respective vendor or contact our 
Technical Support (see page 260).

Delfia Xpress

No configuration is necessary for the Delfia interface, as the work is all done by the DxPress astraia service. Ensure 
that this service is installed and running, and configure it in the Astraia Service Manager. Values reported by the 
analyser will be stored in the database and can be imported into the biochemistry screen with the Result button.

Note: For all further questions concerning lab interfaces, please contact the respective vendor or contact our 
Technical Support (see page 260).

AutoDelfia

No configuration is necessary for the Autodelfia interface, as the work is all done by the Autodelfia astraia service. 
Ensure that this service is installed and running, and configure it in the Astraia Service Manager. Values reported by 
the analyser will be stored in the database and can be imported into the biochemistry screen with the Result
button.

Note: For all further questions concerning lab interfaces, please contact the respective vendor or contact our 
Technical Support (see page 260).

The JDBC lab interface

This interface reads lab data directly from a third-party database. All necessary information for interacting with the 
database is entered in the screen below:
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All fields are mandatory apart from where marked optional (opt). The interface accommodates several database 
drivers:  PostgreSQL, Sybase, Oracle, Mysql, MSSQL (JTDS) and Apache Derby. The external database's URL, user
name and password are required for astraia to access it. When these are filled, the database connection can be 
tested by pressing the button Test.
In order for the interface to access the database data of interest, the Table name and relevant database IDs need to 
be provided. The names refer to the attribute or header names used by the external database and enable an SQL 
command to retrieve the relevant information and transfer it into astraia. Note that the Date name refers to the 
time at which the data was stored. The Tests table must also be filled in, with the Astraia name provided by astraia 
support.
The example in the figure below shows the configuration for a Table DxResults with columns Patient, Sample, 
Test, Value and Stored. The table Tests contains the Display name, the descriptive name of the Test (analytes in 
this case), Astraia name, the corresponding name for the astraia database (parent.column) and Identifier, the 
external database's ID for the Test in question. Factor allows for any unit conversion if needed. For example, if the 
laboratory sends PAPP-A values with units mIU/l we should enter a conversion factor of 0.001 to obtain the astraia 
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units of IU/l.
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Using the interface in astraia

In astraia, First Trimester screen under Biochemistry, enter the Sample ID in Sample number and press enter. 
The Lab results button will display a green flag to indicate that the data has been retrieved (see below).

 
Press the button to view the data. A table appears with the results for a particular Sample ID . Note that Received 
refers to the date at which the sample was received in the original database. You must tick the left-hand boxes in 
order to import the data into the screen (see figure below).

 
The data fields will be automatically entered as illustrated below. If a factor was used, the factored data is given.
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13.10 Options - Patient data

In Options - Patient data you can set up and configure the interfaces to different hospital or practice information 
systems (if licensed) you can optimize the patient lookup screen and change various other settings.

In order to set up and configure an interface to a hospital information system (HIS) or a practice information 
system, chose your system and set it up properly by pressing the button Configure. In case you want to set up an 
interface please always contact our Technical Support (see page 260).
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With the following settings you can optimize your patient lookup screen:

First, you can define in which field the initial focus should be and after how many chars the first results should be 
displayed.

For example, if you select Hospital no. as the initial list focus, upon opening the patient lookup screen, the focus 
will automatically be in the field for the hospital number. If you select 3 chars typed for search on name after, the 
first results will only be displayed after 3 characters of the patient name have been typed in.

Next, you can select which input fields should be available in the patient lookup window. If you tick the 
checkbox Search by doctor, the field Doctor will be shown there. With this field, you are able to search by referring 
to the doctors' surname or the surname of the general practitioner. You can also add the fields NHS number (for the 
UK), OHIP number (for Canada) or BSN (for the Netherlands) to your patient lookup screen. Which options are 
available here depends on your currently selected language. In order to use these fields properly, you may want to 
select the respective patient demographic screens in the mask configuration (see page 213).

Finally, you can choose which columns should be shown in the list of results by ticking the respective fields in 
the Patient list fields. The more information is displayed, the easier it will be to correctly identify a patient and 
prevent wrong data entries. Again the options displayed here depend on your currently selected language.
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You can define the format of your hospital number by choosing the Hospital number type. Here you have the 
choice between

'Normal' (all combinations of numbers, letters and special characters with an arbitrary length)
the Danish 'CPR' (######-AAAA where # represents numbers and A letters) or an alternative 'CPR' format 
(######AAAA)
a special 'Czech format', 'UHL' (A######)
a 'Swedish ID'
the Polish 'PESEL' (###########).

Besides hospital number can be configured as a mandatory field (at least 6-digit) by activating the option a hospital 
number must be entered to book a patient.

These are the further settings:

The other settings enable you to:

copy referring doctors to the next examination (if you create a new examination within one case, the 
referring doctor will be copied),
copy the history from past case by default (History related data that does not change from one case to the 
other will be copied automatically forward to any new case, you can still untick the copy history checkbox 
when you create a case. This function will also check all previous pregnancy cases and automatically put all 
previously recorded pregnancy outcomes to the History - Obstetric history section of a new case) and
copy the indication forward to new examinations (if you create a new examination within one case, the 
indication will be copied).
Fetal data that usually doesn't change during a pregnancy (placenta site and chorionicity) can be copied 
from the latest to a new examination automatically. To enable this, tick copy selected fetal data forward 
to new examinations.... In the following dialogue, you can choose the respective fields you wish to be 
copied. This means these fields are copied forward but stay editable in each examination, so possible 
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changes between two examinations can still be documented correctly.

Furthermore, you can choose to attach messages to cases, not patients. Internal messages will only be displayed 
if the same case which was open when the message was written is accessed again, not if a new case is opened. 
Normally messages will be displayed as soon as the patient which was opened when the message was written is 
accessed.

You can change the labelling of multiple fetuses (either Fetus 1, 2, 3, ... or Fetus A, B, C, ...).

Finally, the pregnancy duration can be set to either 280, 282 or 283 days.
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13.11 Options - Workstation

The section Workstation contains various settings which only apply to the local computer. Therefore these setting 
have to be changed on each workstation separately. They include a hiding option for the image browser (if the 
image browser is licensed), the worklist (if licensed), a Host system, the automatic image import, the 4D viewer and 
the Java memory usage.

The image browser for this workstation can be disabled by removing the default tick.

In the next section, you can select your Host system. The host system needs to be configured whenever you want 
to send data back to an external system. In some cases, the host system will also replace the astraia patient lookup 
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screen. You will need to enter a server name for most systems, furthermore, you can configure the host system 
settings for all workstation and enable a logging function by activating the checkbox.

The configuration of the DICOM worklist (only available if licensed) and any changes in the configuration will take 
effect on all workstations in the network. You can choose between 'None', the 'astraia Worklist Server' (which has 
to be running and configured on the astraia server) and the 'ALI worklist' where you have to specify the file.

In order to import images with the astraia automatic image import (has to be licensed), you will need to specify 
the shared folders where the images can be found, select 'Default' as Import type and select the refresh rate (Scan 
every 5, 10, 30 or 60 seconds, every 5 minutes or do it manually).

In case your ultrasound is capable of 3D or 4D viewing, 3D or 4D files can be displayed with the astraia 3D/4D viewer. 
You can also define the path to the executable of an external 4D viewer (GE 4D view or Samsung 5D Viewer).

The last setting is the amount of memory that will be reserved for the Java Runtime. The default value is the value 
you selected during the installation. You can choose between 64, 128, 256, 512 and 1024 MB memory. Please note 
that working with images requires a lot of memory. Always make sure to leave enough memory for other programs 
as well as the operating system.

In case of any questions or problems, please contact our Technical Support (see page 260).
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14 Screen Configuration
This utility is available only to the admin user. Select Edit from the menu bar, then Screen configuration and select 
the module which you want to change:

You can view every screen by clicking on it in the Navigator. Here for example the screen Patient details from the 
module Pregnancy:
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On the right, there is a sidebar offering several screen-specific configuration options. The first one allows you to 
hide the current screen in the Navigator depending on the current user's user group. This feature will be explained 
in more detail below in the section 'Configuring the screen access permissions'.

On the other hand, you can also set the required screens. That way you can make sure that each operator e.g. 
enters an indication for his/her examination.

For some screens or screen subsections you can select an alternative version, e.g. for the patient name (for a list of 
available alternative screens see the relevant sections in the chapters Pregnancy (see page 28), Gynaecology (see page 
64), Colposcopy (see page 69), Fetal Echocardiography (see page 72)). Depending on these selections, specific fields will 
be shown or not on the respective screen.

By clicking on specific fields, you can customize them individually, here e.g. the field View in the screen Ultrasound 
from the module Pregnancy.

By clicking on individual fields you can select whether

the field is required and must be entered: Required field,
whether the item should be omitted from printout: Suppress in printout,
whether it should be hidden on the screen: Hide this field, 
whether or not the list (only if the field is a list field) can be changed: List cannot be changed and/or
whether the field should be flagged for the Overview functionality (see chapter Overview (see page 76)): Flag 
this field. Any entries in fields, which are marked with this flag will be included on the overview window.
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The settings for each item are shown on the right side of the screen. Fields that can be found in different screens 
(even if they are the same field) can be modified separately. You can see a red frame (in the example the fields 
'Operator' and 'View') around items that are required and blue frames (in the example the field 'US system') 
around items that are suppressed in the printout.

Note that some fields (e.g. patient names, DOB and examination date) are set as required by the system and cannot 
be removed.

Configuring the screen access permissions:

There are two ways of restricting access to screens in astraia. One applies to examination data only, i.e. the 
Examination screen and its sub-screens. Due to their critical role in patient data protection, access to these screens 
can easily be restricted in Options -> Groups.

However, astraia allows for a more fine-grained restriction policy here in the screen configuration. It lets you select 
for all screens individually which user groups should have access to it. You can use this (a) to restrict the access to 
certain screens only to authorised or trained user groups for better control over the access to data and (b) to 
customise the Navigator's entries to fit each user group's individual workflow.

To select which user groups should have access to the current screen, click on Configure.... If the access is not 
permitted for a user group, users that belong to that user group will not see the screen (and all its sub-screens) in 
the Navigator. Hence these users will not be able to open the screen and look at data.

In this example, all groups except for Clerical, Guest and Secretaries can access the current screen. As you can see, 
the checkbox for the group Secretaries is disabled, i.e. it can not be modified. There are two possible reasons why a 
checkbox for a particular user group is disabled:
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1.

2.

Access to a screen (e.g. Amniocentesis) is not permitted because the user group's access to its parent screen 
(e.g. Procedures) is not permitted either, i.e. restrictions are inherited.
The access to examination data is disabled in the user group's settings (in Options -> Groups -> (select the 
user group) -> Edit). Therefore the access to the Examination screen and its sub-screens is disabled in this 
dialogue.

Editing labels:

All labels and list entries displayed on the data entry screens can be edited. The English original label will be 
displayed in the read-only field below/next to each label for reference. The changes will be preserved even after the 
update to a new version.

Adding user-defined values:

You can add user-defined fields for each screen in the navigator by pressing the button Add new... in the section 
user-defined values. The following mask will appear:

First, you will need to define a title for the section of user-defined fields, then select the database table in which this 
section should be saved. There are four possibilities: The user-defined fields only refer to the current exam ('Exam'), 
to the patient in every exam and case ('Patient'), to a whole case ('Episode') or only to a fetus during a whole case 
('Fetus').

You can decide whether the section of user-defined fields should be included in the standard printouts. If this 
checkbox is not activated, the whole section will be ignored.

Note: Please take great care when modifying labels. If the meaning of any label or checkbox is changed, 
previously entered data will appear in a different context than initially intended. NEXUS / ASTRAIA GmbH 
will take no responsibility for any inconsistencies of entered data. Please also note that the label changes 
will not be reflected in other components of the software, such as the printouts or the Overview.



Note that some labels are used on more than one screen. The program will ask you if you want to change 
that label on all screens or only on the currently selected screen.


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Positioning:

The user-defined section will by default be displayed at the end of the respective screen, after all standard fields. If 
you want to position the user-defined fields within a screen please click on the field in the screen before which you 
want to have the user-defined fields displayed (please note: only the complete screen can be positioned). The 
position of the user-defined fields will be shown under Position before (click on the screen), see the above 
screenshot.

The maximum extent of one section is 20 user-defined fields. They can include text fields, number fields, 
checkboxes, lists, date fields and comment fields. You will need to enter a field type, a database name, a label and if 
available the width for each field, for some field types you can optionally enter the decimal numbers (which has to 
be less than the width) and the units.

Fieldtypes:

Text field: A label, a width (number of characters) and an optional suffix can be entered for a text field.
Number field: For a number field you can enter a label, a width (number of displayed characters) and the 
number of decimal places (the number of decimal places needs to be lower than that of the width). A suffix 
can optionally be added, usually to document the unit of measurement.
CheckBox: A checkbox only requires a label.
List: A label and a width (number of displayed characters) can be entered for a list.
Date field: A date field is specified with a label.
Comment: For a comment you can enter a label. The comment field will be displayed with a height of six 
rows.

Already entered fields can be moved up  and down  in the list or can be deleted  entirely. User-
defined values can only be deleted if no data has been entered in the respective field. As long as there is data 
entered for at least one patient, a notification will be shown that the field cannot be deleted. However, after 
clearing the field's contents for all patients the user-defined value can be deleted again.

This is how the entries above are displayed in the program:

After confirming your entries with OK, the user-defined fields cannot be modified anymore (except for 
deleting and the modifications which are available for all fields).


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Summary configuration

There is a set of values that are displayed by default in the Summary (see page 81), but they can be modified or 
removed. It is also possible to add new values.

In order to do so, go to Edit -> Configuration in the menu and select the module whose summary you want to 
change. The configuration window opens. Select the screen on the left whose values you want to change. In the bar 
on the right, you can see a list of values that are currently shown in the summary. The following screenshot shows 
that list for the screen 'First trimester':

We recommend that you use great care when creating user-defined fields - NEXUS / ASTRAIA GmbH will 
take no responsibility for the inconsistency of the database which can result from creating user-defined 
fields. These fields are stored as a separate table in the database and will be correctly preserved after a 
database update.


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The list is made up of 4 columns:

Prefix: This prefix will be shown in front of the value defined by 'Expression'. Usually, it makes sense to enter 
the field's label, but it can be left empty if the value is self-explaining. When you add a new item (see 
following sections), astraia will automatically choose the appropriate prefix.
Expression: This is the value itself which will usually be taken from the database. This field should not be 
changed manually since a wrong value here might cause the value not to be shown at all.
Suffix: Similar to the prefix, this will be shown after the value. Usually, this will be the value's unit or empty.
Loop: Some values like the ones linked to a fetus need to be shown once for every existing fetus and not 
once per examination. This field should be chosen correctly by astraia and should not be changed manually. 
If it does not work as expected, please contact our support.

The items appear in the summary in the same order as in the list. In order to change that order, just select an item 
and move it using the up and down arrows at the top-right of the list.

 Editing items

Please note: Summary configuration is meant to provide a simple way of editing and adding basic 
information to the Summary. If you need a more sophisticated display of data than is described in the 
following sections or if an added value is not displayed the way you expected it to, please contact our 
support.
You can always reset your changes by clicking on the button Restore below the list which is only active if 
you made some changes to the default configuration.


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In order to change an item's prefix or suffix (the other columns should not be changed manually), just double-click 
on the value you want to change.

If for example, you would like the CRL and NT values to be separated by a dash instead of the default "mm,", you 
can change the CRL's suffix (or the NT's prefix) by double-clicking on it and adding the dash character '-' (and 
perhaps a space character in order to improve the appearance).

 Now press Return and click on Save changes. From now on, this change will be visible in the Summary screen (you 
need to close and re-open any patients that were open during the configuration change):

 

Adding items

New items can be added by clicking on the + (plus) button in the Summary configuration area. A blue message 
appears indicating that you now may choose the item from the current screen by left-clicking on it.

It is then added to the list of items. Note how astraia automatically chooses the prefix and suffix from the item you 
clicked on, so manually entering these values should not be necessary.

If you want to keep the changes you just made, click on Save changes.

The following diagram shows how to add the maternal weight to the First trimester screen.
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Removing items

Removing items is as simple as selecting the item you want to remove and clicking on the - (minus) button.

Again the changes need to be saved by clicking on the button Save changes.
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15 Audit

First Trimester Audit

See First Trimester Audit (see page 224)

Automatic Audit

See Automatic Audit (see page 223)

Second Trimester Audit

This audit provides a summary of your 2nd-trimester biometry measurements (BPD, HC, AC, FL, Uterine PI, 
Umbilical PI, Ductus Venosus PI, Middle Cerebral PSV) against the normal distribution of your selected chart (see 
Options - Charts (see page 183)). The list of ultrasound operators is available at the top of the screen so that you can 
examine the individual distribution for each operator. Additionally, you can select a certain number of cases, either 
all cases, the first number of cases, the last number of cases, or all but the first number of cases. To see your values 
against any other available chart in astraia, please select the chart from the list on the right side.

FMU statistics

This audit exports a monthly statistic for your fetal medicine units to excel. The statistic contains the number of first 
scans, followup scans and total scans, furthermore, the number of early pregnancy scans, nuchal (1st trimester) 
scans, anomaly (2nd trimester) scans, growth scans, doppler examinations, fetal echocardiographies, cervical scans 
and serum screenings. Additionally, you can see the number of procedures: Amniocentesis, CVS, FBS (with blood 
transfusions and platelet transfusions), Shunts, Amnio infusions and reductions (drainage), embryo reductions and 
selective fetocides. The percentage of postpartum followups will also be displayed. You can furthermore select if 
the data should be sorted by operator, by department or not at all.

EPU statistics

This option allows you to export monthly and overall data for Early Pregnancy Units to an excel file. The data is 
displayed for each operator and department individually and all departments together. The results provide an 
overview of the different early pregnancy locations and miscarriages, there is also a spreadsheet for ectopics.
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KC65 Colposcopy Report

If Colposcopy is licensed: Produces the KC65 Report - a report used in the UK. It is only available in English and will 
create a summary of a certain set of colposcopy data. You will have to select the quarter and the year of the report 
and may then print or preview the report.

15.1 Automatic Audit
If the automatic audit is licensed it can be used to perform a set of database queries at a preset time. These queries 
will be synchronized and exchanged via the Internet. All data is encrypted. By selecting the automatic audit, you will 
be able to configure all the necessary settings in this screen:
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15.2 First Trimester Audit
When you start the audit, an initial dialogue appears allowing you to select by operator and date range. This feature 
enables you to speed up the data collection process. If you're using different departments, you will also have the 
ability to only select data from a specific department.

The first trimester audit is organised into several sections, individually accessed by clicking on the different tabs:

The Summary page is displayed first. On this page, you can see your overall screening results. You can also set the 
start and end dates of the audit period.

The following data are displayed:

The date the screening program started and the audit period
The number of patients seen in the audit period
The percentage of measurements in two different centile ranges (greater than the median, greater than 95th)
The median, 5th and 95th centiles of free ß-hCG, PAPP-A and PIGF expressed in MoMs and the percentage of 
measurements above the 95th centile
The number of women with an age of 35 or more and the percentage compared to the total group
The number of expected cases of Trisomy 21 based on the maternal age distribution of the group
The number of cases where the adjusted risk estimate is given was equal to or higher than the screen-
positive value (also given as a percentage)
All chromosomal abnormalities recorded, with the astraia ID number, age, CRL, NT, biochemical values, 
calculated risk and karyotype.

The NT Distribution page displays all Nuchal translucency measurements made during the audit period (as 
deviations from the median) against the distribution of the normal population. The list of ultrasound operators is 
available at the top of the screen so that you can examine the individual distribution for each operator. Additionally, 
you can  apply a filter on the number of cases by selecting either all cases, the first number of cases, the last number
of cases, or all but the first number of cases.

The page NT Values plots all nuchal translucency measurements made in the audit period against crown-rump 
length. As in the distribution page, the list of ultrasound operators is available at the top of the screen so that you 
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can examine the individual distribution for each operator. Additionally, you can select a certain number of cases: 
either all cases, the first number of cases, the last number of cases, or all but the first number of cases.

Each measurement is displayed with a symbol representing the fetal karyotype. A legend is shown on the right. 
When you pass the mouse pointer over a symbol, the patient Id number(s) is (are) displayed in the box on the right, 
below the legend.

The biochemistry tabs show the distribution of log10 MoM with the corresponding normal distribution for each 
analyte. Plotted separately, below, are the raw analyte values against the median. The symbols, legends and 
display are the same as for the NT Values plots. You can filter your results by type of analyzer and kits by selecting 
them in the lists.

Ductus venosus PI, Uterine A PI and MAP are presented as distributions of log10 MoM, also shown with the normal 
distribution of each marker. Filtering is available by operator.

The Details page lists the percentage of measurements in two different centile ranges (greater than the median, 
greater than 95th) of the values from all ultrasound operators together as well as for each individual one. In 
addition, the measured and expected median, 5th and 95th centiles, the number of measurements and the 
percentage of measurements above the 95th centile for free β-hCG and below the 5th centile for PAPP-A and for PlGF 
are displayed for each individual analyzer kit. In section Details and calculation methods below, you will find a 
detailed description of the columns and the involved calculation methods.

On the page Medians, you can see graphical representations of the MoMs grouped by gestational age and weight.

The values displayed for each week/weight interval are:

the number of samples
the median gestational age in that interval
the mean observed median in that interval
a confidence interval of the MoMs

Other factors displayed are Ethnicity, Smoking status, Parity and Assisted Reproduction

If the observed and regressed medians are significantly different you should contact your audit centre to change the 
median parameters.

Laboratories can manually adjust their medians by 50% if they notice a continuous increase or decrease of their 
MoM values.

Such adjustments can be made by clicking on Adjust MoMs....

The adjustments made are applied to the calculated MoMs. A factor of 1.10 means that an MoM of 1.10 will be 
converted to 1.0. To adjust these factors, you will need a minimum of 1000 MoM values in total measured in the last 
six months.

The dialogue shows you any existing adjustment factors for the different analysers and analytes. The adjustment 
buttons for the individual analytes and analysers will only be enabled if at least 500 MoM values are available for the 
particular combination of analyser and analyte. This is to make sure that the adjustments are based on a 
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sufficiently large data set. If you want to enter factors from your lab (who have sufficient samples) or calculate the 
median adjustment factors despite not meeting the recommended minimum number of MoM values, you can tick 
the checkbox at the bottom of the screen.

After clicking Adjust..., a dialogue opens in which you can select the date range of the data you want your 
adjustment to be based on. After clicking Next, the application will analyse your data set and recalculate the 
existing MoM values with the latest algorithm version. This is to make sure that your median adjustment factors are 
based on the most recent version of the MoM calculation algorithm. It may not be possible to recalculate some 
existing MoM values due to the changed requirements of the new MoM calculation algorithm. Therefore it can 
happen that the previously sufficient data set does not contain enough data anymore to meet the recommended 
minimum. In that case, the application will show a warning. You can still choose to calculate the median 
adjustment factors by closing the dialogue with the warning message and ticking the checkbox at the bottom of the 
main median adjustment dialogue.

This adjustment will be applied only to future risk calculations. All existing risks will be unchanged. Please use 
these adjustments with care!

On the page CUSUM, you can see the CUmulative SUM plot of the MoMs, for details, click here (see page 228).

The Print button, common to each page, prints a report collecting all the information from each page in the First 
Trimester Audit. Here you can also save your printout as a PDF file by going to Print -> Print and selecting 
PDFCreator as the Print Service.

The FMF Statistics page displays the automated audit report, click here (see page 228) for more information.

Exporting Audit Data

The Export button allows you to save the results of your audit to a text file on your local computer. You can upload 
this Audit file to your personal account on the Fetal Medicine Foundation website. Log into your account 

Please note: While it is possible to base your median adjustment on both data from before an algorithm 
update and after, it is recommended not to do so. A median adjustment should only be based on data that 
was collected with the latest algorithm in place.


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on www.fetalmedicine.org and go to Audit / licensing and follow the procedure described. The exported data 
contains only the data used to produce the audit report: no patient names or addresses, and no comments entered 
in the data entry screens are exported.

You can also export your data as a PDF file. To do this, go to Print and select PDFCreator.

Details and calculation methods

The FMF audit algorithm operates on a set of data (CRL, NT, operator and date), and identifies three parameters to 
evaluate the operator's adherence to FMF scanning and measurement guidelines: bias, spread and trend. Based on 
the bias and spread, the operator's detection rate for trisomy 21 can be calculated (the further away from the FMF 
standard these are, the lower the detection rate).

Data

The algorithm scans data from the desired period (for audit purposes the last year) and collects cases where CRL 
and NT have been measured. Cases where CRL is outside the range 45-84mm or the NT is > 6mm are discarded.

Bias

The bias of the NT measurements (in mm) indicates the degree to which the operator under- or over-measures. 

Bias is calculated by calculating the fits (median NT for CRL) and the residuals (log10 NT - log10 fit). The bias is then 
calculated as

Bias = ((10 ^ (median of residuals)) - 1) * (median of fits)

Spread

The spread of measurements should be similar to an FMF centre. Because standard deviation is not an appropriate 
measure of spread, we calculate the Mean Absolute Deviation (MAD). 

This is calculated by finding the median of (residuals - the median of residuals) / 0.6745.

Spread = MAD / 0.079 

Trend

As NT is increased at larger CRLs, NT data sets should show a trend (smaller NTs at low CRL, higher NTs at high 
CRLs). The residuals are normalized by subtracting the mean of the residuals. Then linear regression is performed 
on the normalized residuals, excluding any where the absolute value is > 3 standard deviations (SD = .0841). If the 
result of linear regression is significant (p  < 0.05) then the slope is analyzed (a correct trend will have a slope of 
zero).

Detection rates

The detection rate for screening for trisomy 21 by NT alone or by NT + biochemistry is estimated from tables 
supplied by David Wright. The tables contain detection rates for each combination of bias and spread. 

FMF pass / fail

The audit will succeed provided

the number of cases is 30 or more and
bias is between -0.25mm and 0.25mm and
spread is between 0.7 and 1.3 and
trend is between -0.003 and 0.003
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Quality review and ongoing Certification in nuchal translucency 

Each sonographer must submit NT data and 3 images of NT measurement for audit 12 months after 
obtaining the FMF Certificate of competence in NT and the FMF software for the calculation of risks. In 
addition to the FMF audit, all sonographers are encouraged to perform their own internal quality assurance 
on a monthly basis by examining their NT distribution using the automated audit module incorporated 
within the FMF risk calculation software.

The audit involves an assessment of the distribution of NT measurements of each sonographer and an 
examination of their images. Sonographers passing their audit will be re-audited and re-licensed on an 
annual basis thereafter. The NT distribution cannot be assessed if fewer than 30 scans have been performed, 
but in this situation, an individual can still pass their audit if their images are satisfactory.

If the NT distribution falls outside the satisfactory range, advice will be given on how to improve the NT 
technique, based on the review of images. The name of the sonographer will be removed from the FMF 
website list of holders of the Certificate of competence in NT. A new audit will be carried out in 3 months 
(please see audit policies on your own FMF page) and the sonographer will only be reinstated on the FMF 
website list once the audit is considered satisfactory. However, if in the new audit the standard of the 
sonographer has not improved then their FMF software license will be revoked. In this case, the sonographer 
will need to be retrained and apply for recertification by attending the FMF internet-based course and 
submitting the appropriate logbook of images.

Please submit images and data online. You can also send these to:

The FETAL MEDICINE FOUNDATION (Registered Charity No. 1037116)
First Trimester Screening Programme
137 Harley Street, London WIG 6BG, UK

Tel: +44 (0)20 7034 3070
Fax: +44 (0)20 7034 3071

e-mail: fmfcertification@fetalmedicine.com

15.2.1 CUSUM
A CUmulative SUM plot displays MoMs sequentially as a sum of log10MoMs. Between the selected audit start and 
end dates, all MoMs corresponding to the selected analyzer type are plotted. It is normal for the plot to wander off 
either above or below the reference line (= 1 MoM). However, any change which results in changes in MoMs will be 
immediately visible as a change in the gradient of the plot.

Any change in the risk version is displayed as a red vertical line at the moment it is first used. If you use lot numbers 
(kit) in the biochemistry screen, changes in lot numbers will be also displayed as blue vertical lines.

15.2.2 FMF Statistics
The automated audit report provides the option of selecting:

Time period (start and finish Date)
Results for the whole centre and individual specified operator

The report includes:

FMF Operator
FMF Operator code
Time period (start and finish Date)
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Number of singleton pregnancies
Number of multiple pregnancies 

Maternal age (median)
Maternal age % above 35.0 yrs
Maternal ethnicity % White
Maternal ethnicity % Black
Maternal ethnicity % Asian
Maternal ethnicity % East Asian
Maternal weight (median)
% previous pregnancy with trisomy 21
Expected number of cases of Trisomy 21 based on background risk 

% pregnancies with more than 1 fetus
% of cases with NT above 3.5 mm
% of cases with NT above the 95th centile
% of cases with NT below the 5th centile
% of cases with NT above the median 

free β-hCG: Median corrected MoM
PAPP-A: Median corrected MoM
PlGF: Median corrected MoM
Uterine artery lowest PI (MoM): Median corrected MoM
Mean arterial pressure (MoM): Median corrected MoM 

No of cases with assessment of nasal bone
No of cases with assessment of tricuspid flow
% of cases with Abnormal nasal bone
% of cases with Abnormal tricuspid flow
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16 The Menu Bar
The menu bar contains the menu groups File, Edit, Tools, Data, Images, Window and Help, of 
which Data and Images are only available if a patient is opened. On the right, the current user's name and the 
language selector (if configured) are displayed.

 

Menu group - File

You can open the menu File by clicking on it or with the shortcut Alt + F.

Print (see page 129)
Opens the print selection with the key combination Alt + F then P, the shortcut Ctrl + P or by clicking on File 
-> Print with the mouse.
Save
With the key combination Alt + F then S, the shortcut Ctrl + S or with a mouse click on File -> Save the 
current report is saved.
Close
You can close any open windows with the key combination Alt + F then C, the shortcut F10, a mouse click 

on File -> Close or a mouse click on the symbol   in the upper right corner of each window.
Export
When you have a question regarding the application's behaviour that involves patient data, our support may 
ask you for sample data to reproduce the behaviour you are experiencing. You can then export the current 
patient's anonymized data and provide it to the astraia support team.
The key combination Alt + F then E, the shortcut Ctrl + E or a mouse click on File -> Export exports the data 
of the current patient. In the following window, you can specify the target folder and the name of the file (the 
default file name is a combination of 'patient', the patient's ID and the file extension 'xml', e.g.: 
patient4.xml). 
All the existing cases and examinations of this patient will be exported unless you restrict the exported data 
to the current exam by using the respective checkbox on the right. You can anonymize the patient data 
(name, address, phone numbers and partner's data will be replaced by Xs) by ticking the second 
checkbox. Images will not be exported.
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Message to users
Go to File -> Message to users to open a dialogue that allows you to send a message to one or more other 
astraia users. This is described in more detail in the chapter Messages (see page 139).
Audit Trail (see page 240)
Go to File -> Audit Trail (key combination Alt + F then A or shortcut Ctrl + A) to open the audit trail window 
(a table with all activities).
Log out
Click on File -> Log out, use the key combination Alt + F then L or the shortcut Ctrl + L in order to log out the 
current user and log in to another user.
Backup database (see page 244)
Click on File -> Backup database, use the key combination Alt + F then B, the shortcut Ctrl + B or to save a 
backup of the database to the predefined directory. This option is only available for single-user systems, the 
predefined directory can be set up in Options - Administrator (see page 167).
Unlock a Patient If a patient record cannot be opened in write mode because it is locked by another client 
computer (e.g. in a network where a client is blocking a patient although the patient file is not open), admin 
users can remotely unlock patients by clicking on File->Unlock a patient (key combination Alt + F then U). 
This can happen if a client computer crashes while a patient record is still open.
Important: Unlocking a patient may cause data corruption. Always check that the patient record is not in 
use by another astraia user on the computer that is detailed in the blocking message, before the patient file 
is unlocked. A patient file should only be unlocked if it is clear that the patient file is not being edited by 
another astraia user simultaneously.
Delete

Delete a Patient
If a patient needs to be removed from the database, the administrator can use this function to delete 
a patient. You will first need to enter the patient's astraia ID number, then confirm the patient in a 
window where an overview of the patient's data is displayed. To delete the patient you will then need 
to confirm your intention by typing 'ACCEPT' and clicking Finish. Only if all three steps are taken, the 
patient and all examinations for that patient will be permanently deleted from the database.
Note: Always make sure that you really want to delete that patient and make sure that you are 
deleting the correct patient. You can cancel the deletion process at any time by closing the window.
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• Delete a Case
If a case (with all examinations) for a specific patient needs to be deleted, the administrator 
can use this function to delete a case. You will first need to enter the patient's astraia ID 
number, then select Open in order to display all cases for that patient. You can then select one 
case and delete it by pressing OK. After confirming the upcoming message, the selected case 
will be deleted.
Note: Always make sure that you really want to delete the case and make sure that you are 
deleting the correct case for the correct patients. You can cancel the deletion process at any 
time by closing the window.
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Merge
Merge patients
In case you accidentally created two patient records in astraia for one real patient, you can merge 
those two patient records into one. You will have to define one patient record as a target record - 
here all data will be added, it should therefore be the patient record with more data. Then you will 
have to define your duplicate patient record - here all data will be removed and the record will 
afterwards be deleted. The original two records will be saved in the Audit trail (see page 240).

Merge cases
In case you accidentally created two case records in astraia for one case, you can merge those two 
case records into one. You will have to define one case record as a target record - here all data will be 
added, it should therefore be the case record with more data. Then you will have to define 
your duplicate patient record - here all data will be removed and the record will afterwards be 
deleted. The original two records will be saved in the Audit trail (see page 240).
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Exit
File - Exit or the shortcut Ctrl + X will always close the astraia application if these options are 
available (not available e.g. when the options menu is open).

Menu group - Edit

You can open the menu Edit by clicking on it or with the shortcut Alt + E.

Cut
The menu Edit - Cut, key combination Alt + E then T, or shortcut Ctrl + X, cuts the highlighted text and puts 
it in the cache of your computer. With Edit - Paste (shortcut Ctrl + V) you can insert the cached text in any 
other place.
Copy
The menu Edit - Copy, key combination Alt + E then C, or shortcut Ctrl + C, copies the highlighted text and 
puts it in the cache of your computer. With Edit - Paste (shortcut Ctrl + V) you can insert the cached text in 
any other place.
Paste
The menu Edit - Paste, key combination Alt + E then P, or shortcut Ctrl + V, inserts a copied or cut text in the 
current place.
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Undo
The menu Edit - Undo, key combination Alt + E then U, or shortcut Ctrl + Z, undoes the last action.
Redo
The menu Edit - Redo, key combination Alt + E then R, or shortcut Ctrl + Y, repeats the last action.
Configuration (see page 213)
The menu Edit - Configuration is only available for admin users and opens the mask configuration for each 
module.

Menu group - Tools

Queries
The menu Tools - Queries, key combination Alt + T then Q. Opens the Queries (see page 141) window.
Audit
The menu Tools - Audit, key combination Alt + T then A. Opens the Audit (see page 222) modules.
Diary
The menu Tools - Diary, key combination Alt + T then D. Opens the Diary (see page 151).
Reminders
The menu Tools - Reminders, key combination Alt + T then R. Opens the Reminders (see page 134).
Options
The menu Tools - Options, key combination Alt + T then O. Opens the Options (see page 163) dialogue.

Menu group - Data

You can open the menu 'Data' by clicking on it or with the shortcut Alt + D. It is only available if a patient report has 
been opened.

Summary (see page 75)
The menu Data - Summary or shortcut F2 changes the focus to the summary.
Navigator (see page 75) 
The menu Data - Navigator or shortcut F3 changes the focus to the navigator.
Overview (see page 76) 
The menu Data - Overview or shortcut F5 shows an overview of problems in the open case (astraia has a 
pre-defined set for this, but the user can also add fields to be shown in the overview, see chapter Screen 
Configuration (see page 213)).
Chart 
The menu Data - Chart or shortcut F7 displays the graph for a measured value.
All Charts 
The menu Data - All Charts or shortcut F8 displays all charts on the current screen.
Read measurement data 
With the menu option Data - Read measurement data or shortcut F9 you can import measurement data 
from a connected ultrasound machine into the currently opened patient record. The option is only available 
if the measurement data transfer has been licensed and set up (see Options - Workstation (see page 211)).

Please note

The measurements are only imported into the currently opened screen and the currently selected fetus 
tab. If you have performed measurements for values of other screens or fetuses than the currently opened 
one, you need to open them and import the measurement data there too. This is to make sure that no data 
is added to the patient record without the explicit request by a user. Therefore you are also required to 


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Messages 
With the menu option Data - Messages or shortcut Alt + M you can insert a message for yourself or other 
users. This message will not be included in the patient report and can be assigned to a whole patient or only 
to one case (see Options - Patient data (see page 207)).
Menu sub-group - Change case 
With this option, you can change between all the cases of the opened patient without having to close the 
patient. You can also create a new case of any module that is part of your license.

External documents
(see also Storage of external documents (see page 170) for further information about the different storage 
options).

Import a document
By clicking here files (such as patient's reports from other doctors) can be stored in the currently 
opened patient record.

In the following popup window, the desired file can be selected and a description has to be added.

Open a document by clicking on its entry.

Delete a document
Imported external documents can be deleted by this function. After clicking a popup window 
appears, where the files are selected for deletion.

If external documents are saved for a patient an icon is displayed in the action panel beneath the 
navigator (see chapter 4 Navigation and Summary (see page 75)).

Appointment
The menu option Data - Appointment, shortcut Alt + P or key combination Alt + D then P is only available 
for pregnancy as it allows you to book an appointment for your patients at a certain pregnancy week. After 

make sure that the measurements that were imported into the current screen are correct and that they 
should be stored in the patient record. If imported values should not be stored in the patient record, they 
must be removed by the user.
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having selected the pregnancy week, the program will automatically open the Diary (see page 151) for that 
date.
Delete current examination
With the menu option Data - Delete current examination or key combination Alt + D then D you can delete 
an examination from the patient data.
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Menu group - Images

You can open the menu 'Images' by clicking on it or with the shortcut Alt + I. It is only available if a patient report 
has been opened, the option Image Viewer has been licensed and the checkbox use image browser on this 
machine has been activated in Options - Workstation (see page 211).

Display
The menu Images - Display or key combination Alt + I then D will open all selected images. Corresponds 

with the button   in the image viewer (see page 109).
Import
The menu Images - Import or key combination Alt + I then I allow you to import images from a folder. 

Corresponds with the import button   in the image viewer (see page 109).
Export
The menu Images - Export or key combination Alt + I then E allows you to export images to a folder. 

Corresponds with the export button   in the image viewer (see page 109).
Delete
The menu Images - Delete will delete the selected images.
Information
The menu Images - Information will display the available raw data for the selected image.

Menu group - Window

The menu Window (shortcut Alt + W) displays a list of all currently open patients and astraia windows (e.g. queries, 
the help function, etc.). By clicking on one, the selected window will be brought to the front.

Show all
The menu Window - Show all or key combination Alt + W then A will bring all windows to front.

Menu group - Help

You can open the menu 'Help' by clicking on it or with the shortcut Alt + H.

Index
The menu Help -> Index, shortcut F1 or key combination Alt + H then I opens a short guide to the program 
and the help function.
How do I ...?
The menu Help -> How do I ...?, key combination Alt + H then H, shows a list with frequently asked 
questions.
Tip of the day
The menu Help - >Tip of the day displays different tips for the usage of the application.
License
The menu Help -> License, key combination Alt + H then L provides general information about the license 
installed (License ID, License owner, License type - single user or network license and Expiry date if there is 
any) and specific information about the licensed modules, interfaces and extras. Here you can also re-license 
a standalone application by clicking on the button Re-license application. Further information can be 
found in Licensing (see page 248).
About...
The menu Help -> About..., key combination Alt + H then A provides information about the installed 
program- and database versions and the installation directory. Furthermore, the credits and resources for 
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the astraia program are displayed.
The button Save enables you to create a .html document with all relevant data about your astraia 
configuration, the database configuration and type, the operating system and all other important data (no 
patient data). It will be easier to solve any technical problems if you send this .html file together with the .log 
files to our technical support.
Via the Properties button, any of the astraia program settings can be viewed and modified.

Menu group - Messages (if unread messages are available)

If you have unread messages available, a flashing notification will appear next to your username. How to use 
messages is described in Messages (see page 139).

Menu group - Current user

On the right side of the menu bar, you can see the user who is currently logged in. By clicking on the user you can 
either log out of the current user or exit the program.

Menu group - Language selector (if configured)

If you have configured the Language selector (e.g. if you want to change the language in astraia frequently for 
different patients), a small flag that symbolizes the currently active language setting is shown in the right corner of 
the astraia menu bar. After clicking on that icon, you can quickly change between languages by clicking on the 
respective flag and it takes effect immediately.

For further information about how to configure this option, see Options - Administrator (see page 176).

Incorrect use of this tool could lead to serious problems in the operation of the software. We 
recommend that you export your settings so that you can restore them in case any problems 
should occur. In most cases, you will be asked by your support contact to add one or more property 
values. This course of action cannot cause any troubles, not even by mistaken entries. Problems 
only could arise if you modify or delete existing properties. In most cases, you can correct problems 
using the program Options screen. By pressing Accept below, you confirm that any resulting 
malfunction of your astraia system is in your own responsibility.


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17 Audit Trail and Database Archive
astraia documents certain actions as entries in the Audit Trail. The following types of audit trail entries exist:

Archived
Viewed
Printed
Query
Login
Logout
Auto Logout
Deleted
Risk options
FMF License
Merge
Settings
Exported

For example, deleting a patient or exam, importing FMF licenses and merging patients or exams will make an entry 
in the audit trail; changes in Options will also be logged. Note that changes in the Diary are not documented in the 
Audit Trail but in the Diary Audit Trail (see section Diary Audit Trail in Diary (see page 151)).

To open the Audit Trail, press the shortcut Ctrl + A, or select Audit trail from the File menu. You can either search 
the archive for a certain day or a certain patient.

The audit trail will view all of today's actions. You can sort the list by each column - just click on the header of the 
column and an arrow symbol will indicate the direction the list is sorted. If you want to check another date, click on 
the field Date at the bottom of the window. You can choose between today, yesterday, any other day (fill in a date) 
or a date range. If you are interested in a certain patient, click on the field Patient at the bottom of the window. The 
Patient lookup will come up and you can search for the patient as usual. After having selected the patient, the audit 
trail for that patient will be displayed.
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The column User shows the name of the user who has performed the documented action. If you are using astraia in 
a network, the name of the Machine from where the change was done is relevant. Apart from the Type, which 
summarizes the kind of action, the column Description gives further information on the action (e.g. the type of the 
printed report or whether the login was successful; with regard to the printout it also shows the mode the printout 
was generated with, i.e. "Print", "Preview", "Email", "PDF" or "Fax").

Clicking on Export will export the displayed part of the audit trail to an excel file.

By selecting a list entry and clicking on the field View, the corresponding patient record/report from that time will 
be opened. You can only look through these records, changes are not possible. You can also look at records of 
already deleted patients - the patient name will not be visible in the column Patient in the audit trail, only the 
respective astraia Id number (PID) will be displayed (the name is visible in the record).

If you click on an examination, that has been modified (Type Archived), you can display the changes with the Diff
button:
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Both, the previous and the changed examinations are displayed: the old one on the left, the new one on the right 
side. The changes are colour-coded (deleted data is red, added data is blue and modified data is green). In this 
example the value for AC was deleted. Values for BPD/TAD, BPD and HC have been added and the values for CRL 
and risk for trisomy have been changed.
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If an examination has been changed more often, you can also compare different versions by marking the respective 
examinations: click on one examination and then click on the other one while pressing Ctrl. This way you can also 
view the contents of a deleted examination: select the two examinations right before and after it and compare 
them.
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18 Database Backup
Please keep in mind that you should back up your database at regular intervals (at least twice a day), in order not 
to loose too many patient data in case of a failure.

When you are working with astraia as a standalone program and Sybase as a database environment, you must do 
the backup manually. Use the shortcut Ctrl + B, or select Backup database from the menu File. Additionally, you 
will be asked if you want to do a database backup when exiting the astraia program. We recommend a database 
backup every time you are closing the program. If you start working with astraia, and you do a database backup for 
the first time, the window Select backup path will appear. In this window, you will need to specify your backup 
location.

Note: This only applies to Sybase databases. This option is not available for other types of databases (PostgreSQL, 
MS SQL or Oracle) and the astraia program cannot be set up to run backups. Your local database administrators 
need to make sure the database is backed up on a regular basis.

With every further backup, the path chosen in the first place will be automatically selected. If you want to change 
the backup path, you can modify it in the Options - Administrator (see page 167) - Backup directory.

When selecting a directory for the database backup, please note:

when your computer is installed in a network, select a backup path on a different computer/hard disk that 
is available at all times.
when your computer is not connected to a network, choose a backup directory on a different hard drive. If 
that is not possible, the backup location should be a different directory than the astraia installation. 
Additionally, you will need to save a copy of the database to a different data carrier, for example to a CD/
DVD, an external hard drive or USB stick.

In a networked astraia installation, the system administrator should perform regular database backups to an 
external medium. Please make sure to check regularly that your database backup is up-to-date, complete and free 
of errors.

The customer is responsible for verifying that the backup is being performed and usable.
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19 Shortcuts and Function Keys
Shortcuts are keys or key combinations which access certain command from the menu directly. Menu groups with 
underlined characters define all key combinations with Alt. To open any menu, you will just need to press Alt and 
the underlined key (e.g. the menu group File: Alt + F). In order to open menu sub-groups, you will then only need to 
press the underlined key without Alt (e.g. the menu sub-group Save in the menu group File: first Alt + F, then S). If a 
direct shortcut exists, it will be displayed in the open menu (e.g. for the menu sub-group Save: Ctrl + S).

Function keys in open patient screens:

F1 Open the help file. If available, the help file for your current screen will be displayed

F2 Change to the summary

F3 Change the focus to the navigator: 
Move up and down with the up and down arrow keys; 
Open and close sub-branches with the right and left arrow; 
Change back to the report screen with Enter

F4 Navigator hidden/displayed

F5 Shows an overview window of the problems of this case

F7 Display the actual chart: The current value is inserted in the graphical representation of the 
percentiles. If one value has been measured in different examinations, all results are shown 
(current measurement in red). That way you can compare the development of a value to a 
collective

F8 Display all charts on the current screen

F9 Access transferred measurement data and insert it into the current screen

F10 Exit the current patient

Esc Exit the list editor, patient list or case choice without saving changes. Exist graphs that have 
been opened with F7 or F8

Function keys in the patient lookup screen:

Enter Open the selected patient

F2 Book a new patient
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F3 Import patient data from a hospital information system (the HIS interface needs to 
be licensed and set up, see Options - Patient data (see page 207))

F5 Display all patients whose data has been sent to the astraia worklist server (the 
worklist server needs to be licensed and set up, see Options - Workstation (see page 
211))

Esc Exit the patient lookup screen

Menu operations:

Ctrl + P Open the astraia Print selection (see page 129)

Ctrl + S Save patient data

Alt + M Open the messages window

Ctrl + E Export patient data (see Options - Administrator (see page 167))

Ctrl + I Import patient data (see Options - Administrator (see page 167))

Ctrl + A Audit Trail - display the database archive (see page 240)

Ctrl + L Log out the current user

Ctrl + B Take a Database Backup (see page 244)

Alt + P Create an appointment at a certain pregnancy week

Editing operations:

Ctrl + X Cut the selected text

Ctrl + C Copy the selected text

Ctrl + V Paste the text from the clipboard

Ctrl + Z Undo the last action

Ctrl + Y Redo the undone action
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Shortcuts Diary:

Alt + C Show calendar

Alt + N Search for a patient appointment

Alt + P Print a summary for the day

Alt + S Open the diary setup, change the settings

List fields and list editor:

The list editor displays buttons with underlined letters, which work with Alt like the menu groups.

Space Open list of a text field with helper list or popup list

Alt + Enter Open list editor

Alt + U 'Move up': move up an item in the list

Alt + D 'Move down': move down an item in the list

Alt + N 'New item': defines a new item

Alt + O 'OK': exit the list editor and save new entries and changes

Alt + C 'Cancel': exit the list editor without saving changes
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20 Licensing
When you start astraia after the installation the software will look for a valid license. If no license is available a 
message will appear, informing you that the program is unlicensed and that you have three options:

use astraia as a demo version, this is a demonstration mode
register astraia, if you already have a license
request a license

Requesting a license

If you do not yet have a license file, click on "Request a license".

If you have an email client installed on your computer (for example Thunderbird, Microsoft Outlook), a customized 
email will appear. Please fill in your contact details accordingly and send this request email to license@astraia.com.

Please do not modify the automatically identified numbers under "Hardware Addresses". These are read from the 
computer and are unique identifiers astraia needs to license your system.
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If no email client can be detected, the same information will appear in a text editor. If this fails to happen, you can 
still retrieve the information from a text file in your astraia folder, e.g. C:\astraia. Go to the ".log" subfolder and look 
for the file "license_request.txt". 

Copy the content and send it to us.

This can be done by an alternative mail client or by phone, letter or fax.

Register now: Importing a license

When you have requested a license astraia will send you the license via email. Importing a license is different for 
standalone and network installations.
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Standalone version

A single-user installation requires a standalone license.

Save the attached *.lic file on the computer where astraia has been installed.

Start astraia and a message will appear asking you whether you would like to use astraia in demonstration mode, 
request a license or register now.

Click on "Register now". 

A window will open. Browse to the folder where you have saved the license file. Select the file and click on "Open".

If you have a valid license, you will receive confirmation that the license has been read successfully. Press "OK" to 
proceed to the login screen.

If the license cannot be read an error message will appear.



astraia user manual - 29.x

Published on: 15-Jan-2024
NEXUS / ASTRAIA GmbH

Licensing- Page 251 of 263

If this is the case please get in contact with your local astraia representative.

Network installation

A network license is required for network installations.

The network license only needs to be installed on the Network server and not on individual astraia machines. The 
access rights for individual machines are handled by the network server.

Licenses for network installations are imported via the License Server.

Open the Astraia Service Manager by clicking on "Astraia Services". Click the "Configure"  button of the License 
Server.

The following License Server Configuration window will appear:
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Now you can import your new license by clicking on the "Import" button.

A window will open. Browse to the folder where you have saved the license file. Select the file and click on "Open".
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Now go back to the Service Manager Screen and press the "Start" button. The license server is now running and you 
can use astraia.

For the clients to be able to connect to the License server you might need to enable port 11111 and 11112 in your 
Firewall and/or Antivirus settings on your server.

Demo Version

Two different demo versions can be installed.

Demo version without a license

If you press "Demo", you will be able to get a first impression of the software. The version of astraia you will have 
access to contains all functionalities except for actually saving patient records.

Demo version with a temporary license

A licensed demo version will provide the full functionality of the software, including saving patient records, but for a 
limited period of time.

Re-licensing

You will need to re-license astraia if you are extending a temporary license, upgrading a demo license, or upgrading 
a standard license

Standalone version

If you have a temporary license, you will need to re-license astraia when the license expires. This can be done by 
clicking on the "Help" button in the menu and then selecting "License".

This will open the licensing dialogue (figure below). Click "Request a license". Refer to the section above on 
"Requesting a license". Your new license will be sent to you by email.

When you have received the license, click on "Re-license Application" in the licensing dialogue in order to import 
the license into astraia. Refer to the section above on "Importing a license".
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Network installation

A request for a new network license is initiated from the astraia Service Manager.

Open the Service Manager and click on the License server's "Configure" button. A new window will appear. Press 
the "Request a license" button (for further information refer to the section above on "Requesting a license"). Your 
new license will be sent to you by email.

When you have received your new license, re-open the configuration screen of the license server and press the 
"Import..." button. (For further information, refer to the section "Importing a license").
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Further information for network installations

Component access control

If you have requested a license where the number of components is different to the number of workstations, you 
may want to make use of an additional feature that helps control the access of components by individual users. 
With component access limited in numbers, a user might need to release the license in order to allow another user 
to make use of the component. This will be the case if the maximum number of users allowed to access a 
component has been met, as further users will have to wait for a current user to log out or exit astraia in order to 
make use of the component. The feature described below allows an individual user to decide whether astraia 
should let them open a component, not let them open a component or ask them every time they attempt to do so.

Open the licensing dialogue from the help menu in astraia. This shows you the type of license you have and which 
components or modules your license allows you to access. If the number of components is limited you will see a 
number in the Users column. For these components, you can also configure the  "Use?" column. Here you can select 
if a component should be accessed by you automatically (Yes) if you should be asked whether you can open the 
component (Ask?) or whether you should not be allowed to open this component (No). The case where you might 
choose No is if you want to let another user have access to this component and you do not want to use up the 
license access. The case where you might choose Ask is if you know you will sometimes want to access this 
component but not automatically or every time.

Please note that you will not be able to create a new case for the components you have set to "No".

Also, if you have set the component to "No" or there is no free licence available, the component can still be opened 
in read-only mode. This means you can view the patient information but not edit or save it.
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If you have opted for "Ask" for a component/module, when you try and open this component/module, a message 
will appear asking you if you want to use a license for the component/module in question.

If you choose Yes, you can open your patient case in editable mode. If you choose No, you can still open your 
patient case but only in Read-Only mode.
If you tick Remember my decision, this will update the Use? column in the licensing dialogue accordingly and this 
message will not appear again.

Note that this feature is user-dependent. This is not controlled or accessed via the license server. An individual user 
will configure this on his or her own astraia (Help - License). Furthermore, the default setting for reporting 
components is Yes. The components are automatically accessed by the user. In the case of embedded modules, 
however, such as Fetal Echocardiography embedded in Obstetrics, the default setting is Ask. This is because the 
most likely scenario is that fewer licenses (component access) will be requested for Fetal Echocardiography than 
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Obstetrics. If this is not the case, you can change the configuration in the license dialogue or tick Remember my 
decision accordingly.

Notifications and Error Messages

The licenses are distributed on a "first-come, first-serve" basis. If there are no more licenses available, you will 
receive a notification.

If you want to review a case even though there are no licenses available, you can still access the case but in Read-
Only mode. This means that you cannot edit the case.

No free licenses

Creating a new case with no license available will not work. You will get the following error message.

Example

If your network has fewer Image Viewer licenses than Obstetric licenses, an obstetrics user will eventually get a 
notification once licenses are no longer available for the Image Viewer. The user can still edit the case (as long as 
there is still an available Obstetric license), but will not have access to the Image Viewer, edit or look at images.
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1.
2.

If there is also no free Obstetric license left, several messages will appear: one stating there are no free licenses for 
Obstetrics, another stating there are no free licenses for the Image viewer and one to say that the case cannot be 
edited.

Embedded component

As mentioned above, a message will appear asking you whether you want to use a license for an embedded 
component. This is the case when you try and access Fetal Echocardiography in an Obstetrics case.

Problems with connection to the database

The message "Cannot connect to database" may have two root causes:

No connection to the server. In this case please check the network connection to the server.
The service for the database is not running. In this case please check if the database is running. 
Administrator rights may be necessary.

Example case for a network installation

A network license controls how astraia is used by a group of people.
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There are different aspects to accessibility for a network:

How many computers can access astraia

Which modules can be used

How many people can use a module at the same time

Imagine the following scenario as an example:

Three computers are available to work with astraia.
The license allows two users to use astraia at the same time
The license allows two users to access the Gynaecology component at the same time.
The license allows one user to access Obstetrics at a time.

The illustration below gives some possible combinations. 2 workstations can be used at any one time. Only 1 
Obstetrics can be opened in total but up to 2 Gynaecology can be opened in total. Read-only access is available but 
only on workstations that are accessing astraia - for example, if one workstation uses the only Obstetric license, the 
other workstation can access Obstetrics but only in read-only mode.
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21 Technical Support
We welcome suggestions for the program.

Please mail to support@astraia.com if you need support or contact:

NEXUS / ASTRAIA GmbH
Adalperostraße 80
D-85737 Ismaning
Germany

+49 89 / 540 204-700

+49 89 / 540 204-730 - Support line

+49 89 / 540 204-799 - Fax

Log files are used to record program events and errors. You can find these files in the folder .logs in the astraia 
directory (usually C:\Program Files\astraia\.logs). If you have email, please send these files with any problem 
report. You can also send your log files with the button Send log files in the program menu Help - About (see page 
230). In order to do that, your computer needs to be connected to the internet and your astraia emails settings must 
be configured (see Options - Administrator (see page 167)).

You can also mail us the log files on a CD / DVD or a memory stick to our office address. Please also add an accurate 
problem report.

Sending us the following details will make the error identification much easier:

operating system (Windows / Mac / Linux)
quantity of system memory (RAM) in MB
language used
database used

As the button Save in the menu Help -> About (see page 230) creates a .html file with only this information, it is best 
and the easiest to send the Help -> About file together with your problem report.

For data protection reasons, we ask you not to provide us with any personal patient information. In cases where 
you have to send us patient data for review or analysis of malfunctions but you cannot give us remote access, 
please tick the checkbox anonymize data in the patient export dialogue. If you need to send us printouts by fax or 
e-mail, please black out all patient-related information on the printout.
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22 Frequently asked questions
Print a report

Press Ctrl + P or select  Print in the File menu. A list of the predefined reports will show (see Printing Reports (see 
page 129)).

Save changes

To close and save the patientscreen you can either click on the cross in the upper right corner or you can 
select Close in the File menu. If the patientdata were edited, a popup will appear, asking if the changes should be 
saved. To save the patientdata while editing you can press Ctrl + S or select Save in the File menu.

Astraia does not open, no error message appears

This problem may occur if Java starts in the background - the astraia program will not be visible. You can bring 
astraia to the front by displaying all current applications with the key combination Alt + Tab. Keep Alt pressed until 
you have focused the astraia application by pressing Tab repeatedly. Release Alt and astraia will open.

Editing a list

Move the cursor to the list you wish to edit and doubleclick to open it. Click on Change this list or use the keyboard 
shortcut Alt + Enter. See Editing Popup Lists (see page 92) and Editing Helper Lists (see page 94) for more information.

Undo a mistake

If you have accidentally changed the data of a patient you can undo the change with Undo in the Edit menu. The 
keyboard shortcut for this action is Ctrl + Z. The program saves all changes and can undo them sequencially.

Create a backup of the database

standalone installation

In Options - Administrator choose the file where you want the backup to be saved . Press Ctrl + B or select Backup 
database in the menu File to save a copy of the database at the chosen location. See Database Backup (see page 244)

network installation

A backup of the database will automatically be carried out. The backupsettings were set during the installation of 
Astraia.

Delete an examination

To delete an examination, select Delete current examination in the menu Data. Confirm the security query if you 
are sure you want to delete this examination. The active examination will be deleted from the current case. The 
option Delete examination should be restricted to the admin.
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Attach a message to a patient

Press Alt + M or choose Messages from the Data menu to create a new message. You can now save messages in a 
text box, such as messages and reminders for other treating colleagues, postponed appointments or callbacks for 
the active patient. Each time the patient is opened, the message is automatically displayed for each user.
You can add to or change the message. If you don't want to see the message again, delete it and press OK. As soon 
as you have finished the current examination with 'save', the message is permanently deleted.

Difference FMF license - astraia license

You will need two different licenses in order to use the pregnancy module with all its functions:

astraia license:

The astraia license will enable the general use of the program - after a new installation if a module has expired or 
after receiving a new license, you will need to import the astraia license from a file.
You will need to import the license file into the license field of the registration (see Menu - Help (see page 230)). 

Re-licensing an existing astraia standalone installation before the expiry date:

Start astraia
Go to the menu bar (on top of the screen), click on "Help" - "License"
The license information will be displayed
Click on "Re-license Application"
You have received a license file (xxxxx-Lxxx_customer_name) from astraia: select the path where you have 
saved the license file.
Check if the license has been updated

Re-licensing an existing astraia network installation before the expiry date:

To import a license on a network installation, you need to use the license server. The network license has to be 
installed on the computer where the Network server installation has been performed. The access rights for all client 
computers are handled via the content of the network license.

Start the Astraia Service Manager by clicking on "Astraia Services". Click the "Configure"  button of the 
License Server.
Now you can configure your license server. If you want to import a new license, please click on the "Import" 
button.
Now go back to the Service Manager Screen and press the "Start" button. The license server is now in 
action, and you can use astraia.

This license is independent of the FMF risk license.

FMF license:

The FMF license will unlock the First Trimester risk calculation:
provided you have completed the online course for the 11-13 weeks scan on the Fetal Medicine Foundation 
website and have internet access, you can download your license from the FMF website directly in the screen 
"Options - FMF risks - Download license". You will need:

Your FMF user ID
Your login name
Your password

→ The downloaded license will be added to the user list.
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Alternatively, you can download your license file from your personal FMF site and copy it to the computer where 
astraia is installed; you can then import the license into the astraia program. By clicking on "Options - FMF risks - 
Import license", you will be able to search for your license file. If the import was successful, you will get a message 
and the data in your FMF Risks windows should have changed, e.g. the expiry date. When selecting which file to 
import, you may need to change the Files of Type that is being displayed to "All files" in order to see and select the 
file that you need to import. When you are at the correct location, select "Open". The license will be imported 
automatically.

In the case of multiple pregnancies, fetuses should be displayed as Fetus A and Fetus B instead of Fetus 1 and 
Fetus 2

You can change this in Options - Patient data - Label fetus.

How do I send patient data to the worklist?

First, you will need to open a patient. Then click on Examination, so that the current date is filled in and add the 
operator. Afterwards, go back to the summary. On the bottom right side, the button Worklist is available (only if the 
worklist is licensed and set up, see Options - Workstation (see page 211)). Pressing the button will send the patient 
data to the worklist. The button Worklist (F5) in the Patient lookup screen will only display all patients whose data 
has already been sent to the worklist.
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